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Introduction to Exchange Manager 
Exchange Manager is a comprehensive, full-service import and export tool capable of handling even the 
most complex data transfers. Exchange Manager provides: 

• Ease of customization. 

• Open access to all data fields using Microsoft SQL technologies. 

• Rapid development of on-demand or regularly scheduled import and export jobs through a 
powerful data mapping tool and intuitive interface. 

• Custom libraries for all new business, maintenance, financial, audit, and client recall file 
transfers.   

Note: If your organization purchased and installed Job Manager, you can use it to automate the 
Exchange import and export jobs. 

What's New in Exchange Manager 
The following Service Updates (SU) introduced changes and enhancements to Exchange 10.0: 

SU 8 

Export 

• Added ability to export previous versions of clients on the Interface Notes tab. For more 
information, see Save a Previous Version of an Exchange Client. 

• Added ability to select multiple rows and move a group of rows up or down 10 rows at a time in 
the Generate Report Record window. For more information, see Specify Data to Include in 
Export. 

Import 

• Removed Uses XML check box from the New Business and Financial Transactions tabs on the 
Import Files tab. 

• Removed ability to import an XML file type from the General Properties dialog box. 

Navigation 

Changed the navigation pane to display small icons instead of buttons for Forms, Services, and Vendors 
options. 

Log on to Exchange Manager 
Use the Latitude Logon dialog box to log on to Exchange Manager. The options and features in Exchange 
that are available to you are based on your assigned permissions. For more information about 
permissions and policies, see the Latitude documentation. 

To log on to Exchange Manager 

1. From your desktop, click Start > All Programs > Latitude Software > Exchange Manager. The 
Latitude Logon dialog box appears. 
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2. In the User Name box, type your Latitude user name. 

3. In the Password box, type your Latitude password. As you type your password, periods display 
instead of the typed characters. 

4. Click Okay. The Exchange Manager window appears. 

 

Overview of Exchange Manager Window 
Use the Exchange Manager window to import and export data, and modify vendor service import 
mappings. 
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1. Menu bar: Displays submenus and commands for working in Exchange. 

2. Navigation pane: Displays navigation options for the selected Navigation menu option. 

3. Information pane: Displays information for the item selected in the Navigation pane. 

4. Navigation menu: Displays items available to display in the Navigation pane. 

5. Batch Execution Control pane: Allows you to view, pause, restart, or cancel jobs in progress. 

Tip: To close all open windows in the Information pane, in the menu bar, click Windows > Close All 
windows. 

Help Overview 
Exchange Manager help provides you with information for using Exchange Manager. To locate and view 
a topic, use the table of contents, index, and search features. 

To open help 

In menu bar, click Help and then click Help on Exchange. The Exchange Manager Help window appears. 
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Tip: To adjust the width and height of the window or its panes, click the edge of the window or pane 
and drag it up or down, left or right. 

1. Toolbar: Displays options for the help window. 

2. Tabs: Displays the following: 

1. Contents: Displays the table of contents. To display a topic in the Content pane, expand a book 
and then click the link. 

2. Index: Displays the index. To display a topic in the Content pane, type a keyword or phrase in 
the box (or scroll through the list) and then click the link in the list. 

3. Search: Displays the search feature. To display a topic in the Content pane, type a keyword or 
phrase in the box and then press Enter. In the search results, click the link. 

4. Glossary: Displays a list of terms and their definitions. To display a definition, click the term. 

3. Breadcrumbs: Displays your current location within the help system. When you click a 
breadcrumb, the related topic displays. 

4. Content toolbar: Displays an option to send feedback through an email message to Latitude by 
Genesys Documentation. 

5. Content pane: Displays the contents of a topic. To view the Content pane menu, right-click in 
the Content pane. 
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Search feature 

You can use the search feature to search for topics that contain words or phrases that you specify. You 
formulate a search query following a specific set of rules. You can include wildcard expressions, Boolean 
operators, and nested expressions in your search query. A list of topics that match your search criteria 
appear in the search results. When you click a topic title in the search results, the content of that topic 
appears in the Content pane. 

Search syntax 

The basic rules for formulating search queries are: 

• Searches are not case-sensitive, meaning you can type uppercase or lowercase characters. 

• You cannot search for a single character or the following reserved words: an, and, as, at, be, but, 
by, do, for, from, have, he, in, it, not, of, on, or, she, that, the, there, they, this, to, we, which, 
with, you. 

• The search engine ignores punctuation marks and special characters such as @#$%^&()=+[]\. 

• Enclose phrases and terms that include a period (such as a file name with an extension) in 
double quotation marks. 

Wildcard expressions 

Wildcard expressions allow you to search for one or more characters using a question mark or asterisk. 
A question mark represents a single character, while an asterisk represents one or more characters. 

Search for... Example Result 

Topics with text that starts with one or 
more specified characters and ends in 
any character or number of characters 

log or log* Returns all topics with text that starts with the 
specified characters (for example, log, logon, logging). 

Topics with text that starts with the 
specified characters, has a single 
character that can be anything, and 
ends in the specified characters 

32?57 
Returns all topics with text that has any character 
where you placed a question mark (for example, 
32?57 returns 32257, 32457, and 32857). 

Topics that contain all the words 
specified, in any order or placement 
within the topic 

account 
status 

Returns all topics with both account and status, but 
not necessarily as a phrase or in the order specified. 
For example, the search returns topics with "the 
account status..." or "the status of the account..." 

Topics that contain the specified 
phrase 

"account 
status" 

Returns all topics with account status as a phrase. For 
example, the search returns topics with "the account 
status..." but not "the status of the account..." 
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Boolean operators 

Boolean operators (AND, OR, NOT, NEAR) allow you to create a relationship between terms. If you don't 
specify an operator, the system uses AND by default. 

Search 
for... Example Result 

AND account AND 
status 

Returns all topics with both account and status, but not necessarily as a phrase or 
in the order specified. For example, the search returns topics with "the account 
status..." or "the status of the account..." 

OR account OR 
status Returns all topics with either account or status, or both. 

NOT account NOT 
status Returns all topics with account but not status. 

NEAR account 
NEAR status Returns all topics where account is within eight words of status. 

Nested expressions 

Nested expressions allow you to perform complex searches. For example, queue AND ((collector OR 
clerical) not supervisor) finds topics containing queue and collector but not supervisor, or containing 
queue and clerical but not supervisor. As with mathematical expressions, the system evaluates 
expressions in parentheses first. If there is no parenthesis, the system evaluates the expression from left 
to right. For example, queue NOT (clerical OR supervisor) finds topics containing queue but not clerical 
or supervisor. Queue NOT clerical OR supervisor finds topics containing queue but not clerical, or topics 
containing supervisor. 

Folders 

Folders 

You can add, rename, and delete folders to organize your clients and forms in Exchange Manager. 

Add a Folder 

Use the Navigation pane to add a folder to organize clients or forms. 

To add a folder 

1. In the Navigation menu, click Clients or Forms. 

2. In the Clients or Forms pane, expand the nodes to the place where you want to add the folder. 

3. Right-click the node or folder name, click Add, and then click Add Folder. The system creates a 
folder. 

4. Type over the "New Folder" label with the name of the folder and then press Enter. 
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Note: Using a folder name that is the same as a client name could cause an error the next time you 
open Exchange. 

Rename a Folder 

Use the Navigation pane to rename a client or form folder. 

To rename a folder 

1. In the Navigation menu, click Clients or Forms. 

2. In the Clients or Forms pane, expand the nodes to locate the folder. 

3. Right-click the folder and then click Rename. 

4. Type the new name and then press Enter. 

Note: Using a folder name that is the same as a client name could cause an error the next time you 
open Exchange. 

Delete a Folder 

Use the Navigation pane to delete a client or form folder. 

To delete a folder 

1. In the Navigation menu, click Clients or Forms. 

2. In the Clients or Forms pane, expand the nodes to locate the folder. 

3. Right-click the folder and then click Delete. If the folder contains clients or forms, a confirmation 
dialog box appears. 

4. To delete the folder and its contents, click Yes. 

Client Configuration 

Client Configuration 

The first step in using Exchange Manager is to add clients and configure the settings for importing and 
exporting information. 

Note: The system creates the API client during installation of Exchange Manager. You do not need to 
do anything with this client unless Latitude by Genesys directs you to do so. 

Clients 

Clients 

Use the Clients pane to add, import, export, and delete clients. 

Add a Client 

Use the [Client Name] tab to add a client to Exchange Manager. The [Client Name] tab includes several 
tabs for configuring the client. 
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Note: If a client uses different criteria for import and export files, create a separate client for each 
configuration. 

To add a client 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, right-click the folder where you want to add the client. 

3. Click Add and then click Add Client. The system creates a client. 

4. Type over the "New Client" label, and then press Enter. 

5. Double-click the client name. A tab appears in the Information pane with the name of the new 
client. 
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6. Complete the information on the General, Import Files, and Export Files tabs. For more 

information, see General Configuration, Import Files, and Export Files. 

Import a New Client 

Use the menu bar to import a new client into Exchange Manager. 

To import a new client 

1. From the menu bar, click File > Import > Client. The Open dialog box appears. 

2. Click the file that contains the client information to import and then click Open. A confirmation 
dialog box appears. 

3. Click OK. The client name appears in the Clients pane. 
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4. In the Clients pane, double-click the client name. The [Client Name] tab appears in the 

Information pane. 

 
5. Complete the information on the General, Import Files, and Export Files tabs and then, in the 

toolbar, click Save. For more information, see General Configuration, Import Files, and Export 
Files. 
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Import All Clients 

Use the menu bar to import all clients to Exchange Manager. 

To import all clients 

1. From the menu bar, click File > Import > All Clients. The Browse For Folder dialog box appears. 

2. Click the client folder and then click OK. The DB Create Configuration dialog box appears. 

 

Create non-existing: Creates only non-existing required database objects. 

Create newer only: Creates only newer required database objects. 

Create Always: Always creates required database objects. 

Never Create: Never creates required database objects. 

3. Do one of the following: 

• To specify a method for creating required database objects, in the Create options list 
box, click a creation method and then click OK. 

• To import clients without creating any database objects, click Cancel and in the 
confirmation dialog box, click Yes. 

A notification dialog box appears indicating whether all clients imported successfully. 

4. In the notification dialog box, click OK. 

Modify a Client 

Use the [Client Name] tab to modify a client's information. You can also import updates to a client's 
information. For more information, see Import Updates to a Client. 

To modify a client 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client name. The 

[Client Name] tab appears in the Information pane. 

 
3. Modify the information on the General, Import Files, and Export Files tabs as necessary and 

then, in the toolbar, click Save. For more information, see General Configuration, Import Files, 
and Export Files. 
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Import Updates to a Client 

Use the [Client Name] tab to update a client's information using data in an XML file. You can also modify 
a client's information manually. For more information, see Modify a Client. 

To import updates to a client 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder, right-click the client name, and then click 

Update Client. The Open dialog box appears. 

3. Click the XML file that contains the updated client information and then click Open. A 
notification dialog box appears. 

4. Click OK. The system updates the client using the information in the XML file. 

Export a Client 

Use the menu bar to export a client from Exchange Manager to an XML file format. 

To export a client 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, double-click the client name. The [Client Name] tab appears in the 

Information pane. 

 
3. From the menu bar, click File > Export > Client. The Save As dialog box appears. 

4. In the File name box, type a name for the file and then click Save. 



Exchange Manager Printable Help 

19 

Export All Clients 

Use the menu bar to export all clients from Exchange Manager to an XML file format. 

To export all clients 

1. From the menu bar, click File > Export > All Clients. The Browse For Folder dialog box appears. 

2. Click the folder to export the clients to and then click OK. The Add date dialog box appears. 

3. Do one of the following: 

• To include the date in the file name, click Yes. 

• To exclude the date from the file name, click No. A notification dialog box appears 
indicating whether all clients exported successfully. 

3. Click OK. 

Copy a Client 

Use the Clients pane to copy a client. You can use a copy of a client to modify the configuration without 
affecting the original client. 

To copy a client 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder, right-click the client, and then click Copy. 

3. Type a name for the copied client and then press Enter. 

Rename a Client 

Use the Clients pane to rename a client. Save any changes that you've made before renaming the client. 

To rename a client 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder, right-click the client, and then click Rename. 

3. Type the new client name and then press Enter. 

Delete a Client 

Use the Clients pane to delete a client. 

To delete a client 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder, right-click the client, and then click Delete. A 

confirmation dialog box appears. 

3. Click Yes. 
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General Configuration 

General Configuration 

Use the General tab to specify general settings for a client. These settings include unique account 
criteria, unique debtor criteria, and global business rules. General information for the client applies to all 
import and export files. 

Specify Unique Account Criteria 

Use the Unique Account Criteria section of the General tab to specify the criteria to use to locate the 
accounts to update in Latitude. 

To specify unique account criteria 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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Account with customer: If selected, Exchange Manager uses the client's account number and the 
client specified during import to locate an account. 

ID 1: If selected, Exchange Manager uses ID1 to locate an account. 

ID 2: If selected, Exchange Manager uses ID2 to locate an account. 

Original1: If selected, Exchange Manager uses the amount in the Principal money bucket to locate 
an account. 

Number (can stand alone): If selected, Exchange Manager uses Latitude's unique account number 
to locate an account. 

Debtor ID (can stand alone): If selected, Exchange Manager uses Latitude's unique debtor 
identification number to locate an account. 

Request ID (can stand alone): If selected, Exchange Manager uses Latitude's Service Request ID to 
locate an account. Exchange uses this ID when matching records returned from a vendor to the 
Service History table. 

No ID (generic tables only): If selected, Exchange Manager writes the information to a generic 
table. Advanced users only. 

Account (can stand alone): If selected, Exchanges Manager uses the client's account number to 
locate an account. 
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Allow Wildcards (account only): If selected, you can use a partial account number for matching. 
For example, your client can provide you with a 16-character account number, and send 
maintenance information using only the first 10 characters. 

Note: Ensure that you map the unique account criteria from your source file to a destination 
field. For more information, see Map Source Fields to Destination Fields. 

3. Select one or more criteria that renders accounts as unique for the specified client and then, in 
the toolbar, click Save. The Update Comment dialog box appears. 

4. In the Update Comment box, type a comment regarding your changes and then click OK. 

Specify Unique Debtor Criteria 

Use the Unique Debtor Criteria section of the General tab to specify the criteria to use to locate the 
debtors to update in Latitude. Exchange uses this criteria along with the unique account criteria you 
specified to locate the correct debtor record to update. If Exchange Manager doesn't locate the debtor, 
it inserts a new debtor record. 

To specify unique debtor criteria 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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Debtor ID: If selected, Exchange uses the debtor ID to locate the debtor record to update. If you 
select this option, select the Debtor ID check box in the Unique Account Criteria section also. 
Recommended as the most accurate method to locate the correct debtor. 

Seq: (Sequence) If selected, Exchange Manager combines the debtor sequence number with the 
unique account criteria to locate the debtor record to update. The sequence number for the 
primary debtor is 0 (zero) and the sequence number for secondary debtors is 1 (one) or higher. 

Note: Use with caution. More than one of the same sequences can exist for a debtor record 
with the same Latitude file number. 

SSN: If selected, Exchange Manager uses the debtor's social security number and the unique 
account criteria to locate the debtor record to update. 

Name: If selected, Exchange Manager uses the customer's name and the unique account criteria to 
locate the customer record to update. The format is last name, first name, middle initial (for 
example, "Doe, John E"). If the customer (debtor) ID isn't available, the name is the second most 
accurate method to locate a customer record. 

Relationship: If selected, Exchange Manager uses the account relationship and the unique account 
criteria to locate the customer record to update. 

Note: Use with caution. More than one of the same relationships can exist for a customer 
record with the same Latitude file number. 
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Not Set: (default) If selected, Exchange Manager doesn't map secondary information for a debtor. 
For example, it only maps to new business. If you select this option: 

• Exchange Manager applies new business information to the primary debtor, unless new 
debtor rows exist in the mapping and you mapped debtor information to the additional 
rows.   

• Maintenance requires debtor mapping; otherwise, Exchange Manager could insert a 
new debtor record.   

• Bankruptcy and deceased records require debtor mapping to match the information to 
the correct debtor. 

Note: Ensure that you map the unique debtor criteria from your source file to a destination 
field. For more information, see Map Source Fields to Destination Fields. 

3. Select one criteria that renders debtors unique for the specified customer and then, in the 
toolbar, click Save. The Update Comment dialog box appears. 

4. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure Global Account Business Rules 

Use the Account tab on the General tab to configure business rules that apply globally at the account 
level. 

To configure global account business rules 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. On the General tab in the Global Business Rules section, click the Account tab. 

 
Skip Closed Accounts (Closed STATUS TYPE or QLEVEL >= 998): If selected, Exchange Manager 
doesn't update accounts that have a closed status or a queue level of 998 or higher when 
importing financial and maintenance data. 

Skip Returned Accounts (QLEVEL = 999): If selected, Exchange Manager doesn't update accounts 
that have a queue level of 999 when importing financial and maintenance data. 

Reject duplicate accounts: If selected, Exchange Manager updates the first account it matches 
and ignores the duplicate accounts. When you select this check box, you also have the following 
options: 
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Reopen Duplicate Accounts on New Business if duplicate is closed: If selected and an 
account in a new business file matches an existing closed account in Latitude, Exchange 
Manager reopens the closed account instead of importing the account as new business. 
Exchange Manager doesn't update the account information in Latitude unless you select the 
Reset Balance to values from new Business file upon reopen of duplicate account check 
box. 

Reset Balance to values from new Business file upon reopen of duplicate account: If 
selected and you chose to reopen duplicate accounts, Exchange Manager updates the 
account balance and other information in Latitude with information in the new business file. 
If the account doesn't have a closed status in Latitude, Exchange Manager doesn't update 
the account with the information in the new business file. 

Move Early Out to Charged Off: If selected, Exchange Manager moves accounts to a charged-off 
status. 

Create New Record Always: If selected, Exchange Manager creates a Misc Extra record regardless 
of whether the Misc Extra record exists in Latitude. 

Update Existing: If selected and the Misc Extra record exists, Exchange Manager updates the 
existing record. If the Misc Extra record does not exist, Exchange Manager creates a record. 

4. Select one or more account business rules to apply and then, in the toolbar, click Save. The 
Update Comment dialog box appears. 

5. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure Global Financial Business Rules 

Use the Financial tab on the General tab to configure business rules that apply globally for financial 
transactions. 

To configure global financial business rules 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder, and then double-click the client. The tab for 
the specified client appears in the Information pane. 

 
3. On the General tab in the Global Business Rules section, click the Financial tab. 

 

Do not apply payment to accounts with a Closed Status: If selected, Exchange Manager doesn't 
apply payments to accounts that have a queue level of 998 or higher (closed status) when 
processing financial imports. 

Do not post accounts that have been Returned (QLEVEL = 999): If selected, Exchange Manager 
doesn't post financial transactions to accounts set to queue level 999 (closed and returned 
status). If you select this option, Exchange Manager selects the Do not apply payment to 
accounts with a Closed Status check box. 
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Apply Custom Fee Schedule during Client defined Grace Period: If selected, Exchange Manager 
applies the specified fee schedule to payments on accounts where the client received payment 
before expiration of the grace days indicated (based on the account received date). 

Grace Period (days): Number of days to subtract from and add to the current date to 
determine the grace period. For example, if the current date is 11/10/2016 and the number 
of grace days is 10, the grace period is 10/31/2016 through 11/20/2016. Exchange Manager 
uses the grace period when determining which fee schedule to apply to payments. 

Use Received Date: If selected, Exchange Manager uses the account received date to 
determine which fee schedule to apply. If the account received date is greater than or equal 
to the current date less the number of grace days specified, Exchange Manager uses the fee 
schedule specified in the Fee Schedule to Apply list box. If the account received date is less 
than the current date less the number of grace days specified, Exchange Manager uses the 
fee schedule set for the client. 

Use Payment Date: If selected, Exchange Manager uses the payment date to determine 
which fee schedule to apply. If the payment date is less than or equal to the account 
received date plus the number of grace days specified, Exchange Manager uses the fee 
schedule specified in the Fee Schedule to Apply list box. If the payment date is greater than 
the account received date plus the number of grace days specified, Exchange Manager uses 
the fee schedule set for the client. 

Fee Schedule to Apply: Fee schedule to apply to payments based on whether you chose to 
compare the grace period to the account received date or payment date. 

Search for Unknown Echo Backs and Update the Original Transaction: If selected, Exchange 
Manager uses a query to search for payments to avoid duplicate payment entries. Use only with 
direction from Latitude by Genesys. 

Echo Back Locating Query: Query used to search for payments to avoid duplicate payment 
entries. If you selected the Search for Unknown Echo Backs and Update the Original 
Transaction check box, specify the name of the query in this box. 

Add Collection Fee: If selected, Exchange Manager uses the collection fee percentage set for the 
client or a stored procedure to add collection fees to accounts. 

Use Customer Setting: If selected, Exchange Manager uses the collection percentage set for 
the client in Latitude to calculate and add collection fees to accounts. 

Use Custom Stored Procedure: If selected, Exchange Manager uses the calculations in a 
stored procedure that Latitude by Genesys provides to add collection fees to accounts. 

[Stored Procedure Name]: Name of the stored procedure to use to calculate and add 
collection fees to accounts. If you selected the Use Custom Stored Procedure check box, 
specify the name of the stored procedure in this box. 

Do not Apply Transactions to Accounts Received before Custom Date: If selected, Exchange 
Manager doesn't apply payment transactions to accounts received before the date specified in 
the Custom Received Date box. Select this option in rare instances to avoid system anomalies 
due to internal (other system) migration. Consult Latitude by Genesys for detailed information. 
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Custom Received Date: Account received date to use to limit the payment transactions 
applied to accounts. If you selected the Do no Apply Transactions to Accounts Received 
before Custom Date check box, specify the date in this box. 

4. Select one or more financial business rules to apply. 

5. To view an example of an echo back query, double-click the Echo Back Locating Query label. The 
Echo back locating query example window appears. 

 
6. In the toolbar, click Save. The Update Comment dialog box appears. 

7. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure Global Custom Business Rules 

Use the Custom tab on the General tab to configure business rules that identify accounts to exclude 
during imports. Custom business rules only apply to maintenance, financial, and final recall imports. 
They don't apply to new business imports. Exchange Manager flags accounts that meet the specified 
criteria with a red exception when processing the import file. 

To configure global custom business rules 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 
the specified client appears in the Information pane. 

 
3. On the General tab in the Global Business Rules section, click the Custom tab. 

 
4. Click Add New Custom Business Rule. The Edit Query column indicates "NO DATA." 
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5. Double-click the box next to "NO DATA." The Select Accounts window appears. 

 
6. Specify the conditions for selecting the accounts to exclude from the import. In the previous 

example, Exchange Manager excludes accounts where the last payment date occurred within 
the last 30 days. For more information about using queries, see Queries. 

7. Click Save. 

Note: We recommend that you create simple conditions. If you combine conditions, the 
exception message doesn't indicate why Exchange Manager didn't process the account. 
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8. On the Custom tab, rest your mouse on the query to view the full SQL statement. 

 
9. In the Exception Message box, type the exception message to display in red above the account 

when processing the import file. 

 

 
10. Select the import types to which to apply the business rule. For example, if you select Final 

Recall, Exchange Manager doesn't recall accounts that received a payment in Latitude within the 
last 30 days. 

11. Add more business rules as necessary and then, in the toolbar, click Save. The Update Comment 
dialog box appears. 

12. In the Update Comment box, type a comment regarding your changes and then click OK. 

Specify General Configuration Settings 

Use the General Configuration section of the General tab to specify general configuration settings. 

To specify general configuration settings 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. On the General tab, locate the General Configuration section. 
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Configure File Pre-processing: Opens the Regex Config dialog box to allow you to run a regular 
expression or SQL code against a file before processing it. For more information, see Add a Regex 
Replacement and Configure Code Pre-processing. 

Configure Dependencies: Opens the Configure Dependencies dialog box to allow you to add 
dependencies to include when copying a client to export. For more information, see Configure 
Dependencies. 

Store copy of original file: If selected, stores a copy of the original file for later reference. 

Always open entire file at once: If selected, Exchange Manager checks for fixed or delimited files 
where a sub record does not contain a unique account identifier and is dependent upon a parent 
record for proper processing. 

Execute this stored procedure before processing the first record: Name of the stored procedure 
to run before processing the first record in a file. 

Execute this stored procedure after processing the last record: Name of the stored procedure to 
run after processing the last record in a file. 

4. Specify the general configuration settings and then, in the toolbar, click Save. The Update 
Comment dialog box appears. 

5. In the Update Comment box, type a comment regarding your changes and then click OK. 

Add a Regular Expression Replacement 

Use the Regex Config dialog box to add a regular expression (REGEX) to replace information within a file. 

To add a regular expression replacement 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 
the specified client appears in the Information pane. 

 
3. On the General tab in the General Configuration section, click Configure File Pre-processing. 

The Regex Config dialog box appears. 

 
4. Click Add regex replacement. The File Processing dialog box appears. 
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Regex: Pattern to use to match to a specific sequence of characters in a file. 

Replacement: For characters that match the regular expression, replace them with these 
characters. 

Effected Interfaces: If selected, Exchange Manager runs the Regular Expression against the file 
type. None" is selected by default. Clear this check box to select a specific import type. 

Place test expression below: Sample text to use to test the regular expression. 

Preview: Runs the regular expression test. 

Result after Regex Replacement: Result of the regular expression.   

In the following example, Exchange Manager looks for the letter "L" in "SCOLL" and replaces it 
with the letter "T" to get "SCOTT". 
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5. Complete the information and then click OK. Exchange populates the Regex Config dialog box 

with all regular expression replacements. 

6. In the Regex Config dialog box, click OK. 

7. In the toolbar, click Save. The Update Comment dialog box appears. 

8. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure Code Pre-processing 

Use the Code Preprocessing Dialog box to specify the SQL code to run before processing a file. For 
example, you can specify code that writes information to a temporary file that Exchange Manager can 
process instead of the original file. 

To configure code pre-processing 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. On the General tab in the General Configuration section, click Configure File Pre-processing. 

The Regex Config dialog box appears. 
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4. Click Configure Code Preprocessing. The Code Preprocessing Dialog box appears. 

 
5. In the "FILL THIS IN" section of the box, type the SQL code to run before processing the file and 

then click Compile. For more information, see Sample Pre-processing Code. 

6. If the "Congratulations" message appears, click OK. Otherwise, correct the error. 

7. In the Regex Config dialog box, click OK. 

8. In the toolbar, click Save. The Update Comment dialog box appears. 

9. In the Update Comment box, type a comment regarding your changes and then click OK. 

Sample Pre-processing Code 

The following sample code adds the current date in MMDDCCYY format to the end of any line that starts 
with an “A” in a fixed-length file format:   

using GSS.Common.Code; 

using System.IO; 

using System; 

using System.Data; 
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using System.Data.SqlClient; 

using System.Xml; 

public class CodeProcessor : ICodePreprocessor 

{ 

public string Execute (string fileContents) 

{ 

string newFile = Path.GetTempFileName(); 

string record = string.Empty; 

// fileContents is the path to the file.. 

using (StreamReader reader = new StreamReader (@fileContents)){ 

using (StreamWriter writer = new StreamWriter (@newFile)){ 

while ((record = reader.ReadLine()) !=null){ 

// If the record is an A record then append the 

// current date to the 

// record and write it to the new file. 

if (record.Substring(0,1) == "A") 

record += DateTime.Now.ToString("MMddyyy"); 

writer.WriteLine(record); 

} 

} 

} 

return newFile; 

} 

// Have to Implement this method this is as ICodePreprocessor implements IDisposable 

public void Dispose(){ 

} 

} 

Assembly Examples 

Examples of assemblies you can use when writing a pre-process script are: 

.NET Framework assemblies 

mscorlib.dll 

System.dll 
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System.Data.dll 

System.Xml.dll 

Latitude proprietary assemblies: 

GSSI.Latitude.Library.dll 

GSS Common.dll 

Configure Dependencies 

Use the Configure Dependencies dialog box to add SQL dependencies (such as tables, procedures, 
functions, and views) to include when exporting files for this client. 

To configure dependencies 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. On the General tab in the General Configuration section, click Configure Dependencies. The 

Configure Dependencies dialog box appears. 

 

4. Click Add SQL Dependency. The Dependency Designer dialog box appears. 
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SQL object type: Type of SQL object. 

Object Name: Name of the SQL object. 

Show Definition: Displays the object's contents. 

5. Complete the information and then click OK. The system populates the Configure Dependencies 
dialog box with the specified SQL dependency. 

6. To view the script, do the following: 

a. Click Show Create Script. The Dependency Script dialog box appears. 

 
b. To export the script to a file, click Export, specify a file name, and then click Open. 

c. To close the Dependency Script dialog box, click the X in the title bar. 

7. Add as many dependencies as the client requires and then click OK. 
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8. In the toolbar, click Save. The Update Comment dialog box appears. 

9. In the Update Comment box, type a comment regarding your changes and then click OK. 

Import Files 

Import Files 

Use the tabs on the Import Files tab to configure import files for new business, financial transactions, 
account maintenance, and final recall files. Do the following steps to create an import interface for a 
client: 

1. Add a client. 

2. Define the file layout. 

3. Map source fields to destination fields. 

Import Process Configuration 

Import Process Configuration 

Use the New Business, Financial Transactions, Maintenance, and Final Recall tabs on the Import Files 
tab to configure import files. Configuration includes defining the source file layouts and mapping the 
import files to the Latitude database. 

Excel Import File Format 

The following are the requirements for importing Excel files: 

• Excel file contains one worksheet only. 

• Worksheet names don't start or end with a space. If a worksheet starts or ends with a space, 
rename it. 

• First row of the worksheet contains column names and each column name is unique. Column 
names cannot start or end with a space. 

• Column names don't contain these characters: 

• / (forward slash) 

• \ (backslash) 

• # (pound sign) 

• $ (dollar sign) 

• Spreadsheet is contiguous, meaning that all rows after the first row contain data to import (for 
example, no totals, subtotals). 

• Spreadsheet doesn't contain formulas. 

• Numbers are formatted as text to prevent a truncation issue where Excel drops number 
sequences over 15 digits in length. 
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• Comma-delimited names only (Smith, John). Exchange Manager doesn't read dashes or other 
formatting properly. If the name components (for example, first name, middle initial, last name) 
are separate columns, Exchange may combine them during the import. For more information, 
see the following: 

• Define a Destination Field Value Using Hardcoded Text 

• Define a Destination Field Value Using C# Script 

• Define a Destination Field Value Using a Switch 

• Define a Destination Field Value Using the Name Parser 

• Define a Destination Field Value Using the Address Parser 

Note: You can use any Excel date field type but the preferred format for import is MM/DD/CCYY. 

Configure a New Business Import File 

Use the New Business tab on the Import Files tab to configure an import file for new business accounts. 

To configure a new business Import file 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business tab. 
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Modify File Source Layout: Opens the Define Import Layout window to allow you to define the 
layout of the import file. For more information, see Source File Layout. 

Modify File Mapping: Opens the Data Translator window to allow you to map the import file to 
the Latitude database. For more information, see Import File Mapping. 

Uses Excel: If selected, the import file is an Excel file. Each row in the Excel file contains one 
record only. 

Customer: 

Prompt: If selected, Exchange Manager prompts you during the import process for the 
client to associate to the accounts. 

Predefined: If selected, allows you to specify the client to associate to the accounts. 

[Client]: Name of the client to associate to the accounts. If you selected Predefined, 
specify the client name and Exchange Manager associates it during the import 
process. 

Use From File: If selected, Exchange Manager associates the client specified in the import 
file to the accounts. 

Desk: 

Prompt: If selected, Exchange Manager prompts you during the import process for the 
desk to assign to the accounts. 

Predefined: If selected, allows you to specify the desk to assign to the accounts. 

[Desk]: Desk to assign to the accounts. If you selected Predefined, specify the desk 
and Exchange Manager associates it during the import process. 

Use From File: If selected, Exchange Manager assigns the desk specified in the import file 
to the accounts. 

Received Date: 

Prompt: If selected, Exchange Manager prompts you during the import process for a 
received date to assign to the accounts. 

Use Current Date: If selected, Exchange Manager assigns the current date to the accounts 
as the received date. 

Use From File: If selected, Exchange Manager assigns the received date specified in the 
import file to the accounts. 

Letter: 

Prompt: If selected, Exchange Manager prompts you during the import process for the 
initial letter to associate to the accounts. 

Predefined: If selected, allows you to specify the initial letter to associate to the accounts. 

[Letter]: Initial letter to associate to the accounts. If you selected Predefined, 
specify the letter and Exchange Manager associates it during the import process. 

None: If selected, Exchange Manager doesn't associate an initial letter to the accounts. 
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Process Open Batches: If selected, Exchange Manager applies the payments in the import file to 
the accounts. Exchange Manager doesn't include adjustments created from reopening accounts 
and resetting balances. 

Combine Multiple Accounts: If selected and duplicate account information exists in the import 
file, Exchange Manager combines the balances and uses all information from the first record 
found for the account. 

Always Load Generic Tables: If selected, loads the generic tables that your organization created. 

Pre Account Procedure: Stored procedure to call before processing each account.  

Post Account Procedure: Stored procedure to call after processing each account. 

Execute this stored procedure before processing the first record: Stored procedure to call before 
processing the first record in the import file. 

Execute this stored procedure after processing the last record: Stored procedure to call after 
processing the last record in the import file. 

Split File?: If selected, Exchange Manager splits the import file based on the number of rows and 
the regular expression that you specify. 

Number of Rows: Number of rows to include in the file split. 

Regular Expression: Regular expression to use to limit the file splitting. 

4. Complete the information. 

5. To view the SQL script for a stored procedure, do the following: 

• For the pre-account procedure, in the Custom Processing section, double-click the Pre 
Account Procedure label. The Stored Procedure Definition window appears.  

 
• For the post-account procedure, in the Custom Processing section, double-click the Post 

Account Procedure label. The Stored Procedure Definition window appears.  
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• For the pre-processing procedure, in the Custom Pre and Post Stored Procedures 
section, double-click the Execute this stored procedure before processing the first 
record... label. The Stored Procedure Definition window appears.  

 
• For the post-processing procedure, in the Custom Pre and Post Stored Procedures 

section, double-click the Execute this stored procedure after processing the last 
record... label. The Stored Procedure Definition window appears.  

 
6.  In the toolbar, click Save. The Update Comment dialog box appears. 

7. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure a Financial Transactions Import File 

Use the Financial Transactions tab on the Import Files tab to configure an import file for financial 
transactions. 

To configure a financial transactions import file 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the Financial Transactions tab. 

 

Modify File Source Layout: Opens the Define Import Layout window to allow you to define the 
layout of the import file. For more information, see Source File Layout. 

Modify File Mapping: Opens the Data Translator window to allow you to map the import file to 
the Latitude database. For more information, see Import File Mapping. 
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Uses Excel: If selected, the import file is an Excel file. Each row in the Excel file contains one 
record only. 

Customer: 

Prompt: If selected, Exchange Manager prompts you during the import process for the 
client to associate to the accounts. 

Predefined: If selected, allows you to specify the client to associate to the accounts. 

[Client]: Name of the client to associate to the accounts. If you selected Predefined, 
specify the client name and Exchange Manager associates it during the import 
process. 

Use From File: If selected, Exchange Manager associates the client specified in the import 
file to the accounts. 

Note: If you use Number as the Unique Account Criteria, select Use From File, even though you 
don't have to map it. 

Process Opened Batches: If selected, Exchange Manager applies the payments in the import file 
to the accounts. Exchange Manager doesn't include the adjustments created from reopening 
accounts and resetting balances. 

Post Account Procedure: Stored procedure to call after processing each account. 

4. Complete the information and then, in the toolbar, click Save. The Update Comment dialog box 
appears. 

5. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure a Maintenance Import File 

Use the Maintenance tab on the Import Files tab to configure an import file for account maintenance. 

To configure a maintenance import file 

1. In the Navigation pane, click Clients. 

 



Exchange Manager Printable Help 

53 

2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 
the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the Maintenance tab. 
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Modify File Source Layout: Opens the Define Import Layout window to allow you to define the 
layout of the import file. For more information, see Source File Layout. 

Modify File Mapping: Opens the Data Translator window to allow you to map the source import 
file to the Latitude database. For more information, see Import File Mapping. 

Uses Excel: If selected, the import file is an Excel file. Each row in the Excel file contains one 
record only. 

Customer: 

Prompt: If selected, Exchange Manager prompts you during the import process for 
the client to associate to the accounts. 

Predefined: If selected, allows you to specify the client to associate to the accounts. 

[Client]: Name of the client to associate to the accounts. If you selected 
Predefined, specify the client name and Exchange Manager associates it 
during the import process. 

Use From File: If selected, Exchange Manager associates the client specified in the 
import file to the accounts. 

Note: If you use Number as the Unique Account Criteria, select Use From File, even though you 
don't have to map it. 

Split File?: If selected, Exchange Manager splits the import file based on the number of 
rows and the regular expression that you specify. 
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Number of Rows: Number of rows to include in the file split. 

Regular Expression: Regular expression to use to limit the file splitting. 

Configure Service History: No longer used. 

Update Linked Accounts: If selected, Exchange Manager updates debtor demographics for linked 
accounts. Applies to the primary debtor (debtor0) only. 

Always Load Generic Tables: If selected, loads the generic tables that your organization created. 

Pre Account Procedure: Stored procedure to call before processing each account. 

Post Account Procedure: Stored procedure to call after processing each account. 

Execute this stored procedure before processing the first record: Stored procedure to call before 
processing the first record in the import file. 

Execute this stored procedure after processing the last record: Stored procedure to call after 
processing the last record in the import file. 

Current Account Values: If selected, Exchange Manager adds the field to the Source tab in the 
Data Translator window. Exchange Manager uses these fields to determine how to process an 
account based on a current value. For example, if current0 > 1000, update the value. 

Configure Duplicate Handling: Opens the Duplicate Config dialog box to allow you to specify how 
to handle duplicate records. For more information, see Configure Duplicate Handling. 

4. Complete the information and then, in the toolbar, click Save. The Update Comment dialog box 
appears. 

5. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure Duplicate Handling 

Use the Duplicate Config dialog box to specify how to handle duplicate records when importing 
maintenance files. 

To configure duplicate handling 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the Maintenance tab. 
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4. Click Configure Duplicate Handling. The Duplicate Config dialog box appears. 

 
Duplicate handling: Method to use to handle duplicate records. 

Reject Duplicates: Don't process accounts with duplicate import records. 

Accept last: Use the first duplicate record found to update the account. 

Accept first: Use the last duplicate record found to update the account. 

Ignore: Process all information, regardless of duplicates or the order found. 

How would you like to be notified of duplicates: Method for Exchange Manager to use to notify 
you when there are duplicate records. 

No Notification: Don't send a notification. 

Log warning: Add a warning message to the log file. 
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Log error: Add an error message to the log file. 

5. Complete the information and then click OK. 

6. In the toolbar, click Save. The Update Comment dialog box appears. 

7. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure a Final Recall Import File 

Use the Final Recall tab on the Import Files tab to configure an import file for final recall accounts. 

To configure a final recall import file 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the Final Recall tab. 
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Modify File Source Layout: Opens the Define Import Layout window to allow you to define the 
layout of the import file. For more information, see Source File Layout. 

Modify File Mapping: Opens the Data Translator window to allow you to map the import file to 
the Latitude database. For more information, see Import File Mapping. 

Uses Excel: If selected, the import file is an Excel file. Each row in the Excel file contains one 
record only. 

Customer: 

Prompt: If selected, Exchange Manager prompts you during the import process for 
the client to associate to the accounts. 

Predefined: If selected, allows you to specify the client to associate to the accounts. 

[Client]: Name of the client to associate to the accounts. If you selected 
Predefined, specify the client name and Exchange Manager associates it 
during the import process. 

Use From File: If selected, Exchange Manager associates the client specified in the 
import file to the accounts. 

Change Desk to: 

Prompt: If selected, Exchange Manager prompts you during the import process for a 
desk to which to move closed accounts. 

Predefined: If selected, allows you to specify the desk to which to move closed 
accounts. 
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[Desk]: Desk to which to move closed accounts. If you selected Predefined, 
specify the desk and Exchange Manager associates it during the import 
process. 

Use From File: If selected, Exchange Manager moves closed accounts to the desk 
specified in the import file. 

Do Not Change: If selected, Exchange Manager doesn't change desk assignments for 
closed accounts. 

Status: 

Prompt: If selected, Exchange Manager prompts you during the import process for a 
status code to assign to closed accounts. 

Predefined: If selected, allows you to specify the status code to assign to closed 
accounts. 

[Status]: Status code to assign to closed accounts. If you selected Predefined, 
specify the status code and Exchange Manager associates it during the import 
process. 

Use From File: If selected, Exchange Manager assigns the status code specified in the 
import file to closed accounts. 

Close and Return All Accounts: If selected, Exchange Manager assigns queue level "999" to closed 
and returned accounts, and changes the status to "recall" (regardless of whether a Post-dated 
check or similar exists). If cleared, use custom business rules to create objection files. For more 
information, see Configure Global Custom Business Rules. 

Always Load Generic Tables: If selected,  

Pre Account Procedure: Stored procedure to call before processing each account. 

Post Account Procedure: Stored procedure to call after processing each account. 

Execute this stored procedure before processing the first record: Stored procedure to call before 
processing the first record in the import file. 

Execute this stored procedure after processing the last record: Stored procedure to call after 
processing the last record in the import file. 

4. Complete the information and then, in the toolbar, click Save. The Update Comment dialog box 
appears. 

5. In the Update Comment box, type a comment regarding your changes and then click OK. 

Source File Layout 

Source File Layout 

Use the Define Import Layout window to define delimited or fixed import file layouts so that you can 
map the layouts to fields in the Latitude database. Optionally, you can use an Excel file to define the 
import file layout. You can create this file or Latitude by Genesys can provide it. 



Exchange Manager Printable Help 

62 

Exchange Manager imports files sequentially. When establishing parent and child relationships between 
records, reference file layouts sequentially unless each record contains the unique account identifier 
that associates it to the correct Latitude account record. 

Note: If the import file is a standard Excel file (one record per row), you do not need to define the 
source file layout. On the New Business, Financial Transactions, Maintenance, or Final Recall tab, 
select the Uses Excel check box and proceed to Import File Mapping. 

Hierarchical File Layout 

Exchange Manager recognizes multiple record files using hierarchies. Define the row context (parent 
record) and all other records as subs (children) of the row context. If Exchange Manager doesn't locate 
the unique account identifier in a sub record, Exchange Manager creates the field. The field inherits its 
value from the previous row context record in the file.   

The following example illustrates a typical flat file layout (fixed or delimited) where the sub record types 
can inherit the unique account identifier from the account record. Multiple sub records of the same 
name can appear for the same account. 

 

Virtual Headers 

Exchange Manager uses a virtual header when there is no record that Exchange Manager can set as the 
context record. The following example illustrates how Exchange Manager uses a virtual header to create 
a relationship for multiple, stand-alone records. In this file, multiple record types exist and each contains 
unique account identifiers. 

 

Excel Import File Layout 

Excel Import File Layout 

You can create an Excel file that defines the delimited or fixed file layout for an import. You can base this 
file on the sample provided in Exchange Manager. Each worksheet name in the file represents a record 
type. In the example file, the worksheet named HeaderRecord represents a header record type 
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(FileContext). Worksheet A represents an account record (RowContext). Worksheets B through Z 
represent sub record types. The TrailerRecord worksheet represents a trailer (FileContext). 

Note: Worksheet names cannot contain spaces. 

Create an Excel Import File 

Use the Define Import Layout window to create an Excel file layout so that you can import it and then 
modify the file layout. 

To create an Excel import file 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Source Layout. The Define Import Layout window appears. 

 
5. In the menu bar, click View Excel Sample to open the sample file. 
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6. Save the file to any location, then modify the file to reflect the layout of your import files. 

Exchange Manager recognizes the following column heading names in Excel as input fields for 
the record type. Exchange ignores any other Excel column heading names. 

Type: Data type. 

string: Text or numeric characters. 

int: Integer. 

decimal: Decimal, two decimal places accepted by default. 

dateTime: Ddate and time. 

Name: Name that represents or describes the field within the record. Don't include spaces after 
the name. 

Format: Format of the DateTime and Decimal field types only. 

DateTime – If you don't use the standard format (MM/DD/CCYY), specify the format 
to use. 

M=month, D=day, C=century, Y=year, H=hour, M=minute, S=second (for 
example, MMDDCCYYHHMMSS) 

Decimal – Not required when the file includes a decimal or the last two integers are 
decimal places. Otherwise: 

nodecimalpoint = No decimal point. 

signedascii = Signed ASCII RMS format. 

nodecimalpointwithsign = Plus or minus sign after integer. 
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Note: Some input strings that require complicated alteration or parsing before import may 
require custom programming. For assistance, contact Latitude by Genesys Support. 

Width: Number of characters in the record. Required for fixed-length files; you can leave them 
blank for delimited files. 

TableType: Record type. Specify one of the following for the first field within the record type 
only: 

FileContext: Header or trailer record. 

RowContext: Main record, usually repeated. Many import files contain only one 
record type, with this repeated record being the RowContext. Only define one 
RowContext record type per file. The RowContext record must contain the unique 
identifier for mapping (as defined on the General tab). This record can stand alone 
and has no parent. It's used for records such as account and payment. 

Sub: Subordinate record. This record type depends on another record to link to 
account information and can occur multiple times for the same account (for example, 
notes, payment, maintenance records). Also specify parent and child relations to link 
the subordinate record to its account record. Subordinate records must follow the 
parent sequentially when they don't contain a field that links to the parent. 

Key: Regular expression that identifies the record within the file. 

MaxOccurs: Maximum number of times the record occurs. 

1 = Record occurs once only. If only one sub record with this name exists for each 
account, or the record is a header, trailer, or main record, select this value. 

* = Multiple records exist. If more than one sub record exists for the same account, 
select this value. 

ParentTable: Name of the parent record for this record (only applies to subordinate table types). 

ParentColumn: Name of the parent column used for record matching (only applies to subordinate 
table types). 

ChildTable: Record name (only applies to subordinate table types). 

ChildColumn: Name of the child column used for record matching (only applies to subordinate 
table types). 

7. Delete the unused worksheets (for example, B through Z) and save the Excel file. After you 
create the Excel layout, you can import it into Exchange Manager to define your source file 
layout. For more information, see Import an Excel File Layout. 

Delete a Record Type 

Use the Define Import Layout window to delete a header, main, subordinate, or trailer record. 

To delete a record type 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Source Layout. The Define Import Layout window appears. 

 
5. Click the tab for the record to delete. 

6. In the menu bar, click Delete Record Type. 

7. In the confirmation dialog box, click Yes. 

8. Close the Define Import Layout window. 

9. In the toolbar, click Save. The Update Comment dialog box appears. 

10. In the Update Comment box, type a comment regarding your changes and then click OK. 

Import an Excel File Layout 

Use the Define Import Layout window to import an Excel file layout. 
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To import an Excel file layout 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Source Layout. The Define Import Layout window appears. 

 
5. Do the following: 

a. In the menu bar, click Import. 

b. In the confirmation dialog box, click Yes. 

c. Click the Excel file layout to import and then click Open. The layout appears in the Define Import 
Layout window with all defined record types displayed as tabs. Rows in the data grid represent fields 
within the record type. 
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6. In the menu bar, click General Properties. The General Properties dialog box appears. 

 
CSV: (Comma-Separated Value) If selected, the file is a delimited file. Specify the delimiter and 
qualifier. 

Delimiter: Character to use to separate data (for example, a comma or dash). 

Qualifier: Character to use to differentiate the data from the delimiter (typically 
single or double quotes). For example, if the delimiter is a comma and your data 
contains a comma (such as "Smith, John"), the qualifier distinguishes between the 
comma in your data and the comma that delimits the data. 

Fixed: If selected, the file is a fixed-length file. 

XML: If selected, the file is an XML file. Use only with assistance from Latitude by Genesys. 

Excel: This option is obsolete. Select the Uses Excel check box on the New Business, Financial 
Transactions, Maintenance, or Final Recall tab instead. 

Primary Table: Name of the Primary Table (record). This record is equivalent to a Latitude master 
record. Exchange Manager considers records between each Primary Table in the file as 
dependent records (for example, notes, payment, bankruptcy).   
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Note: Set the Primary Table to the record after the header (for example, "A").   

Header: If selected, the file contains a header record.   

Trailer: If selected, the file contains a trailer record.   

Verify Width: If selected, Exchange Manager determines whether the file width matches the 
layout width defined. For fixed-length file types only. 

Multiple Records: If selected, the file contains more than one record type (such as dependent 
records, header records, trailer records).   

Has Dynamic Columns: If selected, the file has dynamic columns. You can add columns to the file 
and not map them. Exchange writes extra columns to the Misc Extra table. For delimited file types 
only. 

7. Complete the information and then click Save. 

8. Close the Define Import Layout window. 

9. In the toolbar, click Save. The Update Comment dialog box appears. 

10. In the Update Comment box, type a comment regarding your changes and then click OK. 

Export a File Layout to Excel 

Use the Define Import Layout window to export a file layout to Excel. 

To export a file layout to Excel 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Source Layout. The Define Import Layout window appears. 

 
5. In the menu bar, click Export to Excel. The Save As dialog box appears. 

6. In the File name box, type a name for the file and then click Save. 

7. In the notification dialog box, click OK. 

8. Close the Define Import Layout window. 

9. In the toolbar, click Save. The Update Comment dialog box appears. 

10. In the Update Comment box, type a comment regarding your changes and then click OK. 
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Define the File Layout 

Use the Define Import Layout window to create a file that defines the delimited or fixed file layout for 
an import file. Add the record types needed, such as header record, main record, subordinate records, 
and trailer record. 

To define the file layout 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 



Exchange Manager Printable Help 

78 

 
4. Clear the Uses Excel check box and then click Modify File Source Layout. The Define Import 

Layout window appears. 

 
5. Click Add Record Type. The New Record Table Name dialog box appears. 

 
6. In the Name box, type the name of the record table (without spaces) and then click OK. The 

record name appears as a tab in the Define Import layout window. 
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Name: Name of the table record. Exchange Manager populates this box with the name you 
specified in the New Record Table Name dialog box. 

Key (Reg Exp): Key (regular expression) used to identify which records belong to which record 
type. For a VirtualHeader record, Exchange Manager populates this box and it's not necessary for 
you to change it. 

Tip: For a list of regular expressions and their usage, click the question mark (?) or see Regular 
Expression Syntax. 

Width: Number of characters contained in the record. Required for fixed-length files; you can 
leave it blank for delimited files. For a VirtualHeader record, Exchange Manager populates this 
box and it's not necessary for you to change it. 

Type: Type of record. Valid values are: 

FileContext: Header or trailer record. 

RowContext: Main record, usually repeated. Many import files contain only one 
record type. If that is the case, this repeated record is the RowContext. Only define 
one RowContext record type per file. The RowContext record must contain the 
unique identifier for mapping (as defined on the General tab). This record can stand 
alone and has no parent. It's used for records such as account and payment. 

Note: If multiple RowContext record types exist in the same file, use a virtual header and 
convert these RowContext records to sub records with the virtual header as the parent record. 

Sub: Subordinate record. This record type depends on another record to link to 
account information and can occur multiple times for the same account (for example, 
notes, payment, maintenance records). Also specify parent and child relations to link 
the sub record to its account record. Sub records must follow the parent sequentially 
when they don't contain a field that links to the parent. 

VirtualHeader: Header record used to create a relationship for files containing 
multiple stand-alone records (that meet RowContext criteria and contain unique 
account criteria). Set the multiple record types within the file as Sub types. A 
VirtualHeader allows you to process different sub record types within a file, even if 
they don’t tie together for the same account. The VirtualHeader is the parent record 
for the sub record. 

Parent Relation: For a sub record, select the parent record and field to link the sub record to. For 
example, select "A" as the parent record and "Account_Number" as the key field to use to link 
the sub record to the parent record. 

Max Occurs: For a VirtualHeader record, Exchange Manager populates this box and it's not 
necessary for you to change it. Valid values are: 

1 = Record occurs once only. If only one sub record with this name exists for each 
account, or the record is a header, trailer, or main record, select this value. 

* = Multiple records exist. If more than one sub record exists for the same account, 
select this value. 



Exchange Manager Printable Help 

80 

Child Relation: For a sub record, select the current record and field to match to the parent 
record. For example, for sub record "B,"select "Account_Number" as the key field even though 
the Account_Number field does not exist in the sub record. Exchange Manager processes the file 
sequentially and creates this field "virtually" for every sub record when it exists in the parent 
record. If you used a VirtualHeader, the unique account criteria field has to exist in each sub 
record. 

7. Click in the first available row in the data grid and then type information for the first field in the 
record. 

Name: Name of the field. 

Type: Type of data the field can contain. Valid values are: 

String: Text or numeric characters. 

Integer: Numbers. 

Decimal: Decimal field. Two decimal places accepted by default. 

DateTime: Date, time, or both. 

Format: Format of the DateTime and Decimal field types only. 

DateTime – If you don't use the standard format (MM/DD/CCYY), specify the format 
used. 

M=month, D=day, C=century, Y=year, H=hour, M=minute, S=second (for 
example, MMDDCCYYHHMMSS) 

Decimal – Not required when the file includes a decimal or the last two integers are 
decimal places. Otherwise: 

nodecimalpoint = No decimal point. 

signedascii = Signed ASCII RMS format. 

nodecimalpointwithsign = Plus or minus sign after integer. 

Note: Some input strings that require complicated alteration or parsing before import may 
require custom programming. For assistance, contact Latitude by Genesys Support. 

Width: Maximum length of the data in the field. 

8. Complete the information. 

9. Press Tab to create a blank row for the next field in the record and complete the information. 
Repeat as necessary. 

Note: For a VirtualHeader record, create one row to represent your record type. The record 
doesn't have to exist in the file. For example, Name = VirtualHeader, Type = String, Format = 
blank, and Width = 0.  Create a second row for the unique account identifier. For example, 
Name = AccountNumber, Type = String, Format = blank, and Width = 16. 

10. Close the Define Import Layout window. 

11. In the toolbar, click Save. The Update Comment dialog box appears. 
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12. In the Update Comment box, type a comment regarding your changes and then click OK. 

Regular Expression Syntax 

A regular expression is a special text string for describing a search pattern and functions similar to 
wildcards. You can use regular expressions to search for and replace information in a file. 

The following regular expressions are available: 

• Literal Characters 

• Character classes or character sets [abc] 

• Dot 

• Anchors 

• Word boundaries 

• Alternation 

• Quantifiers 

Literal Characters 

A single letter character matches the first occurrence of that character in the string. For example, "a" 
matches the first "a" in Jack is a boy, which is the "a" in "Jack." 

Character Description Example 

Any 
character 
except 
[\^$.|?*+() 

All characters except the listed special characters 
match a single instance of themselves. 

a matches a 

\(backslash) 
followed by 
any of 
[\^$.|?*+() 

Some characters have special meaning. A 
backslash placed before a special character 
escapes the special character to suppress its 
special meaning. 

\+ matches + 

\xFFwhere 
FF are 2 
hexadecimal 
digits 

Matches the character with the specified 
ASCII/ANSI value, which depends on the code 
page used. Can also use in character classes. 

\xA9 matches ©when using the Latin-
1 code page. 

\n, \r and \t Match an LF character, CR character, and a tab 
character respectively. Can also use in character 
classes. 

\r\n matches a DOS/Windows CRLF 
line break. 

Character classes or character sets [abc] 

A character class matches one out of several characters. For example, "ae" matches either gray or grey, 
whichever word it finds first. The order of the characters in the set is irrelevant. 
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Character Description Example 

[(opening 
square 
bracket) 

Starts a character class. A character class matches 
a single character out of all the possibilities the 
character class offers. Inside a character class, 
different rules apply. The rules in this section are 
only valid inside character classes. The rules 
outside this section are not valid in character 
classes, except \n, \r, \t and \xFF. 

  

Any 
character 
except ^-]\ 
add that 
character to 
the possible 
matches for 
the 
character 
class. 

All characters except the listed special characters. [abc] matches a, b, or c 

\(backslash) 
followed by 
any of the 
following: 
^-]\ 

A backslash escapes special characters to suppress 
their special meaning. 

[\^\]] matches ^ or ] 

-(hyphen) 
except 
immediately 
after the 
opening [ 

Specifies a range of characters. A hyphen placed 
immediately after the opening bracket indicates a 
hyphen. 

[a-zA-Z0-9] matches any letter or digit 

^(caret) 
immediately 
after the 
opening [ 

Negates the character class, causing it to match a 
single character not listed in the character class. A 
caret placed anywhere except after the opening 
bracket indicates a caret. 

[^a-d] matches x (any character 
except a, b, c or d) 

\d, \w, and 
\s 

Shorthand character classes match digits 0-9, 
word characters (alphanumeric characters plus 
underscore), and white space (including tabs and 
line breaks), respectively. Can use inside and 
outside character classes. 

[\d\s] matches a character that is a 
digit or white space 

\D, \W, and 
\S 

Negated versions of the shorthand character 
classes. We recommend using outside character 
classes only as using them inside can be 
confusing. 

\D matches a character that is not a 
digit 

Dot 

A dot matches a single character except line break characters. For example, "gr.y" matches gray and 
grey. Often, a character class or negated character class is faster and more precise than the dot. 
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Character Description Example 

.(dot) Matches any single character except line break 
characters \r and \n. Most regex engines have a 
"dot matches all" or "single line" mode that causes 
the dot match to include line break characters. 

. matches x or (almost) any other 
character 

Anchors 

An anchor matches a position rather than a character. For example, "^b" only matches the first "b" in 
bob. 

Character Description Example 

^(caret) Matches at the start of the string to which you 
apply the pattern. Most regex engines have a 
"multi-line" mode that causes the caret to match 
after any line break (for example, at the start of a 
line in a file). 

^. matches a in abc\ndef. Also matches 
d in "multi-line" mode. 

$(dollar) Matches at the end of the string to which you 
apply the pattern. Most regex engines have a 
"multi-line" mode that causes the dollar sign to 
match before any line break (for example, at the 
end of a line in a file). Also matches before the last 
line break when the string ends with a line break. 

.$ matches f in abc\ndef. Also matches 
c in "multi-line" mode. 

\A Matches at the start of the string to which you 
apply the pattern. Never matches after line breaks. 

\A. matches a in abc 

\Z Matches at the end of the string to which you 
apply the pattern. Never matches before line 
breaks, except for the last line break when the 
string ends with a line break. 

.\Z matches f in abc\ndef 

\z Matches at the end of the string to which you 
apply the pattern. Never matches before line 
breaks. 

.\z matches f in abc\ndef 

Word boundaries 

A word boundary matches at a position between a word character and either another word character or 
a non-word character. 

Character Description Example 

\b Matches at the position between a word character 
(anything matched by \w) and a non-word 
character (anything matched by [^\w] or \W). It 
also matches the string at the start, end, or both 
when the first, last, or both characters in the string 
are word characters. 

.\b matches c in abc 
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Character Description Example 

\B Matches at the position between two word 
characters (for example, the position between 
\w\w) and the position between two non-word 
characters (for example, \W\W). 

\B.\B matches b in abc 

Alternation 

Alternation matches one item out of a group of items and is equivalent to the "or" operator. For 
example, "cat|dog" matches "cat" in About cats and dogs. If it's applied again, it matches "dog." You can 
add as many alternatives as you want (for example, "cat|dog|mouse|fish." Include parenthesis for 
grouping. For example, "(cat|dog) food" matches cat food and dog food. 

The pipe (|) character has the lowest precedence of all regex operators. 

Character Description Example 

| Matches either the part on the left side, or the part 
on the right side. You can string characters 
together into a series of options. 

abc|def|xyz matches abc, def, or xyz 

|(pipe) Use grouping to alternate only part of the regular 
expression. 

abc(def|xyz) matches abcdef or abcxyz 

Quantifiers 

A quantifier matches a set number of characters that matched specific criteria. There are two types of 
quantifier searches: greedy (maximal) and lazy (minimal). A greedy search tries to match as many 
characters as it can while still returning a true value. A lazy search matches once only. For example, if 
you search for one to four "b's" in a row and have a string with three "b's" in a row, greedy matches the 
three "b's" and lazy only matches the first "b." 

Character Description Example 

? Greedy. Makes the preceding item optional. 
Includes the optional item in the match when 
possible. 

abc? matches ab or abc 

?? Lazy. Makes the preceding item optional. Excludes 
the optional item in the match when possible. 

abc?? matches ab or abc 

*(star) Greedy. Repeats the previous item zero or more 
times. Matches as many items as possible before 
trying permutations with fewer matches of the 
preceding item, up to the point where it doesn't 
match the preceding item at all. 

".*" matches "def" "ghi" in abc "def" 
"ghi" jkl 

*?(lazy star) Lazy. Repeats the previous item zero or more 
times. The regex engine attempts to skip the 
previous item, before trying permutations with 
ever increasing matches of the preceding item. 

".*?" matches "def" in abc "def" "ghi" 
jkl 
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Character Description Example 

+(plus) Greedy. Repeats the previous item once or more. 
Matches as many items as possible before trying 
permutations with fewer matches of the preceding 
item, up to the point where the search engine 
matches the preceding item once only. 

".+" matches "def" "ghi" in abc "def" 
"ghi" jkl 

+?(lazy plus) Lazy. Repeats the previous item once or more. 
The regex engine matches the previous item only 
once, before trying permutations with ever 
increasing matches of the preceding item. 

".+?" matches "def" in abc "def" "ghi" 
jkl 

{n}where n 
is an integer 
>= 1 

Repeats the previous item exactly n times. a{3} matches aaa 

{n,m}where 
n >= 1 and 
m >= n 

Greedy. Repeats the previous item between n and 
m times. Tries repeating m times before reducing 
the repetition to n times. 

a{2,4} matches aa, aaa or aaaa 

{n,m}?where 
n >= 1 and 
m >= n 

Lazy. Repeats the previous item between n and m 
times. Tries repeating n times before increasing 
the repetition to m times. 

a{2,4}? matches aaaa, aaa or aa 

{n,}where n 
>= 1 

Greedy. Repeats the previous item at least n 
times. Matches as many items as possible before 
trying permutations with fewer matches of the 
preceding item, up to the point where it matches 
the preceding item only n times. 

a{2,} matches aaaaa in aaaaa 

{n,}?where 
n >= 1 

Lazy. Repeats the previous item between n and m 
times. The regex engine matches the previous 
item n times, before trying permutations with 
ever increasing matches of the preceding item. 

a{2,}? matches aa in aaaaa 

Import File Mapping 

Import File Mapping 

Use the Data Translator window to map the New Business, Financial Transactions, Maintenance, and 
Final Recall import file types to the Latitude database. After you map an import file, the import file 
appears in the Import menu. 

The following options are available for defining how to import data into a table: 

• Map the contents of a file to a table in the Latitude database 

• Hard code a value 

• Define a pre- or post-processing script 
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View Source Information 

Use the Source tab in the Data Translator window to view content from a source import file. This file 
can be a sample file provided to your agency that contains "placeholders" or sample data. The main 
requirement is that the layout within the file matches the layout for the import files your agency is 
receiving. 

Note: If you open an Excel source file that is different from an existing mapped layout, Exchange 
prompts you to overwrite the current layout. 

To view source information 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click Open Sample File. The Open dialog box appears. 

6. Locate the source file, and then click Open. The file's contents appear on the Source tab. 

Note: If the source file is an Excel file, select the Uses Excel check box on the New Business, 
Financial Transactions, Maintenance, or Final Recall tab on the Import Files tab. 
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Map Source Fields to Destination Fields 

Use the Mapping tab to map data in the import file to the Latitude database. Before mapping the fields, 
define the source file layout. If you are using an Excel file, open an import file (see Viewing Source 
Information). 

Note: Examples in this topic are based on the New Business import type. 

To map source fields to destination fields 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6. In the Data Mapping section, select one of the following: 

All to Misc Extra: If selected, Exchange Manager adds all fields in the source file to the Misc Extra 
table, regardless of whether you mapped them. 

All Unmapped to Misc Extra: If selected, Exchange Manager only adds unmapped fields in the 
source file to the Misc Extra table. 

All Primary to Misc Extra: If selected, Exchange Manager adds all fields in the source file that are 
not child fields to the Misc Extra table, regardless of whether you mapped them. Clear this check 
box for Excel imports. 

All Unmapped Primary to Misc Extra: If selected, Exchange Manager only adds unmapped fields 
in the source file that are not child fields to the Misc Extra table. Clear this check box for Excel 
imports. 

None: If selected, Exchange Manager only includes data that you mapped to Latitude tables and 
ignores all other data. 

7. To map a field, click a field in the Source pane and drop it onto the destination field in the 
Destination pane. Continue mapping fields as necessary. 

Notes: 

• You can map multiple source fields to a single destination field. For example, 
you can map the First and Last source fields to the Name destination field. 
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• Exchange Manager maps some fields twice in the Latitude destination tables. 
For example, if you map the source Name field to the destination NAME field in 
the Master table, Exchange Manager maps the Debtor0 destination record also. 

• If you are reporting to the credit bureaus, ensure that the delinquency date is 
valid and is at least 31 days before the date received into Latitude. Map the 
date to the delinquency date field. 

The following example shows three fields in the source file mapped to their corresponding fields 
in the destination file. The First field maps to the FIRSTNAME field, the Last field maps to the 
LASTNAME field, and the Social field maps to the SSN field. The blue icons indicate mapped 
fields. The yellow icons indicate unmapped fields. For more information about the icons, see 
Mapped Field Icons. 

 
8. Do the following as necessary: 

• To show the current mapping, right-click the source field and then click Show Current 
Usage. 

• To map a file to the Misc Extra table, right-click the source field and then click Map to 
MiscExtra. 

• To map a field to the Notes table, right-click the source field and then click Map to 
Notes. 
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• To add a row to a table for mapping, right-click the destination table name and then 
click Add New Row. Exchange Manager assigns the next sequential number to the new 
row. 

Note: Destination tables in the Master table contain one row (indicated by a 0) by default. You 
can add information from a source file to multiple rows in a table by adding more rows and 
then mapping the data to each subsequent row. For example, only one debtor record (row) is 
available initially in the destination file (debtor 0, or primary debtor). If co-debtor information is 
available in the source file, add another row to the Debtors table to accommodate the 
additional debtor record. 

• To view data dictionary information, right-click the destination field and then click View 
Data Dictionary Information. 

• To remove a field mapping, right-click the mapped destination field and then click 
Delete Sources. 

• To remove information from a field in the Misc Extra or Notes table, right-click the 
destination field and then click Delete Info. 

• To define the mapping for a destination field, see the following: 

 Define a Destination Field Value Using Hardcoded Text 

 Define a Destination Field Value Using C# ScriptDefine a 

 Destination Field Value Using a Switch 

 Define a Destination Field Value Using the Name Parser 

 Define a Destination Field Value Using the Address Parser 

9. In the toolbar, click Save and Exit. 

Preview the Import 

Use the Destination tab to preview the data before importing it to ensure that the mapping is correct. 

Note: The examples in this topic are based on the New Business import type. 

To preview the import 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Destination tab. 

6. In the toolbar, click Preview Data. 
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Mapped Field Icons 

The following table describes the icons that represent a mapped field. 

Icon Description 

 

Mapped field that uses address parsing to split an address into separate components (for 
example, street, city, state, and postal code). 

 

Mapped field that uses name parsing to split a name into separate components (for example, 
first name, middle initial, and last name). 

  

 

Mapped field that uses C# script to compare values or specify how to process an account based 
on a current value. 

 

Mapped field that uses a lookup table to assign a value to a destination field. 

 

Mapped field that contains text formatting before or after a value. 

 

Unmapped field. 
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Define a Destination Field Value Using Hardcoded Text 

Use the Define Destination Field Value dialog box to add hardcoded text to a value in the source field 
before storing it in the destination field. 

To define a destination field value using hardcoded text 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6.  In the Destination pane, double-click a mapped destination field. The Define Destination Field 

Value dialog box appears. 

 
7. Click Text. The Text tab appears. 
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8. Type one or more characters before, between, or after the bracketed source field names. For 

example: 

9.  The following format inserts a comma between the values in the LAST and FIRST name fields: 

{AccountRecord/0/Last},{AccountRecord/0/First} 

• The following format inserts "PC" after the value in the PaymentType field. 

{PaymentType} PC 

Note: Do not modify the information within the brackets {}. 

10. Click OK. 

11. In the menu bar, click Advanced and then click Save Mapping Definition. The Save As dialog box 
appears. 

12. In the File name box, type a name for the file and then click Save. 

Define a Destination Field Value Using C# Script 

Use the Define Destination Field Value dialog box to use C# script to process values in the source field 
before storing them in the destination field. 

To define a destination field value using C# script 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6.  In the Destination pane, double-click a mapped destination field. The Define Destination Field 

Value dialog box appears. 

 
7. Click Script. The C# Script tab appears. 
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8. Type the C# script to use to check values, parse data, or perform any other function on the 

source field before populating the destination field. For example, the following script removes 
dashes from the data: 

using System; 

using System.Globalization; 

public class Script : Scripter.DefaultScriptBase 

{ 

    public Script() 

    } 

    public override string GetScriptValue(string str1) 

    { 

        return str1.Replace("-",""); 

    } 

    public override string GetScriptValue(string str1, string str2) 

    { 

        throw new ApplicationException("Script method not implemented yet"); 

    } 

    public override string GetScriptValue(string str1, string str2, string str3) 

    { 

        throw new ApplicationException("Script method not implemented yet"); 

    } 

    public override string GetScriptValue(string[] args) 
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    { 

        throw new ApplicationException("Script method not implemented yet"); 

    } 

} 

Note: The first line ALWAYS contains "public class Script : Scripter.ScriptBase" to implement the 
three methods indicated. If C# code is referencing the Latitude file number field, return a -1 for 
an empty string. Otherwise, the number increments by one until the C# script returns a new 
number. 

9. Click OK. 

10. In the menu bar, click Advanced and then click Save Mapping Definition. The Save As dialog box 
appears. 

11. In the File name box, type a name for the file and then click Save. 

Define a Destination Field Value Using a Switch 

Use the Define Destination Field Value dialog box to switch a value in the source field to a different 
value before storing it to the destination field. For example, if the source file uses a two-character code 
to identify account statuses, create a switch to convert the code to the three-character code that 
Latitude uses. 

To define a destination field value using a switch 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6.  In the Destination pane, double-click a mapped destination field. The Define Destination Field 

Value dialog box appears. 

 
7. Click Switch. The Switch tab appears. 
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8. Click Add New Row. 

9. In the Source Value box, type the value that is in the source field. 

10. In the Destination Value box, type the value to assign to the mapped destination field. 

The following example shows the two-character codes in the source file and the values to assign 
to the destination field. The "@Else" source value handles data not mapped currently. In the 
example, if the source value isn't "UN", "MO", or "PW", Exchange Manager assigns "04211" to the 
destination field. 

 
11. Click OK. 

12. In the menu bar, click Advanced and then click Save Mapping Definition. The Save As dialog box 
appears. 

13. In the File name box, type a name for the file and then click Save. 

Define a Destination Field Value Using the Name Parser 

Use the Define Destination Field Value dialog box to extract components of a name (such as first name, 
middle initial, and last name) from the source field and store that value in the destination field. Parsing 
also keeps blank lines from creating an extra debtor record when using comma insertion. 

To define a destination field value using the name parser 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6. In the Destination pane, double-click a mapped destination field. The Define Destination Field 

Value dialog box appears. 

 
7. Click Name Parser. The Name Parser tab appears. 
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Format: Format of the source field. For best results for a person's name, click VARIABLE. For a 
business name, click Company. 

Return Value: Value to extract from the source field and insert into the destination field. For best 
results for a person's name, click Latitude Style Name (format is last name, first name, middle 
initial). For a business, click Business Flag. 

Variable #1 and Variable #2: Format of the source data. If you selected "VARIABLE" in the Format 
list box, specify the format. FML = First Middle Last and LFM = Last First Middle. 

Note: Import business accounts to a separate file from debtor accounts. 

8. Complete the information and then click OK. 

9. In the menu bar, click Advanced and then click Save Mapping Definition. The Save As dialog box 
appears. 

10. In the File name box, type a name for the file and then click Save. 

Define a Destination Field Value Using the Address Parser 

Use the Define Destination Field Value dialog box to extract a component of an address (such as city, 
state, or ZIP Code) from the source field and store that value in the destination field. 

To define a destination field value using the address parser 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 
the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6. In the Destination pane, double-click a mapped destination field. The Define Destination Field 

Value dialog box appears. 

 
7. Click Address Parser. The Address Parser tab appears. 
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8. Click the component to extract from the source field and insert into the destination field and 

then click OK. 

9. In the menu bar, click Advanced and then click Save Mapping Definition. The Save As dialog box 
appears. 

10. In the File name box, type a name for the file and then click Save. 

Destination Fields 

Destination Fields 

Map the fields in your source file to the destination fields so that you can import your data into the 
Latitude database. The import types are: 

• Financial (F): Used to add and maintain financial information in Latitude. 

• Maintenance (M): Used to update existing records in Latitude. 

• New Business (NB): Used to add records to Latitude. 

• Final Recall (R): Used to add and maintain final recall information in Latitude. 

For information about which import types are valid for a table, see the specific "table" topic. 

Master Table 

The Master table contains the master account information. Exchange only populates the Debtor0 
(primary debtor) record in the Master table. 

Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

SH_RequestID Code that identifies a 
vendor service request for 
the account. 

4 Integer ServiceHistory/RequestID NB, M 

Number Code that Latitude assigns 
to identify the account. For 
new business records, leave 
this field blank and let 
Latitude assign the number. 

4 Integer None NB, F, 
M, R 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

For financial, maintenance, 
and final recall records, 
provide the code that 
Latitude assigned previously. 

Account Code that the customer 
assigned to identify the 
account. 

30 VarChar None NB, F, 
M, R 

Customer Name of the customer. 7 VarChar None NB, F, 
M, R 

CustDivision Customer's division. 15 VarChar None NB, M 

CustDistrict Customer's district. 15 VarChar None NB, M 

CustBranch Customer's branch. 15 VarChar None NB, M 

Desk Code that identifies the desk 
to assign to the account. The 
code must exist in Latitude. 

10 VarChar None NB, F, 
M, R 

Desk1 Field used under the 
direction of Latitude by 
Genesys. 

10 VarChar None NB, M 

Desk2 Field used under the 
direction of Latitude by 
Genesys. 

10 VarChar None NB, M 

Branch Code that identifies the 
agency branch. The code 
must exist in Latitude. 

5 VarChar None NB, M 

Status Code that identifies the 
status of the account, such 
as open or closed. The code 
must exist in Latitude. 

5 VarChar None NB, F, 
M, R 

ClaimType Code that identifies the 
claim type used to 
determine the statute of 

5 VarChar None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

limitations. The code must 
exist in Latitude. 

ClassOfBusiness Code that identifies the class 
of business to which the 
account belongs. The code 
must exist in Latitude. 

5 VarChar None NB, M 

ID1 Custom identification code 
that your organization 
assigns. 

40 VarChar None NB, F, 
M, R 

ID2 Custom identification code 
that your organization 
assigns. 

40 VarChar None NB, F, 
M, R 

Score Credit score for the account. 2 SmallInt None NB, F, 
M 

OriginalCreditor Original creditor on the 
account. 

50 VarChar None NB, M 

PreviousCreditor Previous owner of 
account (usually for 
purchased debt).   

50 VarChar None NB, M 

FeeCode Latitude code that identifies 
the fee assigned to the 
account. If blank, Latitude 
uses the customer's default 
fee schedule. 

30 VarChar None NB, F, 
M, R 

PurchasedPortfolioName Name of the purchased 
portfolio. 

50 VarChar Portfolio/PortfolioName R 

PurchasedPortfolio Code that identifies a 
purchased portfolio.   

7 VarChar None NB, M, 
R 

SoldPortfolioName Name of the sold portfolio. 50 VarChar Portfolio/PortfolioName R 

SoldPortfolio Code that identifies a sold 
portfolio. 

7 VarChar None NB, M, 
R 



Exchange Manager Printable Help 

122 

Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Name Debtor name in "lastname, 
firstname MI suffix" format.  

30 VarChar Debtors/Name NB, M 

Other Debtor's alternate or alias 
name. 

30 VarChar Debtors/Othername NB, M 

Street1 Primary debtor's address 
line 1.   

128 VarChar Debtors/Street1 NB, M 

Street2 Primary debtor's address 
line 2.  

128 VarChar Debtors/Street2 NB, M 

City Primary debtor's city.   30 VarChar Debtors/City NB, M 

State Primary debtor's state.    3 VarChar Debtors/State NB, M 

ZIPCode Primary debtor's ZIP Code.   10 VarChar Debtors/Zipcode NB, M 

MR Flag that indicates whether 
the primary address is good. 

Y = Yes, address is good 

N = No, address is bad or 
unknown 

1 VarChar Debtors/MR NB, M 

HomePhone Primary debtor's home 
phone number. 

30 VarChar Debtors/Homephone NB, M 

WorkPhone Primary debtor's work 
phone number.   

30 VarChar Debtors/Workphone NB, M 

SSN Primary debtor's social 
security number.   

15 VarChar Debtors/SSN NB, M 

DOB Primary debtor's date of 
birth. 

8 DateTime Debtors/DOB NB 

Received Date your organization 
received the account. If 
blank, Exchange populates 
this field with the current 
date.  

8 DateTime None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Closed Date and time your 
organization closed the 
account. 

8 DateTime None NB, M 

Returned Date and time your 
organization returned the 
account. 

8 DateTime None NB, M 

Archived Date and time your 
organization archived the 
account. 

8 DateTime None NB, M 

Viewed Date and time a user last 
viewed the account. 

8 DateTime None NB, M 

Worked Date and time a user last 
worked the account. 

8 DateTime None NB, M 

Contacted Date and time a user last 
contacted the account. 

8 DateTime None NB, M 

StatuteDate Date the statute of 
limitations expires for the 
account. 

8 DateTime None NB, M 

ContractDate Date the debtor started the 
account with the customer. 

8 DateTime None NB, M 

CLIDLC Last date your organization 
charged the customer. 

8 DateTime None NB, M 

CLIDLP Last date the customer paid 
your organization. 

8 DateTime None NB, M 

ChargeOffDate Date the customer charged 
off the account. 

8 DateTime None NB, M 

LastPaid Date the customer last 
received payment on the 
account. 

8 DateTime None NB, M 

BPDate Broken promise date. 8 DateTime None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

FeeSchedule Not used. 5 VarChar None NB, M 

DelinquencyDate Date the customer flagged 
the account as delinquent. 

8 DateTime None NB, M 

LastInterest Date interest last accrued. 8 DateTime None NB, F, 
M 

UserDate1 Custom date field. 8 DateTime None NB, F, 
M, R 

UserDate2 Custom date field. 8 DateTime None NB, F, 
M, R 

UserDate3 Custom date field. 8 DateTime None NB, F, 
M, R 

CLIALC Last amount your 
organization charged the 
customer. 

8 Money None NB 

CLIALP Last amount the customer 
paid your organization. 

8 Money None NB 

LastPaidAmount Last payment amount 
received on the account. 

8 Money None NB, M 

InterestRate Simple interest rate used to 
calculate interest on the 
account. Formatted as 00.00 
(for example, 15.5% interest 
rate shows as 15.50). 

8 Money None NB, F, 
M 

Current0 Total current balance (sum 
of Current1 through 
Current10 money buckets). 

8 Money None NB, M 

Current1 Current principal balance in 
money bucket 1. 

8 Money None NB, M 

Current2 Current interest balance in 
money bucket 2. 

8 Money None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Current3 Current balance in money 
bucket 3. 

8 Money None NB, M 

Current4 Current balance in money 
bucket 4. 

8 Money None NB, M 

Current5 Current balance in money 
bucket 5. 

8 Money None NB, M 

Current6 Current balance in money 
bucket 6. 

8 Money None NB, M 

Current7 Current balance in money 
bucket 7. 

8 Money None NB, M 

Current8 Current balance in money 
bucket 8. 

8 Money None NB, M 

Current9 Current balance in money 
bucket 9. 

8 Money None NB, M 

Current10 Current balance in money 
bucket 10. 

8 Money None NB, M 

Original Total original balance (sum 
of Original1 through 
Original10 money buckets). 

8 Money None NB, M 

Original1 Original principal balance in 
money bucket 1. 

8 Money None NB, M 

Original2 Original interest balance in 
money bucket 2. 

8 Money None NB, M 

Original3 Original balance in money 
bucket 3. 

8 Money None NB, M 

Original4 Original balance in money 
bucket 4. 

8 Money None NB, M 

Original5 Original balance in money 
bucket 5. 

8 Money None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Original6 Original balance in money 
bucket 6. 

8 Money None NB, M 

Original7 Original balance in money 
bucket 7. 

8 Money None NB, M 

Original8 Original balance in money 
bucket 8. 

8 Money None NB, M 

Original9 Original balance in money 
bucket 9. 

8 Money None NB, M 

Original10 Original balance in money 
bucket 10. 

8 Money None NB, M 

Paid Total amount paid (sum of 
Paid1 through Paid10 
money buckets). 

8 Money None NB, M 

Paid1 Principal amount paid 
against money bucket 1. 

8 Money None NB, M 

Paid2 Interest amount paid toward 
money bucket 2. 

8 Money None NB, M 

Paid3 Amount paid against money 
bucket 3. 

8 Money None NB, M 

Paid4 Amount paid against money 
bucket 4. 

8 Money None NB, M 

Paid5 Amount paid against money 
bucket 5. 

8 Money None NB, M 

Paid6 Amount paid against money 
bucket 6. 

8 Money None NB, M 

Paid7 Amount paid against money 
bucket 7. 

8 Money None NB, M 

Paid8 Amount paid against money 
bucket 8. 

8 Money None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Paid9 Amount paid against money 
bucket 9. 

8 Money None NB, M 

Paid10 Amount paid against money 
bucket 10. 

8 Money None NB, M 

QLevel Code that identifies the 
account queue level. The 
code must exist in Latitude. 

3 VarChar None NB, F, 
M, R 

QDate Date for the account to 
appear in the Collector 
queue. 

8 DateTime None NB, M 

QTime Time for the account to 
appear in the Collector 
queue. 

4 VarChar None NB, M 

QFlag Flag that indicates whether 
to display the account in a 
queue.   

1 = Yes 

0 = No 

1 VarChar None NB, M 

Queue Not used. 26 VarChar None NB, M 

QueueHold Not used. 8 DateTime None NB, M 

Accrued2 Interest accrued against the 
account since placement. 

8 Money None NB, M 

Accrued10 Transaction surcharges 
applied against the account 
since placement. 

8 Money None NB, M 

AgencyCode Not used. 5 VarChar None NB, M 

AgencyFlag Not used. 1 TinyInt None NB, M 

AIMAgency Code that identifies the 
outside agency to which a 

4 Integer None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

user assigned the account. 
The code must exist in AIM. 

AIMAssigned Date the customer assigned 
the account to an outside 
agency. 

8 DateTime None NB, M 

AssignedAttorney Date the customer assigned 
the account to an attorney. 

8 DateTime None NB, M 

Attorney Not used. 5 VarChar None NB, M 

AttorneyAccountID Not used. 30 VarChar None NB, M 

AttorneyID Code that identifies the 
attorney to which the 
customer assigned the 
account. The code must 
exist in AIM. 

4 Integer None NB, M 

AttorneyLawList "You Got Claims" ID. 5 VarChar None NB, M 

AttorneyStatus Indicates whether the 
customer placed the 
account with an attorney. 

Placed = Customer placed 
the account.  

NULL = Not placed. 

15 VarChar None NB, M 

BlanketSIFOverride Blanket settlement 
percentage set for the 
customer. 

8 Float None NB, M 

CBRException Exception that prevents 
reporting the debtor to the 
credit bureaus. 

2 Smallint None NB, M 

CBRExtendDays Number of days from 
normal credit bureau 
reporting date to delay 
reporting. 

4 Integer None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

CBROverride Flag that indicates whether 
to override the automated 
credit bureau reporting 
evaluation. 

1 = Yes 

0 = No 

1 Bit None NB, M 

CBRPrevent Flag that indicates whether 
to prevent reporting of the 
account to the credit 
bureaus. 

1 = Yes 

0 = No 

1 Bit None NB, M 

Complete1 Not used. 8 DateTime None NB, M 

Complete2 Not used. 8 DateTime None NB, M 

CTL General-purpose flag. Used 
for things such as converting 
records to Latitude or 
flagging records from certain 
programs   

3 VarChar None NB, M 

CurrencyType Not used. 20 VarChar None NB, M 

DMDateStamp Not used. 10 VarChar None NB, M 

ExtraCodes Not used. 40 VarChar None NB, M 

Finders Not used. 8 DateTime None NB, M 

FirstDesk Not used. 10 VarChar None NB, M 

FirstReceived Not used. 8 DateTime None NB, M 

Full0 Not used. 8 DateTime None NB, M 

HasBigNote Not used. 1 VarChar None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

InterestBuckets Account-level override to 
specify which money 
buckets to use as the 
principal value when 
calculating interest. This 
field overrides the same 
field on the Customer table, 
which overrides the system 
default of only using the 
principal bucket Current1.  

Interest accrues based on 
the values of Current1 and 
Current3. Exchange doesn't 
support Current2 as Latitude 
doesn't calculate 
compounded interest.  

2 Smallint None NB, M 

Link Code that identifies the 
linked accounts group to 
which the account belongs. 
The code must exist in 
Latitude. 

4 Integer None NB, M 

LinkDriver Flag that indicates whether 
the account is the link 
driver. 

1 = Yes 

0 = No 

1 Bit None NB, M 

NSF Flag that indicates whether 
the account had insufficient 
funds posted. 

Default = NULL (no NSF) 

T = Yes 

1 VarChar None NB, M 

NSFDate Date the last NSF posted on 
the account. 

8 DateTime None NB, M 

PromAmt Not used. 8 Money None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

PromDue Not used. 8 DateTime None NB, M 

PSEQ Sequence number of the 
primary debtor on the 
account. Most programs 
assume that the primary 
debtor is sequence zero, so 
this field is always zero. 

4 Integer None NB, M 

RestrictedAccess Flag that indicates whether 
the account has restricted 
access and requires 
permission to access the 
account. 

1 = Yes 

0 = No 

1 Bit None NB, M 

Salary Not used. 8 Money None NB, M 

Salesman1ID Not used. 4 Integer None NB, M 

Salesman2ID Not used. 4 Integer None NB, M 

Salesman3ID Not used. 4 Integer None NB, M 

SEQ Not used. 4 Integer None NB, M 

SIFPct Not used. 8 Money None NB, M 

SysMonth System processing month. 1 TinyInt None NB, M 

SysYear System processing year. 2 SmallInt None NB, M 

TotalContacted Number of times agents 
contacted the debtor. 

4 Integer None NB, M 

TotalViewed Number of times agents 
viewed the account. 

4 Integer None NB, M 

TotalWorked Number of times that agents 
worked the account. 

4 Integer None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Secured Flag that indicates whether 
the account is for a secured 
loan. 

1 = Yes 

0 = No 

1 Bit None NB, M 

ShouldQueue Flag that indicates whether 
to display the account in a 
user's queue. 

1 = Yes 
0 = No 

1 Bit None NB, M 

 
AIM Ledger Table 

The AIM Ledger table contains expenditures and receipts for purchased accounts. Each account can 
have multiple ledger records. 

Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned to identify 
the account. To ensure that Exchange 
Manager locates the correct account, you 
must map this field. 

4 Integer Master/Number M 

LedgerTypeID Code that identifies the ledger type. You 
must have already created this code in 
Latitude. 

4 Integer None M 

DateEntered Date of debit or credit. 8 DateTime None M 

Debit Amount debited from the account. 8 Money None M 

Credit Amount credited to the account. 8 Money None M 

Comments Comments regarding the ledger entry. 16 Text None M 

Status Ledger entry status, such as sent, 
received, pending, or approved. 

50 VarChar None M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

PortfolioID Code that identifies the purchased 
portfolio. You must have already created 
this code in Portfolio Manager. 

4 Integer None M 

ToGroupID Code that identifies the group receiving 
the credit or debit.  

4 Integer None M 

FromGroupID Code that identifies the group sending the 
credit or debit.  

4 Integer None M 

InvoiceID Code that identifies the invoice that 
includes the credit or debit. This code 
must exist in Latitude. 

4 Integer None M 

LedgerID Code that Latitude assigned to identify 
the ledger record. 

4 Integer None M 

AIM Ledger Misc Extra Table 

The AIM Ledger Misc Extra table contains miscellaneous data for AIM ledger accounts. Each account can 
have multiple miscellaneous data records. 

Field Name Description Length Data 
Type 

Parent Table and 
Field 

Import 
Types 

LedgerID Code that Latitude assigned to identify 
the ledger record. 

4 Integer AIM_Ledger/LedgerID M 

Title Title for the information associated 
to the ledger entry. 

30 VarChar None M 

TheData Miscellaneous information 
associated to the ledger entry. 

100 VarChar None M 

Bankruptcy Table 

The Bankruptcy table contains bankruptcy information for accounts. Each account can have one 
bankruptcy record for one debtor only. To ensure that Exchange locates the correct debtor on the 
account, you must map the debtor field that you specified as unique criteria in the Unique Debtor 
Criteria section of the General tab. For more information, see Specify Unique Debtor Criteria.  
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

AccountID Code that Latitude assigned 
to identify the account. For 
new business imports, don't 
map this field. For 
maintenance imports, you 
must map this field to ensure 
that Exchange Manager 
locates the correct account. 

4 Integer Master/Number NB, M 

DebtorID Code that Latitude assigned 
to identify the debtor 
associated to the bankruptcy. 
If you selected "Debtor ID" as 
the unique debtor criteria. 

4 Integer Debtors/DebtorID NB, M 

Seq Code that indicates whether 
the debtor is the primary or 
secondary debtor on the 
account. If you selected 
"Seq" as the unique debtor 
criteria, you must map this 
field. 

0 = Primary debtor  
1 or greater = Secondary 
debtor  

4 Integer Debtors/Seq NB, M 

Relationship Person's relationship to the 
account. If you selected 
"Relationship" as the unique 
debtor criteria, you must 
map this field. 

30 VarChar Debtors/Relationship NB, M 

Name Debtor name. If you selected 
"Name" as the unique debtor 
criteria, you must map this 
field. 

300 VarChar Debtors/Name NB, M 

Chapter Bankruptcy chapter. 
Values are 7, 11, 12, or 13. 

1 TinyInt None NB, M 

DateFiled Bankruptcy filed date. 8 DateTime None NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

CaseNumber Bankruptcy case number. 20 VarChar None NB, M 

CourtCity Bankruptcy court city. 50 VarChar None NB, M 

CourtDistrict Bankruptcy court district. 200 VarChar None NB, M 

CourtDivision Bankruptcy court division. 100 VarChar None NB, M 

CourtPhone Bankruptcy court phone 
number. 

50 VarChar None NB, M 

CourtStreet1 Bankruptcy court address 
line 1. 

128 VarChar None NB, M 

CourtStreet2 Bankruptcy court address 
line 2. 

128 VarChar None NB, M 

CourtState Bankruptcy court state. 3 VarChar None NB, M 

CourtZIPCode Bankruptcy court ZIP Code. 15 VarChar None NB, M 

Trustee Trustee's name. 50 VarChar None NB, M 

TrusteeStreet1 Trustee's address line 1. 128 VarChar None NB, M 

TrusteeStreet2 Trustee's address line 2. 128 VarChar None NB, M 

TrusteeCity Trustee's city. 100 VarChar None NB, M 

TrusteeState Trustee's state. 3 VarChar None NB, M 

TrusteeZIPCode Trustee's ZIP Code. 10 VarChar None NB, M 

TrusteePhone Trustee's phone number. 30 VarChar None NB, M 

Has341Info Flag that indicates whether 
the customer set the 
creditors meeting.  
1 = Yes 

0 = No 

1 Bit None NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

DateTime341 Date and time of the 
meeting of creditors. 

8 DateTime None NB, M 

Location341 Meeting of creditors 
location. 

200 VarChar None NB, M 

Comments Bankruptcy comments. 500 VarChar None NB, M 

Status Bankruptcy status. 100 VarChar None NB, M 

TransmittedDate Date AIM or another 
interface transmitted the 
bankruptcy information. If 
you map to this field, the 
system doesn't populate it in 
the table unless you also 
map AIM information in 
Exchange. 

4 SmallDate None NB, M 

AuctionAmount Amount the auction house 
received for the surrendered 
item. Available for 
bankruptcy chapter 7 where 
method = "Surrender" only.  

8 Money None NB, M 

AuctionAmountApplied Amount of the auction funds 
applied to the account. 
Available for bankruptcy 
chapter 7 where method = 
"Surrender" only. 

8 Money None NB, M 

AuctionDate Date the auction house 
auctioned the surrendered 
item. Available for 
bankruptcy chapter 7 where 
method = "Surrender" only. 

8 DateTime None NB, M 

AuctionFee Fee the auction house 
charged for auctioning the 
surrendered item. Available 
for bankruptcy chapter 7 

8 Money None NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

where method = "Surrender" 
only. 

AuctionHouse Name of the auction house 
that auctioned the 
surrendered item. Available 
for bankruptcy chapter 7 
where method = "Surrender" 
only. 

50 VarChar None NB, M 

BankruptcyID Code that Latitude assigns to 
identify the bankruptcy 
record. Don't map this field. 

4 Integer None NB 

ConfirmationHearingDate Confirmation hearing date. 8 DateTime None NB, M 

ConvertedFrom Original bankruptcy chapter 
number. 

1 TinyInt None NB, M 

CTL Do not use (reserved for 
AIM). 

3 VarChar None NB, M 

DateNotice Date the client received a 
notice that the debtor filed 
for bankruptcy. 

8 DateTime None NB, M 

DischargeDate Date the court discharged 
the bankruptcy.  

8 DateTime None NB, M 

DismissalDate Date the court dismissed the 
bankruptcy. 

8 DateTime None NB, M 

HasAsset Indicates whether the debtor 
has assets to secure the 
debt. Available for 
bankruptcy chapter 7 only. 

1 = Yes 

0 = No 

1 Bit None NB, M 

ProofFiled Date the client sent a proof 
of claim to the court. 

8 DateTime None NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

Reaffirm Indicates whether the debtor 
reaffirmed the debt under 
new terms. 

R = Reaffirmation 
S = Surrender 
V = Voluntary payments 

Blank = No intention to 
reaffirm 

1 Char None NB, M 

ReaffirmAmount Amount that the debtor 
reaffirmed to pay. 

8 Money None NB, M 

ReaffirmDateFiled Date the debtor filed the 
reaffirmation with the court. 

8 DateTime None NB, M 

ReaffirmTerms Reaffirmation terms. 50 VarChar None NB, M 

SecuredAmount Amount of the debt that is 
secured. Available for 
bankruptcy chapters 11, 12, 
and 13 only. 

8 Money None NB, M 

SecuredPercentage Percentage of the secured 
amount for which the debtor 
remains responsible. 
Available for bankruptcy 
chapters 11, 12, and 13 only. 

4 SmallMon None NB, M 

SurrenderDate Date the debtor surrendered 
the item. Available for 
bankruptcy chapter 7 only. 

8 DateTime None NB, M 

SurrenderMethod Method the debtor used to 
surrender the item (shipped 
or picked up). Available for 
bankruptcy chapter 7 only. 

50 VarChar None NB, M 

UnsecuredAmount Amount of the debt that is 
unsecured. Available for 
chapters 11, 12, and 13 only. 

8 Money None NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

UnsecuredPercentage Percentage of the unsecured 
amount for which the debtor 
remains responsible. 
Available for chapters 11, 12, 
and 13 only. 

4 SmallMon None NB, M 

VoluntaryAmount Amount the debtor 
volunteered to pay. Available 
for bankruptcy chapter7, 
voluntary payment method 
only. 

8 Money None NB, M 

VoluntaryDate Date the debtor volunteered 
to pay off the debt. Available 
for bankruptcy chapter7, 
voluntary payment method 
only. 

8 DateTime None NB, M 

VoluntaryTerms Terms of the voluntary 
payment agreement. 
Available for bankruptcy 
chapter 7, voluntary 
payment method only. 

50 VarChar None NB, M 

Court Cases Table 

The Court Cases table contains court case information for accounts. Each account can have one court 
case record only.   

Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

CourtCaseID Code that 
Latitude 
assigned to 
identify 
the court 
case 
record. For 
new 
business 
imports, 
don't map 

4 Integer None NB, M 
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Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

this field. 
For 
maintenan
ce imports, 
you must 
map this 
field to 
ensure 
that 
Exchange 
Manager 
locates the 
correct 
court case 
record. 

AccountID Code that 
Latitude 
assigned to 
identify 
the 
account. 
For new 
business 
imports, 
don't map 
this field. 
For 
maintenan
ce imports, 
you must 
map this 
field to 
ensure 
that 
Exchange 
Manager 
locates the 
correct 
account. 

4 Integer Master/N
umber 

NB, M 

CourtID Code that 
identifies 

4 Integer Courts/Co
urtID 

NB, M 
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Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

the court 
assigned to 
the case. 
You must 
have 
already 
created 
this code 
in Latitude. 

Judge Name of 
the judge 
assigned 
to the 
case. 

100 VarChar None NB, M 

CaseNumber Court case 
number. 

50 VarChar None NB, M 

DateFiled Date the 
Plaintiff 
filed the 
complaint 
with the 
court. 

8 DateTime None NB, M 

Judgment Flag that 
indicates 
whether a 
judgment 
exists on 
the 
account. 

1 = Yes 

0 = No 

1 Bit None NB, M 

JudgmentAmount Amount of 
the 
judgment 
awarded 

8 Money None NB, M 
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Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

toward 
principal. 

JudgmentIntRate Interest 
rate 
calculated 
from the 
specified 
interest 
date and 
applied 
toward the 
awarded 
principal 
amount. 

4 Real None NB, M 

JudgmentDate Date the 
court 
awarded 
judgment. 

8 DateTime None NB, M 

Status Status of 
the legal 
case. 

50 VarChar None NB, M 

MiscInfo1 Use for 
whatever 
informatio
n you 
choose. 

500 VarChar None NB, M 

MiscInfo2 Use for 
whatever 
informatio
n you 
choose. 

500 VarChar None NB, M 

Remarks Comments 
regarding 
the case. 

1000 VarChar None NB, M 

Plaintiff Person 
who filed 

200 VarChar None NB, M 
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Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

the 
complaint. 

Defendant Person 
defending 
the case. 

100 VarChar None NB, M 

DateAnswered Date the 
Defendant 
filed the 
response 
to the 
complaint 
with the 
court. 

4 SmallDate None NB, M 

StatusDeadline Statutory 
deadline 
for trying 
the case. 

4 SmallDate None NB, M 

CourtDate Date and 
time of the 
trial. 

8 DateTime None NB, M 

DiscoveryCutoff Deadline 
for 
discovery 
requests. 

4 SmallDate None NB, M 

MotionCutOff Deadline 
for filing a 
motion to 
reopen 
discovery. 

4 SmallDate None NB, M 

ArbitrationDate Date and 
time of 
arbitration. 

8 DateTime None NB, M 

LastSummaryJudgmentDate Deadline 
for filing 

4 SmallDate None NB, M 
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Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

summary 
judgment 
motions. 

JudgmentIntAward Interest 
amount 
awarded in 
the 
judgment. 

8 Money None NB, M 

JudgmentCostAward Court costs 
awarded in 
the 
judgment. 

8 Money None NB, M 

JudgmentAttorneyCostAward Attorney 
fees 
awarded in 
the 
judgment. 

8 Money None NB, M 

JudgmentOtherAward Miscellane
ous fees 
awarded in 
the 
judgment. 

8 Money None NB, M 

IntFromDate Date to use 
to apply 
interest at 
the 
specified 
interest 
rate. 

4 SmallDate None NB, M 

AccruedInt Amount of 
accrued 
interest. 

8 Money None NB, M 

DateCreated Date the 
court 

8 DateTime None NB, M 
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Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

awarded 
judgment. 

DateUpdated Date the 
court clerk 
recorded 
the 
judgment. 

8 DateTime None NB, M 

UpdatedBy Code that 
identifies 
the user 
who 
updated 
the court 
case in 
Latitude. 

4 Integer None NB, M 

UpdatedCheckSum Internally 
calculated. 

50 VarChar None NB, M 

CourtName Name of 
the court. 

50 VarChar None NB, M 

CourtCounty Court's 
county. 

50 VarChar None NB, M 

CourtNotes Comments 
regarding 
the court. 

1000 VarChar None NB, M 

ReverseJudgment Flag that 
indicates 
whether 
the court 
reversed 
the 
judgment. 

1 = Yes 

0 = No 

1 Bit None NB, M 
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Field Name Descriptio
n 

Length Data Type Parent 
Table and 
Field 

Import 
Types 

IsCorrection Flag that 
indicates 
whether 
the 
judgment 
reversal is 
to correct 
a judgment 
created in 
error. 

1 = Yes 

0 = No 

1 Bit None NB, M 

Customer Notes Table 

The Customer Notes table contains debtor notes regarding accounts. Each account can have multiple 
note records. To ensure that Exchange locates the correct debtor on the account, you must map the 
debtor field that you specified as unique criteria in the Unique Debtor Criteria section of the General 
tab. For more information, see Specify Unique Debtor Criteria.  

Field 
Name 

Description Length Data Type Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned to identify the 
account. For new business imports, don't map 
this field. For maintenance imports, you must 
map this field to ensure that Exchange Manager 
locates the correct account. 

4 Integer Master/Number NB, M 

Seq Code that indicates whether the debtor is the 
primary or secondary debtor on the account. If 
you selected "Seq" as the unique debtor criteria, 
you must map this field. 

0 = Primary debtor  
1 or greater = Secondary debtor information 

4 Integer Debtors/Seq NB, M 

NoteDate Date a user added the note. 8 DateTime None NB, M 

NotText Note content. 255 Char None NB, M 

DCC Table 
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The Debtor Credit Cards (DCC) table contains debtor credit card payments for accounts. Each account 
can have multiple credit card payment records. 

Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned to 
identify the account. For new business 
imports, don't map this field. For 
maintenance imports, you must map 
this field to ensure that Exchange 
Manager locates the correct account. 

4 Integer Master/Number NB, M 

Amount Payment amount. 8 Money None NB, M 

Approved Transaction approval date. 8 DateTime None NB, M 

ApprovedBy User who approved the transaction. 10 VarChar None NB, M 

CardNumber Credit card number. 30 VarChar None NB, M 

City Credit card holder's city. 25 VarChar None NB, M 

Code Credit card security code. 10 VarChar None NB, M 

CollectorFee Credit card transaction fee. 8 Money None NB, M 

CreditCard Code that identifies the credit card 
type. 
0001 = Master Card or Visa 
0002 = American Express 
0003 = Discover Card 

4 VarChar None NB, M 

DateEntered Transaction date. 4 SmallDate None NB, M 

DebtorID Code that Latitude assigned to 
identify the debtor associated to the 
credit card transaction. 

4 Integer Debtors/DebtorID NB, M 

DepositDate Scheduled deposit date. 4 SmallDate None NB, M 

ExpMonth Credit card expiration month. 2 VarChar None NB, M 

ExpYear Credit card expiration year. 2 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

IsActive Flag that indicates whether the credit 
card is active. 

1 = Yes 
0 = No 

1 Bit None NB, M 

LetterCode Code that identifies the Notice of 
Intention to Deposit (NITD) letter in 
Latitude.  

5 VarChar None NB, M 

Name Name on the credit card. 30 VarChar None NB, M 

NITDSendDate Date to send NITD letter. 4 SmallDate None NB, M 

NITDSentDate Date user sent the NITD letter. 8 DateTime None NB, M 

NSFCount Number of insufficient funds 
transactions. 

4 Integer None NB, M 

OnHoldDate Date the agent placed the transaction 
on hold. 

4 SmallDate None NB, M 

Printed Flag that indicates whether the 
transaction printed. 

1 = Yes 

0 = No 

1 VarChar None NB, M 

PrintedDate Transaction printed date. 8 DateTime None NB, M 

ProcessStatus Transaction processing status. 

Closed = Processed 
Active = Not processed 

25 VarChar None NB, M 

ProjectedFee Fee to apply to the transaction. 8 Money None NB, M 

PromiseMode Payment arrangement type. 

1 = Single payment 
2 = Monthly payments 
3 = Bi-weekly payments 
4 = Twice per month payments 
5 = Weekly payments 

1 TinyInt None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

6 = Settlement 
7 = Multi-part settlement 
8 = Promise payoff 
9 = Every 28 days 
10 = Monthly on last day 

State Code that identifies the credit card 
holder's state of residence. 

3 VarChar None NB, M 

Street1 Credit card holder's address line 1. 128 VarChar None NB, M 

Street2 Credit card holder's address line 2. 128 VarChar None NB, M 

Surcharge Surcharge amount applied to the 
transaction. 

8 Money None NB, M 

UseProjectedFee Not used. 1 Bit None NB, M 

ZIPCode Credit card holder's ZIP Code. 10 VarChar None NB, M 

 
Debtor Assets Table 

The Debtor Assets table contains debtor assets for accounts. Each account can have multiple asset 
records. To ensure that Exchange locates the correct debtor on the account, you must map the debtor 
field that you specified as unique criteria in the Unique Debtor Criteria section of the General tab. For 
more information, see Specify Unique Debtor Criteria.  

Field Name Description Length Data 
Type 

Parent Table and 
Field 

Import 
Types 

AccountID Code that Latitude assigns to identify the 
account. Don't map this field. 

4 Integer Master/Number NB 

DebtorID Code that Latitude assigns to identify the 
debtor on the account. If you selected 
"Debtor ID" as the unique debtor criteria, 
you must map this field. 

4 Integer Debtors/DebtorID NB 

Name Debtor name in "lastname, firstname MI 
suffix" format. If you selected "Name" as the 
unique debtor criteria, you must map this 
field. 

50 VarChar Debtors/Name NB 
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Field Name Description Length Data 
Type 

Parent Table and 
Field 

Import 
Types 

AssetType Code that identifies the type of asset. You 
must have already created this code in 
Latitude. 

1 TinyInt None NB 

Description Description of the asset. 4000 VarChar None NB 

CurrentValue Current value of the asset. 8 Money None NB 

LienAmount Amount held against the asset. 8 Money None NB 

ValueVerified Flag that indicates whether an agent verified 
the asset's value. 

1 = Yes 

0 = No 

1 Bit None NB 

LienVerified Flag that indicates whether an agent verified 
the lien amount. 

1 = Yes 

0 = No 

1 Bit None NB 

Debtors Table 

The Debtors table contains debtors and other parties associated to accounts. Each account can have 
multiple debtor records. To ensure that Exchange locates the correct debtor on the account, you must 
map the debtor field that you specified as unique criteria in the Unique Debtor Criteria section of the 
General tab. For more information, see Specify Unique Debtor Criteria. 

Use DEBTORID or NAME to map to the correct debtor record. In the Master table, Exchange only 
populates the Debtor0 (primary debtor) record. 

Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned 
to identify the account. For 
new business imports, don't 
map this field. For 
maintenance imports, you 
must map this field to ensure 
that Exchange Manager 
locates the correct account. 

4 Integer Master/Number NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

DebtorID Code that Latitude assigned 
to identify the debtor. If you 
selected "Debtor ID" as the 
unique debtor criteria, you 
must map this field. 

4 Integer None NB, M 

Seq Code that indicates whether 
the debtor is the primary or 
secondary debtor on the 
account. If you selected "Seq" 
as the unique debtor criteria, 
you must map this field. 

0 = Primary debtor 
1 or greater = Secondary 
debtor 

4 Integer Master/Seq NB, M 

Responsible Flag that indicates whether 
the person is responsible for 
the account. 

1 = Yes 
0 = No 

1 Bit None NB, M 

IsBusiness Flag that indicates whether 
the account is a business 
account. 

1 = Yes 
0 = No 

1 Bit None NB, M 

BusinessName Business name. If ISBUSINESS 
flag = 0, leave this field blank. 

50 VarChar None NB, M 

IsParsed Flag that indicates whether 
the name is parsed. 

1 = Yes 
0 = No 

1 Bit None NB, M 

Name Debtor name in "lastname, 
firstname MI suffix" format. If 
you selected "Name" as the 

300 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

unique debtor criteria, you 
must map this field. 

Prefix Optional name prefix (Mr, 
Ms, Miss, Mrs, Dr, Prof). 

50 VarChar None NB, M 

FirstName Debtor's first name. 50 VarChar None NB, M 

MiddleName Debtor's middle name. 50 VarChar None NB, M 

LastName Debtor's last name. 50 VarChar None NB, M 

OtherName Debtor's alternate name.  30 VarChar None NB, M 

Suffix Optional name suffix (I, II, 
III, Jr, Sr). 

50 VarChar Master/other NB, M 

Street1 Debtor's address line 1.  128 VarChar Master/Street1 NB, M 

Street2 Debtor's address line 2.  128 VarChar Master/Street2 NB, M 

City Debtor's city.  30 VarChar Master/City NB, M 

State Code that identifies the 
customer's state of residence.  

3 VarChar Master/State NB, M 

ZIPCode Debtor's ZIP Code.  10 VarChar Master/Zipcode NB, M 

County Debtor's county of residence. 50 VarChar None NB, M 

Country Debtor's country of residence. 50 VarChar None NB, M 

MR Flag that indicates whether 
the address is good. 

Y = Yes, address is good 

N = No, address is bad or 
unknown 

1 VarChar None NB, M 

SSN Debtor's social security 
number. If you selected "SSN" 

15 VarChar Master/SSN NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

as the unique debtor criteria, 
you must map this field. 

HomePhone Debtor's home phone 
number. 

30 VarChar Master/Homephone NB, M 

WorkPhone Debtor's work phone number.  30 VarChar Master/Workphone NB, M 

Pager Debtor's pager number. 20 VarChar None NB, M 

Fax Debtor's fax number. 50 VarChar None NB, M 

OtherPhone1 Not used. 20 VarChar None NB, M 

OtherPhoneType Not used. 15 VarChar None NB, M 

OtherPhone2 Not used. 20 VarChar None NB, M 

OtherPhone2Type Not used. 15 VarChar None NB, M 

OtherPhone3 Not used. 20 VarChar None NB, M 

OtherPhone3Type Not used. 15 VarChar None NB, M 

Email Debtor's email address. 50 VarChar None NB, M 

Gender Debtor's gender. 

M = Male 
F = Female 
U = Unknown 
N = Neutral 
C = Company 

1 Char None NB, M 

Language Debtor's native language. 30 VarChar None NB, M 

DLNum Debtor's driver license 
number. 

50 VarChar None NB, M 

DOB Debtor's date of birth.  8 DateTime Master/DOB NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

JobName Debtor's employer's name. 50 VarChar None NB, M 

JobAddr1 Debtor's employer's address 
line 1. 

128 VarChar None NB, M 

JobAddr2 Debtor's employer's address 
line 2. 

128 VarChar None NB, M 

JobCSZ Debtor's employer's city, 
state, and ZIP Code. 

50 VarChar None NB, M 

JobMemo Note about the debtor's 
employment. 

16 Text None NB, M 

Spouse Spouse's name. 50 VarChar None NB, M 

SpouseHomePhone Spouse's home phone 
number. 

20 VarChar None NB, M 

SpouseJobName Spouse's employer's name. 50 VarChar None NB, M 

SpouseJobAddr1 Spouse's employer's address 
line 1. 

128 VarChar None NB, M 

SpouseJobAddr2 Spouse's employer's address 
line 2. 

128 VarChar None NB, M 

SpouseJobCSZ Spouse's employer's city, 
state, and ZIP Code. 

50 VarChar None NB, M 

SpouseWorkPhone Spouse's work phone number. 20 VarChar None NB, M 

SpouseJobMemo Note about the spouse's 
employment. 

16 Text None NB, M 

SpouseResponsible Not used. 1 VarChar None NB, M 

Relationship Debtor's relationship to the 
account. If you selected 
"Relationship" as the unique 

30 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

debtor criteria, you must map 
this field. 

USPSKeyLine Unique code that identifies 
a mail item. 

16 VarChar None NB, M 

IsHomeOwner Not used. 1 Bit None NB, M 

CBRException Exception that prevents 
reporting the debtor to the 
credit bureaus. 

2 SmallInt None NB, M 

CBRExclude Flag that indicates whether to 
prevent reporting of the 
account to the credit bureaus. 

1 = Yes 

0 = No 

1 Bit None NB, M 

DebtorMemo Not used. 16 Text None NB, M 

EarlyTimeZone Code that identifies the 
earliest time zone (for 
example, 5 is Eastern) allowed 
to call the debtor. 

4 Integer None NB, M 

LateTimeZone Code that identifies the latest 
time zone (for example, 5 is 
Eastern) allowed to call the 
debtor. 

4 Integer None NB, M 

ObserveDST Flag that indicates whether 
the debtor is in a location that 
observes daylight savings 
time. 

1= Yes 

0 = No 

1 Bit None NB, M 

RegionCode Not used. 2 Char None NB, M 

TimeZoneOverride Not used. 1 Bit None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

IsAuthorizedAccountUser Flag that indicates whether 
the person is an authorized 
user of the account. 

1 = Yes 
0 = No 

1 Bit None NB, M 

Deceased Table 

The Deceased table contains deceased debtor information for accounts. Each account can have one 
deceased debtor record only. To ensure that Exchange locates the correct debtor on the account, you 
must map the debtor field that you specified as unique criteria in the Unique Debtor Criteria section of 
the General tab. For more information, see Specify Unique Debtor Criteria.  

Field Name Description Length Data Type Parent Table and Field Import 
Types 

AccountID Code that Latitude assigned to 
identify the account. For new 
business imports, don't map this 
field. For maintenance imports, 
you must map this field to ensure 
that Exchange Manager locates 
the correct account. 

4 Integer Master/Number NB, M 

DebtorID Code that Latitude assigned to 
identify the deceased debtor. If 
you selected "Debtor ID" as the 
unique debtor criteria. 

4 Integer Debtors/DebtorID NB, M 

Seq Code that indicates whether the 
debtor is the primary or secondary 
debtor on the account. If you 
selected "Seq" as the unique 
debtor criteria, you must map this 
field. 

0 = Primary debtor  
1 or greater = Secondary debtor  

4 Integer Debtors/Seq NB, M 

Relationship Debtor's relationship to the 
account. If you selected 
"Relationship" as the unique 

30 VarChar Debtors/Relationship NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

debtor criteria, you must map this 
field. 

Name Debtor name. If you selected 
"Name" as the unique debtor 
criteria, you must map this field. 

300 VarChar Debtors/Name NB, M 

FirstName Deceased person’s first name. 30 VarChar Debtors/Firstname NB, M 

LastName Deceased person’s last name. 30 VarChar Debtors/Lastname NB, M 

State Deceased person’s state of 
residence. 

3 VarChar Debtors/State NB, M 

PostalCode Deceased person’s ZIP Code. 10 VarChar Debtors/Zipcode NB, M 

SSN Deceased person’s social security 
number. If you selected "SSN" as 
the unique debtor criteria, you 
must map this field. 

15 VarChar Debtors/SSN NB, M 

DOB Deceased person’s date of birth. 8 DateTime Debtors/DOB NB, M 

DOD Deceased person’s date of death. 8 DateTime None NB, M 

MatchCode Code returned from the vendor 
that indicates what the system 
matched on the Deceased scrub. 
For example, "NAS" means the 
vendor matched to the deceased 
debtor's name, address, and SSN. 

5 VarChar None NB, M 

TransmittedDate Date AIM or another interface 
transmitted the data. If you map 
to this field, the system doesn't 
populate it in the table unless you 
also map AIM information in 
Exchange. 

4 SmallDate None NB, M 

CaseNumber Claim case number. 20 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

ClaimDeadline Deadline for filing a claim against 
the debtor's estate. 

8 DateTime None NB, M 

CourtCity Court's city. 50 VarChar None NB, M 

CourtDistrict Court district. 200 VarChar None NB, M 

CourtDivision Court division. 100 VarChar None NB, M 

CourtPhone Court's phone number. 50 VarChar None NB, M 

CourtState Court's state. 3 VarChar None NB, M 

CourtStreet1 Court's street address line 1. 128 VarChar None NB, M 

CourtStreet2 Court's street address line 2. 128 VarChar None NB, M 

CourtZIPCode Court's ZIP Code. 15 VarChar None NB, M 

CTL Not used. 3 VarChar None NB, M 

DateFiled Date the customer filed a claim 
against the debtor's estate. 

8 DateTime None NB, M 

Executor Name of the executor of the 
estate. 

50 VarChar None NB, M 

ExecutorCity Executor of the estate's city. 100 VarChar None NB, M 

ExecutorFax Executor of the estate's fax 
number. 

50 VarChar None NB, M 

ExecutorPhone Executor of the estate's phone 
number. 

50 VarChar None NB, M 

ExecutorState Executor of the estate's state of 
residence. 

3 VarChar None NB, M 

ExecutorStreet1 Executor of the estate's street 
address line 1. 

128 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and Field Import 
Types 

ExecutorStreet2 Executor of the estate's street 
address line 2. 

128 VarChar None NB, M 

ExecutorZIPCode Executor of the estate's ZIP Code. 10 VarChar None NB, M 

Early Stage Data Table 

This table is no longer used. 

Extra Data Table 

The Extra Data table contains custom data information for accounts. Each account can have multiple 
extra data records. 

Field Name Description Length Data 
Type 

Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned to identify the 
account. For new business imports, don't map 
this field. For maintenance imports, you must 
map this field to ensure that Exchange 
Manager locates the correct account. 

4 Integer Master/Number NB, M 

ExtraCode Code that identifies the extra data record. You 
must have already created this code in 
Latitude. 

2 VarChar None NB, M 

Line1 Line 1 of extra data information. 128 VarChar None NB, M 

Line2 Line 2 of extra data information. 128 VarChar None NB, M 

Line3 Line 3 of extra data information. 128 VarChar None NB, M 

Line4 Line 4 of extra data information. 128 VarChar None NB, M 

Line5 Line 5 of extra data information. 128 VarChar None NB, M 

Hot Notes Table 

The Hot Notes table contains important information for working accounts. Each account can have one 
hot note record only. 
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Field Name Description Length Data 
Type 

Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned to identify the 
account. For new business imports, don't map 
this field. For maintenance imports, you must 
map this field to ensure that Exchange 
Manager locates the correct account. 

4 Integer Master/Number NB, M 

HotNote Hot note information. 16 Text None NB, M 

Insurance Table 

The Insurance table contains insurance information for accounts. Each account can have one insurance 
record only. 

Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned 
to identify the account. For 
new business imports, don't 
map this field. For 
maintenance imports, you 
must map this field to ensure 
that Exchange Manager 
locates the correct account. 

4 Integer Master/Number NB, M 

InsuredName Insured person's name. 50 VarChar None NB, M 

InsuredStreet1 Insured person's street 
address line 1. 

128 VarChar None NB, M 

InsuredStreet2 Insured person's street 
address line 2. 

128 VarChar None NB, M 

InsuredCity Insured person's city. 50 VarChar None NB, M 

InsuredState Insured person's state. 3 Char None NB, M 

InsuredZIP Insured person's ZIP Code. 10 Char None NB, M 

InsuredPhone Insured person's phone 
number. 

20 Char None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

InsuredBirthday Insured person's date of 
birth. 

8 DateTime None NB, M 

InsuredSex Insured person's gender. 1 Char None NB, M 

InsuredEmployer Name of the insured person's 
employer. 

50 VarChar None NB, M 

AuthPmtToProvider Flag that indicates 
whether the insurance 
provider authorized 
payments to the 
healthcare provider. 
1 = Yes 
0 = No 

1 Bit None NB, M 

AcceptAssignment Flag that indicates whether 
the healthcare provider 
accepted assignment from 
the insurance provider. 

1 = Yes 
0 = No 

1 Bit None NB, M 

EmployerHealthPlan Name of the employer's 
health plan. 

50 VarChar None NB, M 

PolicyNumber Insurance policy number. 50 VarChar None NB, M 

PatientRelationToInsured Patient's relationship to the 
insured. 

50 VarChar None NB, M 

Program Insurance program name. 50 VarChar None NB, M 

GroupNumber Insurance group number. 50 VarChar None NB, M 

GroupName Insurance group name. 50 VarChar None NB, M 

CarrierName Name of the person's 
insurance carrier. 

100 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

CarrierStreet1 Insurance carrier's street 
address line 1. 

128 VarChar None NB, M 

CarrierStreet2 Insurance carrier's street 
address line 2. 

128 VarChar None NB, M 

CarrierCity Insurance carrier's city. 50 VarChar None NB, M 

CarrierState Insurance carrier's state. 3 Char None NB, M 

CarrierZIP Insurance carrier's ZIP Code. 10 Char None NB, M 

CarrierDocProviderNumber Number the insurance carrier 
assigned to identify a 
provider. 

30 VarChar None NB, M 

CarrierRefDocProviderNumber Number the insurance carrier 
assigned to identify the 
referring provider. 

30 VarChar None NB, M 

AdditionalInfo More information about the 
case. 

5000 VarChar None NB, M 

DateCreated Date the user added the 
insurance information. 

8 DateTime None NB, M 

DateUpdated Date the user updated the 
insurance information. 

8 DateTime None NB, M 

UpdatedCheckSum Update control. 50 VarChar None NB, M 

UpdatedBy Code that identifies the user 
who updated the insurance 
record in Latitude. 

4 Integer None NB, M 

CoordinationNumber Number that identifies the 
health insurance plan 
when a patient has more 
than one (for example, a 
primary and secondary 
healthcare plan). 

50 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

InsuredWorkPhone Insured person's work 
phone number. 

20 VarChar None NB, M 

InsuredSSN Insured person's social 
security number. 

15 VarChar None NB, M 

Category Type of insurance (for 
example, primary or 
secondary). 

15 VarChar None NB, M 

 
Legal Ledger Table 

The Legal Ledger table contains legal ledger information for accounts. Each account can have multiple 
legal ledger records. 

Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

AccountID Code that Latitude 
assigned to identify the 
account. For new 
business imports, don't 
map this field. For 
maintenance imports, 
you must map this field 
to ensure that 
Exchange Manager 
locates the correct 
account. 

4 Integer Master/Number NB, M 

Customer Code that identifies the 
customer. You must 
have already created 
this code in Latitude. 

7 VarChar None NB 

LegalLedgerID Code that Latitude 
assigned to identify the 
ledger record. 

4 Integer None NB, M 

ItemDate Date a user created the 
ledger item. 

8 DateTime None NB, M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

Created Date a user created the 
ledger entry. 

8 DateTime None NB, M 

Description Description of the 
ledger item. 

50 VarChar None NB, M 

LegalLedgerTypeID Code that identifies the 
type of ledger item. 
You must have already 
created this code in 
Latitude. 

4 Integer None NB, M 

LegalLedgerTypeCode Latitude code that 
identifies the ledger 
account to which to 
apply the debit or 
credit. 

    None NB, M 

DebitAmt Amount to debit from 
the account. 

8 Money None NB, M 

CreditAmt Amount to credit to the 
account. 

8 Money None NB, M 

PayHistoryID Code that identifies a 
payment in the 
PayHistoryDetails file. 

4 Integer None NB 

Invoiceable Flag that indicates 
whether the ledger 
item represents a 
transaction that you 
can invoice. 

1 = Yes 

0 = No 

1 Bit None NB 

Invoice Code that identifies the 
invoice the transaction 
appears on. You must 
have already created 
this code in Latitude. 

4 Integer None NB 



Exchange Manager Printable Help 

165 

Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

AIMID Code that Latitude 
assigned to identify the 
outside collection 
agency or attorney that 
created the ledger 
entry. 

4 Integer None NB, M 

AIMUniqueID Code that identifies the 
transaction in the 
outside collection 
agency's or attorney's 
system. 

50 VarChar None NB, M 

AIMInvoiceID Code that identifies the 
invoice in the outside 
collection agency's or 
attorney's system. 

50 VarChar None NB, M 

Approved 

  

  

Flag that indicates 
whether the person 
approved the ledger 
transaction. 

1 = Yes 

0 = No 

1 Bit None M 

InsertBalancingTransactionsOnDeclines Not used.     None M 

ApprovedOn Date the person 
approved the ledger 
transaction. 

8 DateTime None NB, M 

ApprovedAmount Ledger amount that 
Legal and Accounting 
approved. 

8 Money None NB, M 

ApprovedBy Person who approved 
the ledger transaction. 

50 VarChar None NB, M 

AccountingLedgerID Code that identifies the 
ledger transaction in 
the outside collection 

50 VarChar None NB, M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

agency's or attorney's 
system. 

Misc Extra Table 

The Misc Extra table contains miscellaneous data for accounts. Each account can have multiple 
miscellaneous data records. 

Field 
Name 

Description Length Data 
Type 

Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned to identify the account. 
For new business imports, don't map this field. For 
all other imports, you must map this field to ensure 
that Exchange Manager locates the correct account. 

4 Integer Master/Number NB, F, 
M, R 

Title Title associated to the information. 30 VarChar None NB, F, 
M, R 

TheData Miscellaneous information. 100 VarChar None NB, F, 
M, R 

Notes Table 

The Notes table contains notes for accounts. Each account can have multiple note records. 

Field 
Name 

Description Length Data Type Parent Table and 
Field 

Import 
Types 

Number Code that Latitude assigned to identify the 
account. For new business imports, don't map 
this field. For all other imports, you must map 
this field to ensure that Exchange Manager 
locates the correct account. 

4 Integer Master/Number NB, F, 
M, R 

Created Date a user or the system created the note 
creation. 

8 DateTime None NB, F, 
M, R 

User0 Code that identifies the user who created the 
note. You must have already created this code in 
Latitude. 

10 VarChar None NB, F, 
M, R 
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Field 
Name 

Description Length Data Type Parent Table and 
Field 

Import 
Types 

Action Latitude action code to associate to the note. 
You must have already created this code in 
Latitude. 

6 VarChar None NB, F, 
M, R 

Result Latitude result code to associate to the note. 
You must have already created this code in 
Latitude. 

6 VarChar None NB, F, 
M, R 

Comment Content of the note. 256 Text None NB, F, 
M, R 

Patient Info Table 

The Patient Info table contains patient information for accounts. Each account can have one patient 
record only.   

Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

AccountID Code that 
Latitude assigned 
to identify the 
account. For new 
business imports, 
don't map this 
field. For 
maintenance 
imports, you must 
map this field to 
ensure that 
Exchange 
Manager locates 
the correct 
account. 

4 Integer Master/Number NB, M 

AdmissionDate Patient admission 
date. 

8 DateTime None NB, M 

Age Patient's age. 1 TinyInt None NB, M 

City Patient's city. 35 VarChar None NB, M 

Country Patient's country. 25 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

DischargeDate Patient's 
discharge date. 

8 DateTime None NB, M 

DOB Patient's date of 
birth. 

8 DateTime None NB, M 

DoctorFax Doctor's fax 
number. 

20 VarChar None NB, M 

DoctorName Doctor's name. 75 VarChar None NB, M 

DoctorPhnoe Doctor's phone 
number. 

20 VarChar None NB, M 

EmployerName Patient's 
employer's name. 

75 VarChar None NB, M 

FacilityCity Medical facility's 
city. 

35 VarChar None NB, M 

FacilityCountry Medical facility's 
country. 

25 VarChar None NB, M 

FacilityFax Medical facility's 
fax number. 

20 VarChar None NB, M 

FacilityName Name of the 
medical facility. 

75 VarChar None NB, M 

FacilityPhone Medical facility's 
phone number. 

20 VarChar None NB, M 

FacilityState Medical facility's 
state. 

5 VarChar None NB, M 

FacilityStreet1 Medical facility's 
street address line 
1. 

128 VarChar None NB, M 

FacilityStreet2 Medical facility's 
street address line 
2. 

128 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

FacilityZIPCode Medical facility's 
ZIP Code. 

15 VarChar None NB, M 

GuarantorRecNumber Code that 
identifies the 
payment 
guarantor. 

30 VarChar None NB, M 

KinCity Next of kin's city. 35 VarChar None NB, M 

KinCountry Next of kin's 
country. 

25 VarChar None NB, M 

KinName Name of the 
patient's next of 
kin. 

75 VarChar None NB, M 

KinPhone Next of kin's 
phone number. 

20 VarChar None NB, M 

KinState Next of kin's 
state. 

5 VarChar None NB, M 

KinStreet1 Next of kin's 
street address line 
1. 

128 VarChar None NB, M 

KinStreet2 Next of kin's 
street address line 
2. 

128 VarChar None NB, M 

KinZIPCode Next of kin's ZIP 
Code. 

15 VarChar None NB, M 

MaritalStatus Patient's marital 
status. 

1 Char None NB, M 

Name Patient's name. 75 VarChar None NB, M 

PatientRecNumber Code that medical 
facility assigned to 

30 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

identify the 
patient record. 

Phone Patient's phone 
number. 

20 VarChar None NB, M 

ServiceDate Date the patient 
received medical 
service. 

8 DateTime None NB, M 

Sex Patient's gender. 1 Char None NB, M 

SSN Patient's social 
security number. 

15 VarChar None NB, M 

State Patient's state of 
residence. 

5 VarChar None NB, M 

Street1 Patient's street 
address line 1. 

128 VarChar None NB, M 

Street2 Patient's street 
address line 2. 

128 VarChar None NB, M 

WorkPhone Patient's work 
phone number. 

20 VarChar None NB, M 

ZIPCode Patient's ZIP 
Code. 

15 VarChar None NB, M 

PatientRelationToGuarantor Patient's 
relationship to 
the person 
guaranteeing 
payment for 
medical care. 

25 VarChar None NB, M 

PatientRelationToGuarantorAdditionalInfo More 
information 
regarding the 
patient's 

50 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

relationship to 
the guarantor. 

AccidentDate Date the patient 
had an accident 
that required 
medical 
attention. 

8 DateTime None NB, M 

AccidentType Type of accident 
that the patient 
had. 

25 VarChar None NB, M 

FinancialClass Code that 
identifies the 
patient's 
primary 
insurance to bill 
first for services. 

25 VarChar None NB, M 

ImportProcedures Code that 
identifies a 
specific surgical, 
medical, or 
diagnostic 
intervention. 

25 VarChar None NB, M 

LocationCode Code that 
identifies the 
location where 
the patient 
received medical 
care. 

25 VarChar None NB, M 

Modifier Code that 
identifies a 
medical service 
or procedure. 

25 VarChar None NB, M 

PatientType Code assigned 
during the 

25 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

registration or 
admission 
process to 
identify the type 
of patient (for 
example, 
emergency or 
day surgery). 

PlaceOfServiceCode Code that 
identifies the 
place that 
rendered service 
to the patient. 

25 VarChar None NB, M 

ProcedureCode Code that 
identifies the 
medical 
procedure that 
the patient 
received. 

25 VarChar None NB, M 

ServicingProviderCode Code that 
identifies the 
health care 
provider. 

25 VarChar None NB, M 

DiagnosisCode1 Code that 
identifies the 
patient's 
medical 
diagnosis. 

25 VarChar None NB, M 

DiagnosisCode2 Code that 
identifies the 
patient's 
medical 
diagnosis. 

25 VarChar None NB, M 

DiagnosisCode3 Code that 
identifies the 

25 VarChar None NB, M 
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Field Name Description Length Data Type Parent Table and 
Field 

Import 
Types 

patient's 
medical 
diagnosis. 

DoctorCode Code that the 
medical facility 
assigned to 
identify the 
admitting 
doctor. 

5 VarChar None NB, M 

AttendingDoctorName Name of the 
doctor who is 
rendering 
service to the 
patient. 

75 VarChar None NB, M 

AttendingDoctorPhone Attending 
doctor's phone 
number. 

20 VarChar None NB, M 

AttendingDoctorFax Attending 
doctor's fax 
number. 

20 VarChar None NB, M 

AttendingDoctorCode Code that the 
medical facility 
assigned to 
identify the 
attending 
doctor. 

5 VarChar None NB, M 

Payment Table 

The Payment table contains payments for accounts. Each account can have multiple payment records. 
This table corresponds to the Payhistory table in the Latitude database. 

Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

Number Code that Latitude assigned 
to identify the account. For 

4 Integer Master/Number NB, F, 
M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

new business imports, don't 
map this field. For financial 
and maintenance imports, 
you must map this field to 
ensure that Exchange 
Manager locates the correct 
account. 

Amount Payment amount. 

Maps to TotalPaid field. 

8 Money None NB, F, 
M 

AdjustmentAmount1 Amount paid against the 
principle balance. 

Maps to Paid1 field. 

8 Money None NB, F, 
M 

AdjustmentAmount2 Amount paid against the 
interest balance. 

Maps to Paid2 field. 

8 Money None NB, F, 
M 

AdjustmentAmount3 Amount paid against money 
bucket 3. 

Maps to Paid3 field. 

8 Money None NB, F, 
M 

AdjustmentAmount4 Amount paid against money 
bucket 4. 

Maps to Paid4 field. 

8 Money None NB, F, 
M 

AdjustmentAmount5 Amount paid against money 
bucket 5. 

Maps to Paid5 field. 

8 Money None NB, F, 
M 

AdjustmentAmount6 Amount paid against money 
bucket 6. 

Maps to Paid6 field. 

8 Money None NB, F, 
M 

AdjustmentAmount7 Amount paid against money 
bucket 7. 

Maps to Paid7 field. 

8 Money None NB, F, 
M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

AdjustmentAmount8 Amount paid against money 
bucket 8. 

Maps to Paid8 field. 

8 Money None NB, F, 
M 

AdjustmentAmount9 Amount paid against money 
bucket 9. 

Maps to Paid9 field. 

8 Money None NB, F, 
M 

AdjustmentAmount10 Amount paid against money 
bucket 10. 

Maps to Paid10 field. 

8 Money None NB, F, 
M 

PaymentDate Payment date. 

Maps to DatePaid field. 

8 DateTime None NB, F, 
M 

PaymentType Type of payment batch 
(BatchType field in the 
Latitude table). 

3 VarChar None NB, F, 
M 

AdjustmentBucket Bucket number to which to 
apply the payment. 

    None NB, F, 
M 

PaymentID Code that identifies a 
payment transaction that an 
AIM agency or attorney 
returned (PAIdentifier field 
in the Latitude table). 

30 VarChar None NB, F, 
M 

Comments Comments regarding the 
payment. 

30 Char None NB, F, 
M 

PayMethod Payment method (for 
example, check, money 
order). 

30 VarChar None NB, F, 
M 

CheckNumber Check number associated to 
the payment. 

30 VarChar None NB, F, 
M 

Desk Desk that receives credit for 
the payment. You must have 

10 VarChar None NB, F, 
M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

already created this code in 
Latitude. 

SubBatchType (Optional) Secondary code 
that identifies a batch. 

3 Char None NB, F, 
M 

IsSettlement Flag that indicates whether 
the payment settles the 
account. 

1 = Yes, sets account to SIF 
after processing 
0 = No, doesn't set account 
to SIF 

1 Bit None NB, F, 
M 

IsCorrection Flag for PUR and PCR 
payment types that 
indicates whether the 
payment reversal is a 
correction. 

1 = Yes, doesn't set NSF flag 
on account 
0 = No, sets NSF flag on 
account 

1 Bit None NB, F, 
M 

IsFreeDemand Flag that indicates whether 
to apply the fee schedule to 
the payment (within the 
customer's free demand 
period). 

1 = Yes 
0 = No 

1 Bit None NB, F, 
M 

PostDateUID Not used. 4 Integer None NB, F, 
M 

FeeCode Code that identifies the fee 
to apply to the payment 
(FeeSched field in the 
Latitude table). You must 
have already created this 
code in Latitude. 

30 VarChar None NB, F, 
M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

IsEchoBack Flag that indicates whether 
the payment is valid. 

1 = Yes, payment exists and 
debtor is just verifying 

0 = No, payment wasn't 
entered 

Maps to Echo field. 

1 Bit None NB, F, 
M 

AIMAgencyID Latitude code that identifies 
the outside collection 
agency or attorney where 
the customer placed the 
account. 

4 Integer None NB, F, 
M 

AIMDueAgency Amount owed to the outside 
collection agency or 
attorney. 

8 Money None NB, F, 
M 

AIMAgencyFee Outside collection agency's 
or attorney's fee amount. 

8 Money None NB, F, 
M 

AIMBatchID Code that identifies the AIM 
payment batch. 

4 Integer None NB, F, 
M 

AIMSendingID Code that identifies the 
outside collection agency or 
attorney sending the 
payment. 

4 Integer None NB 

LatitudeReceivedAIMGracePeriod Not used.     None F, M 

AIMPlacedGracePeriod Not used.     None F, M 

OverrideAIMProperties Not used.     None F, M 

SetAIMProperties Not used.     None NB, F, 
M 

 
PDC Table 
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The Post-dated Check (PDC) table contains post-dated check payments for accounts. Each account can 
have multiple post-dated check payment records. 

Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

Number Code that Latitude assigned to identify the 
account. 

4 Integer Master/Number NB, M 

Active Flag that indicates whether PDC is active. 

1 = Active 
0 = Inactive 

1 Bit   NB, M 

Amount Payment amount. 8 Money   NB, M 

ApprovedBy User who approved the transaction. 20 VarChar   NB, M 

CheckNbr Check number for the transaction. 10 Char   NB, M 

CollectorFee Fee amount credited to the collector desk 
for the transaction. 

8 Money   NB, M 

CTL Not used. 3 Char   NB, M 

DepositDate Deposit scheduled date. 8 DateTime   NB, M 

Desk Code that identifies the desk receiving credit 
for the transaction. 

10 VarChar   NB, M 

Entered Transaction date. 8 DateTime   NB, M 

Fill1 Not used. 255 Char   NB, M 

Fill2 Not used. 255 Char   NB, M 

Fill3 Not used. 255 Char   NB, M 

Fill4 Not used. 255 Char   NB, M 

Fill5 Not used. 255 Char   NB, M 

PDC_Type Type of transaction. 1 TinyInt   NB, M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

6 = Paper Draft 
7 = ACH Debit 
8 = Post Dated Check 

OnHoldDate If placed on hold, date placed on hold. 8 DateTime   NB, M 

ProcessedDate If processed, date processed. 8 DateTime   NB, M 

ProcessedFlag Flag that indicates whether Latitude 
processed the transaction. 

1 Char   NB, M 

Seq Corresponds to Debtors.Seq to identify the 
customer making the post-dated 
payments. If the value is NULL, Exchange 
assumes that the primary customer for the 
account is paying. 

4 Integer Debtors/Seq NB, M 

LetterCode Code that identifies the letter requested 
with the transaction. 

5 VarChar   NB, M 

NITDSendDate Date to send a notice of intent to deposit 
letter. 

8 DateTime   NB, M 

Surcharge Surcharge amount for the transaction. 8 Money   NB, M 

Printed Flag that indicates whether Latitude printed 
the transaction (or wrote it to a file). 

1 Bit   NB, M 

PrintedDate Transaction printed date. 8 DateTime   NB, M 

PromiseMode Payment arrangement type. 

1 = Single payment 
2 = Monthly payments 
3 = Bi-weekly payments 
4 = Twice per month payments 
5 = Weekly Payments 
6 = Settlement 
7 = Multi-part Settlement 
8 = Promise payoff 
9 = Every 28 days 
10 = Monthly on last day 

1 TinyInt   NB, M 
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Field Name Description Length Data 
Type 

Parent Table 
and Field 

Import 
Types 

ProjectedFee Amount to collect from the client for the 
transaction (included on the invoice). 

8 Money   NB, M 

UseProjectedFee Not used. 1 Bit   NB, M 

NSFCount You can increment this field manually in the 
PDT tool for users that send out an ACH file 
without creating a batch. Then you can track 
the number of NSF remits the vendor or 
bank submits when the transaction is not 
good. Typically a transaction is on 
resubmitted after bouncing three times.  

4 Integer   NB, M 

ProcessStatus Process status set during stages of PDT 
transactions, such as Active, Sent, Processed, 
Closed, or Returned. 

25 VarChar   NB, M 

Phones Table 

The Phones table contains phone information for accounts. Each account can have multiple phone 
records. To ensure that Exchange locates the correct customer on the account, you must map the 
customer field that you specified as unique criteria in the Unique Debtor Criteria section of the General 
tab. For more information, see Specify Unique Debtor Criteria.  

Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Number Code that Latitude assigned to identify 
the account. For new business imports, 
don't map this field. For maintenance 
imports, you must map this field to 
ensure that Exchange Manager locates 
the correct account. 

4 Integer Master/Number NB, M 

DebtorID Code that Latitude assigned to identify 
the debtor associated to the phone 
number. If you selected "Debtor ID" as 
the unique debtor criteria, you must 
map this field. 

4 Integer Debtors/DebtorID NB, M 

SH_RequestID Code that Latitude assigned to identify 
a vendor service request for the 
account. 

4 Integer ServiceHistory/RequestID NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Relationship Relationship to the account. If you 
selected "Relationship" as the unique 
debtor criteria, you must map this 
field. 

50 VarChar Debtors/Relationship NB, M 

Name Debtor name. If you selected "Name" 
as the unique debtor criteria, you must 
map this field. 

300 VarChar Debtors/Name NB, M 

Seq Code that indicates whether the 
debtor is the primary or secondary 
debtor on the account. If you selected 
"Seq" as the unique debtor criteria, 
you must map this field. 

0 = Primary debtor  
1 or greater = Secondary debtor  

4 Integer Debtors/SEQ NB, M 

SSN Debtor's social security number. If you 
selected "SSN" as the unique debtor 
criteria, you must map this field. 

15 VarChar Debtors/SSN NB, M 

PhoneTypeID Code that identifies the type of phone 
number. 

4 Integer None NB, M 

PhoneStatusID Code that identifies the status of the 
phone number. 

4 Integer None NB, M 

OnHold Flag that indicates whether the phone 
number is on hold. 

1 = Yes 

0 = No 

1 Bit None NB, M 

PhoneNumber Debtor's phone number, including 
country code and extension. 

30 VarChar None NB, M 

PhoneExt Debtor's telephone extension number. 10 VarChar None NB, M 

PhoneName Name of the debtor associated to the 
phone number. 

50 VarChar None NB, M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Source Source who provided the phone 
number, such as debtor, customer, or 
credit bureau. 

255 VarChar None NB, M 

Phones Master Table 

The Phones Master table contains phone information for accounts. Each account can have multiple 
phone records. To ensure that Exchange locates the correct debtor on the account, you must map the 
debtor field that you specified as unique criteria in the Unique Debtor Criteria section of the General 
tab. For more information, see Specify Unique Debtor Criteria. 

Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

Number Code that Latitude assigned to 
identify the account. For 
maintenance imports, you must map 
this field to ensure that Exchange 
Manager locates the correct account. 

4 Integer Master/Number M 

PhoneType Code that identifies the type of 
phone number. 

4 Integer None M 

Relationship Relationship to the account. If you 
selected "Relationship" as the unique 
debtor criteria, you must map this 
field. 

50 VarChar Debtors/Relationship M 

PhoneStatus Code that identifies the status of the 
phone number. 

4 Integer None M 

OnHold Flag that indicates whether the 
phone number is on hold. 

1 = Yes 

0 = No 

1 Bit None M 

PhoneNumber Debtor's phone number, including 
country code and extension. 

30 VarChar None M 

PhoneExt Debtor's telephone extension 
number. 

10 VarChar None M 
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Field Name Description Length Data 
Type 

Parent Table and Field Import 
Types 

DebtorID Code that Latitude assigned to 
identify the debtor associated to the 
phone number. If you selected 
"Debtor ID" as the unique debtor 
criteria, you must map this field. 

4 Integer Debtors/DebtorID M 

DateAdded Date the user added the phone 
number to the account. 

8 DateTime None M 

RequestID Code that Latitude assigned to 
identify a vendor service request for 
the account. 

4 Integer ServiceHistory/RequestID M 

PhoneName Name of the debtor associated to the 
phone number. 

50 VarChar None M 

LoginName User ID of the person who added the 
phone number to the account. 

10 VarChar None M 

Service History Table 

The Service History table (that the Fusion program uses, typically) contains vendor service requests for 
accounts. Each account can have multiple service history records. The sent and received REQUESTID 
must match. 

Field 
Name 

Description Length Data 
Type 

Parent Table and 
Field 

Import 
Types 

ID Code that Latitude assigned to identify the account. 
For new business imports, don't map this field. For 
maintenance imports, you must map this field to 
ensure that Exchange Manager locates the correct 
account. 

4 Integer Master/Number NB, M 

RequestID Code that Latitude assigned to identify a request 
for information from a vendor. 

4 Integer None NB, M 

Filter Records 

Use the Define Context Rows dialog box to specify a SQL statement to limit which records to import. 
You can apply the SQL statement at the Master row level or in subsequent table rows. 



Exchange Manager Printable Help 

184 

Note: Custom row filters applied at the Master table level can reference any destination field. 
Custom row filters applied at any other table level (for example, Debtors, Misc Extra, Notes) must 
reference a column within that table. 

To filter records 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6. In the Destination pane, double-click the table name. The Define Context Rows dialog box 

appears. 

   

7. In the box, type one or more SQL statements. If a field name contains spaces, enclose it in 
brackets []. For more information about SQL statements, see SQL Statements. 

Note: Not all accounts have a co-debtor record. To prevent Exchange Manager from adding 
blank co-debtor records, type the following in the box: NAME <> ''. Note the use of single 
quotes, not double quotes. 

SQL Statements 

You can use SQL statements to limit which records to import. For information about filtering records, 
see Filter Records. 

Master table SQL statement examples 

The following are examples of SQL statements that you can apply to the Master table: 
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SQL Statement Verification 

Account is not null Exchange Manager only imports rows with data in the Account field. 

NewBusinessFlag = 
"Y" 

Exchange Manager only imports records where the NewBusinessFlag field 
contains a "Y’". 

Account <> "" Exchange Manager only imports rows with data in the Account field. 

[Account Name] <> 
"" Exchange Manager only imports rows with data in the Account Name field. 

Debtors table SQL statement examples 

The following are examples of SQL statements that you can apply to the Debtors table: 

SQL Statement Verification 

SSN <> "" Exchange Manager only adds rows where the SSN field contains a social 
security number. 

[Cosign Responsible] = 
"Y" 

Exchange Manager only adds rows where the Cosign Responsible field 
contains a "Y". 

Empty Rows 

Besides defining source row criteria, some destination tables require certain information or Exchange 
Manager removes the record from the results. 

Table Name Required Field if the... 

MiscExtra Title is an empty string. 

Notes Comment is an empty string. 

ExtraData Extracode is an empty string. 

Payment Paymenttype is an empty string or the amount equals 0 
(zero). 

CustomerNotes Notetext is an empty string. 

HotNotes Hotnote is an empty string. 

Bankruptcy Datefiled is an empty string. 
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Table Name Required Field if the... 

DebtorAssets Description is an empty string. 

LegalLedger Description is an empty string. 

CourtCases Datefiled is not a valid date. 

Exchange Manager processes this logic first, and then any custom row filter that you created. If the row 
passes both criteria, Exchange Manager determines whether all fields are not empty. This step is for 
generic tables mainly. Exchange Manager ignores identity, number, accountid, and debtorid fields 
because they don't require input values. 

Following are the values that cause an empty field, depending on the data type: 

DateTime: When year = 1. 

Decimal: When value = 0. 

Integer: When value = 0. 

String: When value = empty string. 

Boolean: When value = true (If it's the only field in the record that has a value and the value is 
true, it can cause issues when importing). 

Define Multiple Row Handling 

Use the Row Definition dialog box to define how to select a field when it exists in multiple rows. The 
Row Definition dialog box appears when you map a field in a flat file (fixed or delimited) where you set a 
subordinate record to MaxOccurs = *. In these cases, you specify which row to use, or identify which 
rows represent a valid occurrence of the record and create a new row in the table. 

Note: Only define automatic row creation criteria for one field within the record. The Row 
Definition dialog box only appears for the first field you map. 

To define multiple row handling 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. Click the Mapping tab. 
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6. In the Destination pane, expand a table (for example, Debtors) and then expand a record (for 

example, 0). 

7. In the Source pane, drag a source field to a destination field in the Destination pane. The 
following example creates a note record for rows in a flat file. This file can contain multiple rows 
for the Notes2 record for each account. The criterion creates a record for Notes2 rows that have 
data in the Description field. 
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After mapping a field that exists in multiple rows, the Row Definition dialog box appears. 

 
By Row Number: If selected, Exchange Manager selects the field based on the specified row 
number. 

By Column Value: If selected, Exchange Manager selects the field based on the specified field and 
its specified value. 

For Each Row: If selected, Exchange Manager creates rows dynamically based on the number of 
rows and the data in the row. The blank box represents a WHERE clause. You can use it to verify 
that data exists in the row before creating a record (<> ""). You can also specify a qualifier in the 
WHERE clause box. For example, "Seq < 5" tells Exchange Manager to add as records all rows 
containing a number less than 5 in the Seq field. 

8. Complete the information and then click OK. 

Update the Destination Schema 

Use the Open dialog box to update the destination schema to include new or modified destination 
fields. Do this update when you update your Latitude database to a newer version, after installing 
Exchange Manager, or after creating the import file mappings. 

To update the destination schema 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. In the menu bar, click Advanced > Load New Destination Schema. The Open dialog box appears. 

6. Open the folder that contains your Exchange Manager schemas (for example, "C:\Program Files 
(x86)\Latitude Software\Data\ExchangeDestinationSchema") and then click the destination 
schema file. 

7. Click Open. The destination schema appears on the Mapping tab. 
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Open a Mapping Definition 

Use the Open dialog box to open a mapping definition file so that you can view or modify the mapping 
of the import file to the Latitude database. 

To open a mapping definition 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 
the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. In the menu bar, click Advanced > Open Mapping Definition. The Open dialog box appears. 

6. Click the mapping definition file and then click Open. The mapping definition appears on the 
Mapping tab. 
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Add a Generic Table to the Destination Schema 

Use the Select Table dialog box to add a generic table to the destination schema. For more information, 
see Generic Tables. 

To add a generic table to the destination schema 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 
the specified client appears in the Information pane. 

 
3. Click the Import Files tab and then click the New Business, Financial Transactions, 

Maintenance, or Final Recall tab, depending on the import file type. 
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4. Click Modify File Mapping. The Data Translator window appears. 

 
5. In the menu bar, click Advanced > Add Generic Table to Dest Schema. The Select Table dialog 

box appears. 

 

6. In the Table list box, click the table to add and then click OK. Exchange adds the table to the 
Mapping tab. 
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Generic Tables 

A generic table is a table in the Latitude database that isn't already in the default mapping locations. For 
example, a custom table that your organization or Latitude by Genesys created that's not in the Latitude 
schema. 

Notes: 

• If Exchange Manager displays an "object reference not set to an instance of an object" message 
when you're adding a generic table, modify the table design and include a primary key. 

• Complete the table design before you add the table to Exchange Manager. Otherwise, you 
either have to remove the table from the mapping; add it back; and map it again, or you have to 
export the mapping translation XML and edit it manually. 

• Exchange Manager populates columns in the table labeled "Number," "Accountid," or 
"Debtorid" with the file number it finds after doing the account lookup; you don't have to map 
them. 

• Exchange Manager doesn't truncate fields in a generic table before inserting them when the 
data is too long. Instead, Exchange Manager displays a failed insert message and adds an 
exception to the trace log. To resolve the issue, increase the destination field size so that it's 
larger than the source, or run C# on the table so that Exchange Manager doesn't attempt to 
insert data that's too long. 
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File Import 

File Import 

Exchange Manager requires a client configuration before allowing you to import a file. Once you create 
the client configuration, you can import files received from that client as often as necessary. 

Split a File 

Use the File Splitter dialog box to split a file into multiple files. You can split an import file before 
importing it and split an export file after exporting it. 

To split a file 

1. From the menu bar, click Tools > Split File. The File Splitter dialog box appears. 

 
2. Click the ellipsis next to File to Split. 

3. In the Open dialog box, click the file to split and then click Open. The path and file name appear 
in the File to Split box. 

4. In the Num lines per file box, type or click the number of records to include in each file. For 
example, if you have a file with 100 records and set this number to 25, the system splits the file 
into 4 separate files with 25 records each. 

5. In the Regular Expression Pattern box, type the character for the regular expression to match to 
identify a new record. 

6. Click Split. 

Import a New Business File 

Use the Import New Business dialog box to import new business. Set up the client, desk, and initial 
letter in Latitude before importing new business. You must configure Exchange Manager for importing 
files. For more information, see Import Files. 

To import a new business file 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. From the menu bar, click File > Import > New Business. The Import New Business dialog box 

appears. The options available for selection depend on how your organization configured the 
new business import file. For more information, see Configure a New Business Import File. 



Exchange Manager Printable Help 

205 

 
4. If applicable (depending on the import file configuration), specify the client and desk to import, 

and the initial letter. 

5. In the Received Date box, click the date you received the import file. 

6. Click the ellipsis (...) next to the Choose Import File box. 

7. In the Open dialog box, click the file to import and then click Open. Data in the import file 
appears in the data grid in the lower section of the Import New Business dialog box. 
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Number of Records: Number of records in the import file. 

Sum of Principal: Total amount of principal for all records in the import file. 

Sum of Balances: Total account balance for all records in the import file. 

8. To expand a row and view its details, click the plus sign (+). 

9. To export the information to an Excel file so that you can review the data before importing, click 
Export to Excel. 

10. When you are ready to import the file, click Import. The Import New Business dialog box closes 
and the import progress appears in the lower section of the New Business tab. 

Import a Financial Transaction File 

Use the Import Financial Transactions dialog box to import financial transactions. You must configure 
Exchange Manager for importing files. For more information, see Import Files. 

Note: After importing financial transactions, process the transactions in Latitude to apply the 
payments to the accounts. 
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To import a financial transaction file 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. From the menu bar, click File > Import > Financial Transactions. The Import Financial 

Transactions dialog box appears. The options available for selection depend on how your 
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organization configured the financial transactions import file. For more information, see 
Configure a Financial Transactions Import File. 

 
4. If applicable (depending on the import file configuration), specify the client to import. 

5. Click the ellipsis (...) next to the Choose Import File box. 

6. In the Open dialog box, click the file to import and then click Open. Data in the import file 
appears in the data grid in the lower section of the Import Financial Transactions dialog box. 

 
Number of Records: Number of records in the import file. 

7. To expand a row and view its details, click the plus sign (+). 
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8. To export the information to an Excel file to review the data before importing, click Export to 
Excel. 

9. When you are ready to import the file, click Import. The Import Financial Transactions dialog 
box closes and the import progress appears in the lower section of the Financial Transactions 
tab. 

Import a Maintenance File 

Use the Import Maintenance dialog box to import updated account information. Ensure that you 
specified the unique debtor criteria on the General tab and mapped it from the source file to the 
destination file. For more information, see Specify Unique Debtor Criteria. You must configure Exchange 
Manager for importing files. For more information, see Import Files. 

To import a maintenance file 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 



Exchange Manager Printable Help 

210 

 
3. From the menu bar, click File > Import > Maintenance. The Import Maintenance dialog box 

appears. The options available for selection depend on how your organization configured the 
maintenance import file. For more information, see Configure a Maintenance Import File. 

 
4. If applicable (depending on the import file configuration), specify the client to import. 

5. Click the ellipsis (...) next to the Choose Import File box. 

6. In the Open dialog box, click the file to import and then click Open. Data in the import file 
appears in the data grid in the lower section of the Import Maintenance dialog box. 
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Number of Records: Number of records in the import file. 

7. To expand a row and view its details, click the plus sign (+). 

8. To export the information to an Excel file to review the data before importing, click Export to 
Excel. 

9. When you are ready to import the file, click Import. The Import Maintenance dialog box closes 
and the import progress appears in the lower section of the Maintenance tab. 

Import a Final Recall File 

Use the Import Final Recall dialog box to import final recall information. Ensure that you specified the 
unique debtor criteria on the General tab and mapped it from the source file to the destination file. For 
more information, see Specify Unique Debtor Criteria. You must configure Exchange Manager for 
importing files. For more information, see Import Files. 

To import a final recall file 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. From the menu bar, click File > Import > Final Recall. The Import Final Recall dialog box 

appears. The options available for selection depend on how your organization configured the 
final recall import file. For more information, see Configure a Final Recall Import File. 
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4. If applicable (depending on the import file configuration), specify the client, the desk to change 

the account to, and the account status. 

5. Click the ellipsis (...) next to the Choose Import File box. 

6. In the Open dialog box, click the file to import and then click Open. Data in the import file 
appears in the data grid in the lower section of the Import Final Recall dialog box. 

 
Number of Records: Number of records in the import file. 

7. To expand a row and view its details, click the plus sign (+). 
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8. To export the information to an Excel file to review the data before importing, click Export to 
Excel. 

9. When you are ready to import the file, click Import. The Import Final Recall dialog box closes 
and the import progress appears in the lower section of the Final Recall tab. 

Export Files 

Export Files 

Use the Export Files tab to create an export file definition that you can use as often as necessary to 
export data to a file. There are two methods for creating an export file definition: 

• Query Tool: Allows you to use a query to retrieve specific accounts to export. 

• Stored Procedure: Allows you to use a stored procedure to retrieve specific accounts to export. 

Query Tool 

Query Tool 

Use the Export Files tab to open the query tool to create an export file definition. Queries retrieve 
accounts that meet specific criteria. 

Create an Export File Layout Using the Query Tool 

Use the Export Files tab to create an export file layout using the query tool.   

To create an export file layout using the query tool 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Export Files tab. 
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4. In the toolbar, click the Add icon. The New Export Name dialog box appears. 

 
5. In the Name box, type a descriptive name. 

6. For the export type, click Query Tool Built and then click OK. The system adds the export as a 
tab on the Export Files tab. 

 

Name: Descriptive name of the export file. 

Output File: Name to assign to the export file. You can name the file using the following methods: 

• Use a literal name, such as "Payment File". 

• Include dynamic information, such as a date and time stamp. For example, 
"PAYMENTFILE_@Date(MMddyyyy_hhmmss).txt," names the export file as 
"PAYMENTFILE," followed by the current date and time in the format indicated. 

• Include an aggregate value from the resultant dataset. For example, 
"Payment_@Value(sum(Amount)|Batchtype = ‘PU - Paid Us’|rec)_PAYMENT.txt," 
names the export file as "PAYMENT_[sum of the payments in the “Amount” column, 
where the type of payment is "PU," which is in the “Batchtype” column]_PAYMENT.txt. 
This aggregate value function takes three parameters 
@Value(expression|filter|tableIndex) separated by the | (pipe) character. TableIndex is 
the name of the detail record from the export definition. 
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Description: Description of the export file. 

Excel: If selected, exports the data to a Microsoft Excel file. 

Fixed: If selected, exports the data to a fixed-length flat file. 

CSV: If selected, exports the data to a Comma-Separated Value file. 

Delimiter: Character to use to separate data (for example, a comma or dash). 

Qualifier: Character to use to differentiate the data from the delimiter (typically 
single or double quotes). For example, if the delimiter is a comma and your data 
contains a comma (such as "Smith, John"), the qualifier distinguishes between the 
comma in your data and the comma that delimits the data. 

Modify Record Layouts: Opens the Query Tool Built Export dialog box to allow you to 
specify the criteria for retrieving accounts to export. For more information, see Create a 
Query for an Export. 

File Sequence: Sequence number to assign to the end of the export file name to make the file 
name unique. 

Last Time Ran: Date and time the export last ran. 

Query Tool Export Type: Type of export. 

Standard: Exports data from the Latitude database and stores it in tables. 

Simple Reader: Exports data to a Reader. This option uses less memory. However, you 
cannot export to an Excel file, have detail groups, or relate detail records in a parent-child 
relationship. 

Define Post Processing CSharp Script: Opens the Configure Query Tool Post Export Script 
window to allow you to define a C Sharp script to process the data after exporting it. For more 
information, see Define a C Sharp Script. 

7. Complete the information and then, in the toolbar, click Save. The Update Comment dialog box 
appears. 

8. In the Update Comment box, type a comment regarding your changes and then click OK. 

Create a Query for an Export 

Use the Query Tool Built Export window to create a query for an export definition.    

To create a query for an export 

1. Do one of the following: 

• If the export file layout doesn't exist, do the steps to Create an Export File Layout Using 
the Query Tool. 

• If the export file layout exists, click the [Export Layout Name] tab on the Export Files tab 
(for example, End of Month Report). 
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2. Click Modify Record Layouts. The Query Tool Built Export window appears. 

 
Record Delimiter 

CRLF: If selected, separates records using a carriage return/line feed (Windows). 

LF: If selected, separates records using a line feed (Unix). 

CR: If selected, separates records using a carriage return (Macintosh). 

None: If selected, doesn't use a record delimiter. 

3. Click the delimiter to use to separate records. 

4. Click [Export Layout Name] (for example, Financial Export) and then click Select Conditions. The 
Select Conditions for Export window appears. 
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5. Specify the global conditions and then click OK. The condition appears in the data grid in the 

Query Tool Built Export dialog box. For more information about using queries, see Queries. 

 

Prompt: If selected, Exchange Manager prompts the user for input. 
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Condition: Condition that limits the records to export. To modify the condition, click the Edit icon 
next to the condition. 

Displayed Prompt: Prompt to display to the user to request input when exporting the data. If you 
selected the Prompt check box, type a message in this box. 

6. To add a global date condition that you can apply to date conditions you define in the detail 
records, click Add Global Date Condition. The system adds the condition to the data grid. To 
modify the condition, click the Edit icon next to the condition. 

7. To prompt the user for input for a condition, click the Prompt check box and in the Displayed 
Prompt box, type the message to display to the user. 

8. To delete a condition, click the row in the data grid and the press Delete. In the confirmation 
dialog box, click Yes. 

9. To export the query definition to an XML file, in the toolbar, click Export Definition. 

10. Do the steps to Add a Detail Record to a Query Export. 

11. When you finish building the query, in the toolbar, click Save and Exit. 

12. In the toolbar in the Clients pane, click Save. The Update Comment dialog box appears. 

13. In the Update Comment box, type a comment regarding your changes and then click OK. 

Query Export Detail Record 

Query Export Detail Record 

Use the Query Tool Built Export window to maintain detail records for an export layout definition that 
you created using the query tool. 

Add a Detail Record to a Query Export 

Use the Query Tool Built Export window to add a detail record to an export layout definition created 
using the query tool. 

To add a detail record to a query export 

1. Do one of the following: 

• If the export file doesn't exist, do the steps to Create an Export File Layout Using the 
Query Tool. 

• If the export file exists, click the [Export Layout Name] tab on the Export Files tab (for 
example, End of Month Report). 
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2. Click Modify Record Layouts. The Query Tool Built Export window appears. 

 
3. Right-click the name of the export file layout (for example, End of Month Report) and then click 

Add New Detail Record. The Add New Detail Record dialog box appears. 

 
4. In the Name box, type a name for the detail record and then click OK. 
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Name: Name of the detail record. 

Group By Record: If selected, Exchange Manager group records by the first field in the data grid. 
Exchange Manager adds the "GroupingConstruct" column to the data grid, which allows you to 
count records, calculate the minimum or maximum value, or sum records. 

Note: You cannot create a history record or run post-processing actions on a grouping record. 

Create History Record: If selected, creates a history record.  

Preserve Data Types for Excel Export: If selected, retains data types when exporting to Excel. 

5. Complete the information and then click Save and Exit. 

6. In the Clients pane toolbar, click Save. The Update Comment dialog box appears. 

7. In the Update Comment box, type a comment regarding your changes and then click OK. 

Specify Actions to Run After Exporting 

Use the Record Post Execute Actions Form dialog box to specify the actions to run after exporting a file. 

To specify actions to run after exporting 

1. Click the [Export Layout Name] tab on the Export Files tab (for example, End of Month Report). 
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2. Click Modify Record Layouts. The Query Tool Built Export window appears. 

 
3. Click the name of the detail record (for example, Detail Example). Information for the detail 

record appears. 
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4. Select the Create History Record check box and then, above the data grid, click Action. The 

Record Post Execute Actions Form dialog box appears. 

 
None: If selected, Exchange Manager doesn't change the account. 

Closed (Qlevel = 998): If selected, Exchange Manager changes closed accounts based on the check 
boxes you select. 

Return (Qlevel = 999): If selected, Exchange Manager changes returned accounts based on the 
check boxes you select. 

Other: If selected, Exchange Manager changes accounts that aren't closed or returned based on 
the check boxes you select. 

Change Status: If selected, Exchange Manager changes the account status to the one you specify in 
the corresponding box. 

Move to Desk: If selected, Exchange Manager changes the desk assignment to the one you specify 
in the corresponding box. 
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Execute Custom Stored Procedure: If selected, Exchange Manager runs the stored procedure that 
you specify in the corresponding box to update accounts. 

5. Complete the information and then click OK. 

6. In the Query Tool Built Export window, click Save and Exit. 

7. In the Clients pane toolbar, click Save. The Update Comment dialog box appears. 

8. In the Update Comment box, type a comment regarding your changes and then click OK. 

Specify Data to Include in Export 

Use the Generate Report Record window to specify the data to include in the export and the conditions 
that limit the records to include. 

To specify data to include in the export 

1. Click the [Export Layout Name] tab on the Export Files tab (for example, End of Month Report). 

 
2. Click Modify Record Layouts. The Query Tool Built Export window appears. 
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3. Click the name of the detail record (for example, Detail Example). Information for the detail 

record appears. 

 
4. Above the data grid, click Select Data Fields And Conditions. The Generate Report Record 

window appears. 
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Note: For information about using queries, see Queries. 

5. Specify the columns to include in the detail record and the conditions for selecting records to 
include and then click OK. The columns and conditions appear in the data grid in the Query Tool 
Built Export dialog box.  
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Name: Name of the query column. 

DataType: Type of data (for example, integer or string). 

SQLColumn: SQL table and field name. If you switch a value, the SQL code for switching values 
appears also. 

Ordinal: Position in the export file to place the field. 

Printed: If selected, Exchange Manager includes the field in the export file. 

Format: Format to which to export the data. 

UseQualifier: If selected, Exchange Manager places a qualifier around the field to signify the start 
and end of the field. Exchange Manager uses the character you specified on the [Export Name] 
tab. For more information, see Create an Export File Layout Using the Query Tool. 

GroupingConstruct: Value to calculate for the records in each group (for example, number of 
records in each group). This column appears when you select the Group By Record check box. 

Write to Xml Map: If selected, Exchange Manager writes the data to an XML file. 

6. To change the position in which a field appears in the export file, do the following:  

• To move a single field, click the row and then click the up or down arrow at the bottom 
of the window. 

• To move multiple sequential fields, click the first row; hold down the Shift key; click the 
last row; release the key; and then click the up or down arrow at the bottom of the 
window. 

• To move multiple non-sequential fields, click each row while holding down the Ctrl key; 
release the key; and then click the up or down arrow at the bottom of the window. 

• To move one or more fields up or down 10 positions, click the individual; sequential; or 
non-sequential rows to move, and then click the up 10 Rows or down 10 Rows down 
arrow at the bottom of the window. 

7. To switch a value in the source file to another value when exporting the data, do the following: 

a. Next to the value in the SQLColumn cell of the data grid, click the gray box. The Query Tool 
Column Defined Export Field Form dialog box appears. 
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b. Click Switch on Query Tool Defined Column and then click Add New Row. The data grid 

appears in edit mode. 

c. In the Source Value box, type the value as it exists in the Latitude table. 

d. In the Destination Value box, type the value to which to change the source value when 
exporting it and then click OK. Exchange Manager displays the SQL code in the SLQColumn cell of the 
datagrid. 

 
  

8. To include a field in the export file, select the Printed check box in the data grid. To exclude a 
field, clear the check box. 

9. To specify the format for a field (for example, currency format for an integer data type), in the 
Format list box in the data grid, click the format. 

Note: Exchange Manager doesn't validate the format so if you choose the wrong format for the 
data type, an error occurs when you attempt to export the file. 

10. To have Exchange Manager place a qualifier around a field, select the corresponding 
UseQualifier check box in the data grid. 

11. If you selected the Group By Record check box, in the GroupingConstruct list box in the data 
grid, do one of the following: 

• To count the number of records in each group, click Count. 

• To calculate the maximum value (for example, highest current balance) for the records 
in each group, click Max. 

• To calculate the minimum value (for example, lowest current balance) for the records in 
each group, click Min. 
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• To calculate the total (for example, total current balance) for the records in each group, 
click Sum. 

12. To include a field in an XML file, select the Write to Xml Map check box in the data grid. To 
exclude a field, clear the check box. 

13. To remove a field from the export, click the row in the data grid and the press the Delete key. In 
the confirmation dialog box, click Yes. 

14. Click Save and Exit. 

15. In the Clients pane toolbar, click Save. The Update Comment dialog box appears. 

16. In the Update Comment box, type a comment regarding your changes and then click OK. 

Create a User-defined Field 

Use the Query Tool Built Export window to define a field to include in the export file. 

To create a user-defined field 

1. Click the [Export Layout Name] tab on the Export Files tab (for example, End of Month Report). 

 
2. Click Modify Record Layouts. The Query Tool Built Export window appears. 
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3. Click the name of the detail record (for example, Detail Example). Information for the detail 

record appears. 

 
4. Above the data grid, click Add User Defined Field. Exchange Manager adds a row to the data 

grid. 
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5. In the Name box, type a descriptive name for the field. 

6. In the SQLColumn box, click the gray box. The Define User Created Field dialog box appears. 

 

Text: If selected, type the text to assign to the field. 

Function: If selected, click the function to use to populate the field (for example, Current 
Date or File Sequence). 

SQL: If selected, type the SQL statement to use to populate the field. 

7. Complete the information and then click OK. Exchange Manager updates the data grid and 
populates the DataType box accordingly. 

8. In the Query Tool Built Export window, click Save and Exit. 

9. In the Clients pane toolbar, click Save. The Update Comment dialog box appears. 

10. In the Update Comment box, type a comment regarding your changes and then click OK. 

Configure Date Conditions 

Use the Configure Conditions dialog box to specify how to apply date conditions. 

To configure date conditions 

1. Click the [Export Layout Name] tab on the Export Files tab (for example, End of Month Report). 



Exchange Manager Printable Help 

233 

 
2. Click Modify Record Layouts. The Query Tool Built Export window appears. 

 
3. Click the name of the detail record (for example, Detail Example). Information for the detail 

record appears. 
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4. Above the data grid, click Edit Conditions. The Configure Conditions dialog box appears. 

 
If defined Use Global Conditions: If selected and you defined global date conditions, Exchange 
Manager uses the global date conditions instead of the date conditions listed in the data grid. 

Do not apply Global Dates to Date Conditions: If selected, Exchange Manager uses the date 
conditions listed in the data grid instead of the global date conditions you defined. 

If defined Use Global Date Time Condition For Date Time Conditions: If selected and you defined 
global date conditions, Exchange Manager uses the global date conditions instead of the date 
conditions listed in the data grid. 

Use last Time Export Run for Date Time Conditions: If selected, Exchange Manager uses the date 
and time a user last ran the export instead of the date conditions listed in the data grid or the 
global date conditions you defined. 

Prompt: If selected, Exchange Manager prompts the user for input for the condition. 
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Condition: Condition that limits the records to export. To modify the condition, click the Edit icon 
next to the condition. 

Displayed Prompt: Prompt to display to the user to request input when exporting the data. If you 
selected the Prompt check box, type a message in this box. 

Note: For date conditions, if you chose to use a global condition, the system ignores the 
prompts and conditions listed in the data grid. 

5. Complete the information and then click OK. 

6. In the Query Tool Built Export window, click Save and Exit. 

7. In the Clients pane toolbar, click Save. The Update Comment dialog box appears. 

8. In the Update Comment box, type a comment regarding your changes and then click OK. 

Modify SQL Query 

Use the Configure Conditions dialog box to view or modify the query as a SQL statement. 

To modify a SQL Query 

1. Click the [Export Layout Name] tab on the Export Files tab (for example, End of Month Report). 

 

2. Click Modify Record Layouts. The Query Tool Built Export window appears. 
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3. Click the name of the detail record (for example, Detail Example). Information for the detail 

record appears. 

 
4. Above the data grid, click Show Sql Query. The SQL Query Form dialog box appears. 
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5. To add a table or derived table to use as select columns, in the Additional JOINS box, type the 

JOIN clause. To view an example, double-click in the box. 

6. To add a search condition, in the Additional WHERE clause box, type the WHERE clause. To view 
an example, double-click in the box. 

7. To specify a sort order, in the ORDER BY clause box, type the ORDER BY clause. For example, 
"ORDER BY AccountID." 

8. To verify that the SQL statement is valid after adding or modifying a clause, click Validate Query. 
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9. To rebuild the query after adding or modifying a clause, click Rebuild. Exchange Manager 
updates the SQL Query box to reflect your changes. 

10. Click OK. 

11. In the Query Tool Built Export window, click Save and Exit. 

12. In the Clients pane toolbar, click Save. The Update Comment dialog box appears. 

13. In the Update Comment box, type a comment regarding your changes and then click OK. 

Export Query Definition to a File 

Use the Query Tool Built Export window to export a query definition to an XML file. 

To export a query definition to a file 

1. Click the [Export Layout Name] tab on the Export Files tab (for example, End of Month Report). 

 
2. Click Modify Record Layouts. The Query Tool Built Export window appears. 
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3. In the toolbar, click Export Definition. The Save As dialog box appears. 

4. In the File name list box, click or type the name to assign to the file and then click Save. 

5. In the Query Tool Built Export window, click Save and Exit. 

Define a C Sharp Script 

Use the Configure Query Tool Post Export Script window to define a C Sharp script to process a file after 
exporting data. For example, you can define a script to translate the file into another format or split the 
file into multiple files. 

To define a C Sharp script 

1. Do one of the following: 

• If the export file doesn't exist, do the steps to Create an Export File Layout Using the 
Query Tool. 

• If the export file exists, click the [Export Layout Name] tab on the Export Files tab (for 
example, End of Month Report). 
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2. Click Define Post Processing C Sharp Script. The Configure Query Tool Post Export Script 

window appears. 
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3. Follow the instructions in the window to create the script. 

4. Click Compile and then click OK. 

Tip: To remove the script, click Remove code pre-processing and close and then, in the 
confirmation dialog box, click Yes. 

5. In the toolbar, click Save. The Update Comment dialog box appears. 

6. In the Update Comment box, type a comment regarding your changes and then click OK. 

Export Data Using a Query Tool Layout 

Use the Export Form dialog box to export data to a file based on a query tool layout. For more 
information, see Create an Export File Layout Using the Query Tool. 

To export data using a query tool layout 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. From the menu bar, click File > Export and then click the name of the export layout to use. The 

Export Form dialog box appears. 
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4. Do one of the following: 

• To export data to an Excel file, at the top of the dialog box, click Export to Excel. 

• To export data to a fixed or CSV file format (as defined for the layout), at the bottom of 
the dialog box, click Export. 

The Save As dialog box appears. 

5. In the File name list box, click or type the name to assign to the file and then click Save. 

6. If the Preserve Data Types dialog box appears, click Yes. 

7. Click OK. 

Stored Procedure 

Stored Procedure 

Use the Export Files tab to use a stored procedure that your organization or Latitude by Genesys created 
to define an export file. 

Create an Export File Layout Using a Stored Procedure 

Use the Export Files tab to create an export file layout using a stored procedure that exists in your 
Latitude database.   

To create an export file layout using a stored procedure 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Export Files tab. 
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4. In the toolbar, click the Add icon. The New Export Name dialog box appears. 

 
5. In the Name box, type a descriptive name for the export. 

6. For the export type, click Standard and then click OK. The system adds the export as a tab on 
the Export Files tab. 
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Name: Name of the export. 

Output File: Name to assign to the export file. You can name the file using the following methods: 

• Use a literal name, such as "PaymentFile". 

• Include dynamic information, such as a date and time stamp. For example, 
"PAYMENTFILE_@Date(MMddyyyy_hhmmss).txt," names the export file as 
"PAYMENTFILE," followed by the current date and time in the format indicated. 

• Include an aggregate value from the resultant dataset. For example, 
"Payment_@Value(sum(Amount)|Batchtype = ‘PU’|0)_PAYMENT.txt," names the 
export file as "PAYMENT_[sum of the payments in the “Amount” column, where the 
type of payment is "PU," which is in the “Batchtype” column]_PAYMENT.txt. This 
aggregate value function takes three parameters @Value(expression|filter|tableIndex) 
separated by the | (pipe) character. TableIndex is the name of the export you defined. 

Description: Description of the export file. 

Parameters: Parameters to use to pass values to the stored procedure. If you export data using 
Exchange Manager, Exchange Manager requests the values from the user. If you export data 
using Job Manager and you predefine the parameters, Exchange Manager uses the predefined 
values. 

Stored Procedure: Name of the stored procedure to use to retrieve the data to export. 

Note: If you use a stored procedure for post export processing (Stored Procedure Post Export), 
include the parameters that the post export stored procedure uses in this stored procedure.     

Excel: If selected, exports the data to a Microsoft Excel file. 
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Fixed: If selected, exports the data to a fixed-length flat file. 

CSV: If selected, exports the data to a Comma-Separated Value file. 

Transformation Details: Allows you to specify the XSLT translation to transform XML into 
other formats such as HTML, plain text, and XLSX. 

Stored Procedure Post Export: Stored procedure to use for post-export processing (for example, 
flagging payments or changing account statuses). 

Note: Ensure that this stored procedure uses the same account selection criteria as the stored 
procedure for exporting the data. 

Pre-define Parameters: Opens a dialog box to allow you to specify the values to use when 
exporting data using Job Manager instead of requesting the values from the user. 

7. Complete the information. 

8. To add a parameter to request data from a user and pass it to the stored procedure, do the 
following: 

a. In the data grid, click in the Name box in the first blank row and type the parameter name that 
the stored procedure uses. 

b. In the Type box, click a data type and then, in the Name box, click the Edit icon. 

• If you selected "string," see Specify a String Parameter. 

• If you selected "Date/Time," see Specify a Date and Time Parameter. 

• If you selected "int," see Specify an Integer Parameter. 

• If you selected "QueryBuilder," see Specify a Query Parameter. 

c. In the Prompt box, type a prompt to display to request input from the user when 
running the export. 

9. To transform XML into another format, do the following: 

• Click Transformation Details and then do one of the following: 

 To open the file that contains the translation code, click From File..., click the 
name of the file, and then click Open. 

 To type the translation code, click New... 

The Edit File window appears. 

b. Modify the code as necessary and then click OK. 

10. To specify the values to use when exporting data using Job Manager, do the following: 

a. In the data grid, click the parameter row to predefine. 
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b. Click Pre-define Parameters. The Parameters dialog box appears. 

 
c. Specify the values to use to retrieve the data to export and then click OK. 

d. Repeat these steps for each parameter in the data grid that you want to predefine. 

11. In the toolbar, click Save. The Update Comment dialog box appears. 

12. In the Update Comment box, type a comment regarding your changes and then click OK. 

Specify a String Parameter 

Use the String Parameter dialog box to specify parameters for a string data type. 

To specify a string parameter 

1. Do one of the following: 
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• If the export file doesn't exist, do the steps to Create an Export File Layout Using a 
Stored Procedure. 

• If the export file exists, click the [Export Layout Name] tab on the Export Files tab (for 
example, Standard Export). 

 
2. In the Name box in the data grid, click the Edit icon for a string data type. The String Parameter 

dialog box appears. 
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Name: Descriptive name for the parameter. 

Prompt: Message to display to the user to request input. 

Sql: SQL statement to use to query data in the Latitude database.   

Select Mode: Indicates how users can select items from the query results. 

Multi-Select: User can select one or more items from the query results. 

Single-Select: User can select one item only from the query results. 

Free Text: User must type a value. 

Display: Field from the SQL statement to display to the user when exporting the data. 

Value: Field from the SQL statement from which to retrieve the value to pass to the stored 
procedure. 

3. Complete the information and then click OK. 

Specify a Date and Time Parameter 

Use the Date Time Parameter dialog box to specify parameters for a "date/time" data type. 

To specify a date and time parameter 

1. Do one of the following: 

• If the export file doesn't exist, do the steps to Create an Export File Layout Using a 
Stored Procedure. 

• If the export file exists, click the [Export Layout Name] tab on the Export Files tab (for 
example, Standard Export). 
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2. In the Name box in the data grid, click the Edit icon for a DateTime data type. The Date Time 

Parameter dialog box appears. 

 
Name: Descriptive name for the parameter. 

Prompt: Message to display to the user to request input. 

Format: Date and time format. For example, MMDDYYYY HH:MM:SS, where MM=month, 
DD=day, YYYY=year, HH=hour, MM=minute, and SS=second. 

3. Complete the information and then click OK. 

Specify an Integer Parameter 

Use the Integer Parameter dialog box to specify parameters for an integer data type. 
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To specify an integer parameter 

1. Do one of the following: 

• If the export file doesn't exist, do the steps to Create an Export File Layout Using a 
Stored Procedure. 

• If the export file exists, click the [Export Layout Name] tab on the Export Files tab (for 
example, Standard Export). 

 
2. In the Name box in the data grid, click the Edit icon for an integer (int) data type. The Int 

Parameter dialog box appears. 

 
Name: Descriptive name for the parameter. 

Prompt: Message to display to the user to request input. 
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Start: Starting value. 

Finish: Ending value. 

Increment: Number by which to increase the current value. 

3. Complete the information and then click OK. 

Specify a Query Parameter 

Use the Query Designer Report Form window to specify parameters for a query data type. 

To specify a query parameter 

1. Do one of the following: 

• If the export file doesn't exist, do the steps to Create an Export File Layout Using a 
Stored Procedure. 

• If the export file exists, click the [Export Layout Name] tab on the Export Files tab (for 
example, Standard Export). 

 
2. In the Name box in the data grid, click the Edit icon for a query builder data type. The Query 

Designer Report Form window appears. 
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3. In the Select Account Identifier list box, click the data element that identifies an account. 

4. Specify the conditions and then click OK. For more information about using queries, see Queries. 

Export Data Using a Stored Procedure Layout 

Use the Export Form dialog box to export data to a file based on a stored procedure layout. For more 
information, see Create an Export File Layout Using a Stored Procedure. 

To export data using a stored procedure layout 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. From the menu bar, click File > Export and then click the name of the export layout to use. If you 

set parameters for the export, the Parameters dialog box appears. 
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4. Specify the parameters and then click OK. The Export Form dialog box appears. 

 
5. To modify the parameters, do the following: 

• Click Modify Parameters. The Parameters dialog box appears. 

• Specify the parameters and then click OK. 

6. Do one of the following: 

• To export to an Excel file, at the top of the dialog box, click Export to Excel or at the 
bottom of the dialog box, click Export. 

• To export to an XML file, at the top of the dialog box, click Export to XML. 
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The Save As dialog box appears. 

7. In the File name list box, click or type the name to assign to the file and then click Save. 

Split a File 

Use the File Splitter dialog box to split a file into multiple files. You can split an import file before 
importing it and split an export file after exporting it. 

To split a file 

1. From the menu bar, click Tools > Split File. The File Splitter dialog box appears. 

 
2. Click the ellipsis next to File to Split. 

3. In the Open dialog box, click the file to split and then click Open. The path and file name appear 
in the File to Split box. 

4. In the Num lines per file box, type or click the number of records to include in each file. For 
example, if you have a file with 100 records and set this number to 25, the system splits the file 
into 4 separate files with 25 records each. 

5. In the Regular Expression Pattern box, type the character for the regular expression to match to 
identify a new record. 

6. Click Split. 

Queries 

Queries 

Use a query designer window to create or modify a query that retrieves accounts that meet specific 
criteria. The query windows include: 

• Select Accounts: Allows you to select specific accounts to exclude from an import. For more 
information, see Configure Global Custom Business Rules. 

• Query Designer Report Form: Allows you to retrieve specific accounts and export them, or 
automate export jobs to run in Job Manager. This window is the only query designer window 
that includes the account identifier. For more information, see Specify a Query Parameter. 

• Select Conditions for Export: Allows you to retrieve specific accounts to create an export file. 
For more information, see Create a Query for an Export. 

• Generate Report Record: Allows you to add a detail record to an export file definition and 
specify the conditions for retrieving accounts. This window is the only one that allows you to 
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specify which columns to include in the export file. For more information, see Add a Detail 
Record to a Query Export. 

The following example shows the layout of the Query Designer Report Form window. 

 

1. Toolbar: Displays the options for the query. 

2. Data Selection pane: Displays the data available to include in the query. 

3. Options: Displays options to apply to the query. 

4. Select Columns pane: Displays the columns to include in the export file. 

5. Conditions pane: Displays the conditions for retrieving accounts. 

6. Window Toolbar: Accepts your changes or closes the window without saving changes. 
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Query Columns 

Query Columns 

Use the Select Columns pane in the Generate Report Record window to specify the data columns to 
include in the export file. 

Note: Not all query windows have a Select Columns pane. 

Add a Query Column 

Use the Select Columns pane in the Generate Report Record window to add a column to include in the 
export file. 

To add a query column 

1. In the Generate Report Record window, in the Data Selection pane, click the plus sign (+) next 
to a folder to expand it. 

 
2. Click the data to include as a column in the export file and drag and drop it in the Select 

Columns pane. 

 
3. Drag and drop more data as necessary. 

Modify the Query Column Order 

Use the Select Columns pane in the Generate Report Record window to change the order in which 
columns of data appear in the export file. 

To modify the query column order 

1. In the Generate Report Record window, go to the Select Columns pane. 
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2. To move up a column in the list, click the column and then, in the toolbar, click the up arrow. 

3. To move down a column in the list, click the column and then, in the toolbar, click the down 
arrow. 

Modify a Query Column Name 

Use the Select Columns pane in the Generate Report Record window to modify the name of a column 
to include in the export file. 

To modify a query column name 

1. In the Generate Report Record window, go to the Select Columns pane. 

 

2. Do one of the following: 

• Click the column and then, in the toolbar, click the Rename icon. 

• Right-click the column and then click Rename. The query designer clears the column 
name and displays a blank box to allow you to modify the name. 

 
3. In the box, type the new name for the column and then press Enter. The original column name 

appears with the new name appended. For example, if you change the Customer column to 
Client, the query designer changes the column name to Customer as Client. 

Delete a Query Column 

Use the Select Columns pane in the Generate Report Record window to delete a column to exclude it 
from the export file. 

To delete a query column 

1. In the Generate Report Record window, go to the Select Columns pane. 
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2. Do one of the following: 

• Click the column and then, in the toolbar, click the Delete icon. 

• Click the column and then press the Delete key. 

• Right-click the column and then click Delete. A confirmation dialog box appears. 

3. Click Yes. 

Assign an Aggregate Function to a Query Column 

Use the Select Columns pane in the Generate Report Record window to assign an aggregate function to 
a column. The export file includes the aggregated values instead of the actual value. Non-aggregated 
columns create the groups that the aggregated data represents. For more information about aggregate 
functions, see Aggregate Functions. 

To assign an aggregate function to a query column 

1. In the Generate Report Record window, go to the Select Columns pane. 

 
2. Click the column and then, in the toolbar, click the arrow next to the Aggregate icon. A list of 

functions appears. 
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3. Click a function. The original column name appears with the aggregate function name 
appended. For example, if you selected the "average" function for the Linked Current Balance 
column, the Linked Current Balance column name changes to Average of Linked Current 
Balance. In the export file, the average account balance for all the linked accounts appears. 

4. To delete an aggregated function, click the column name and then click the Aggregate icon. 

Aggregate Functions 

The following table describes the functions that are available when aggregating data. The functions 
available for an item are based on the item's data type. 

Function Description 

Count Counts the number of records for the grouping. 

Sum Totals the values within the grouping. 

Average Averages the values within the grouping. 

Maximum Calculates the highest value within the grouping. 

Minimum Calculates the lowest value within the grouping. 

Standard Deviation Averages the difference from the mean value of the entire set of accounts 
included. 

Population Standard 
Deviation 

Averages the difference from the mean value within the grouping. 

Variance Squares the standard deviation. 

Population Variance Squares the standard deviation within the grouping. 

Eliminate Duplicates Changes the equation to add the "distinct" clause. You can use this 
function with any aggregate after the initial selection. 

Remove Aggregate Deletes the aggregate function and returns the column to its literal value. 

Query Column Icons 

The following table lists the query column icons and their description. 

Icon Description 

 

Deletes the selected column. 
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Icon Description 

 

Moves the selected column up one row in the Select Columns pane. 

 

Moves the selected column down one row in the Select Columns pane. 

 

Renames the selected column. 

 

Assigns an aggregate function to a column. 

Query Conditions 

Query Conditions 

Use the Conditions pane in a query tool window to specify the criteria for records to include in export 
file. For more information, see Queries. 

Add a Query Condition 

Use the Conditions pane to add a query condition. 

To add a query condition 

1. Open the query tool window. 
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2. To exclude duplicate records from the output, select Exclude Duplicate Records. 

3. To set a maximum number of records to include in the output, select Maximum Records and 
type the value. 

4. In the Data Selection pane, click the plus sign (+) next to a folder to expand it. 
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5. Click the data item for which to set a condition and drag and drop it in the Conditions pane. A 
dialog box appears. The title of the dialog box and the information displayed depend on the 
condition selected. 

The following example shows the Current Balance dialog box that appears when you drag and 
drop the Current Balance data item into the Conditions pane. 

 
6. In the dialog box, specify the criteria and then click Okay. The condition appears in the 

Conditions pane. 

In the following example, the condition indicates that you want to include in the export file 
accounts with a current balance that is greater than or equal to "$20,000." 

 

7. Continue specifying conditions as necessary. 

8. To view the number of records returned and accounts affected based on the specified criteria, 
click Count. This feature isn't available on some query tool windows. 

9. To preview the query results, click Run. The results appear on the Preview tab. This feature isn't 
available on some query tool windows. 

10. To save the query, click Save. In the Query Name box in the Save Query Dialog box, type a name 
for the query and then click Save. This feature isn't available on some query tool windows. 

11. In the query designer window, click OK. 

Modify a Query Condition 

Use the Conditions pane to modify a query condition. 

To modify a query condition 

1. With a query tool window open, in the Conditions pane, do one of the following: 

 
• Click a condition and then, in the toolbar, click the Edit icon. 

• Double-click a condition. 

• Right-click a condition and then click Edit. 
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A dialog box appears, which allows you to modify the criteria. The title of the dialog box and the 
information displayed depends on the condition selected. 

The following example shows the Current Balance dialog box that appears when you drag and 
drop the Current Balance data item into the Conditions pane. 

 
2. In the dialog box, modify the criteria and then click Okay. The Conditions pane reflects the 

update. 

Copy a Query Condition 

Use the Conditions pane to copy a query condition. 

To copy a query condition 

1. With a query tool window open, in the Conditions pane, do one of the following: 

  

• Click the condition and then, in the toolbar, click the Copy icon. 

• Right-click the condition and then click Copy. 

The query designer copies the condition to the Clipboard. 

2. In the Conditions pane, do one of the following: 

• Click where you want to copy the condition and then, in the toolbar, click the Paste icon. 

• Right-click where you want to copy the condition and then click Paste. 

The query tool pastes the condition in the specified location. 

Group Query Conditions 

Use the Conditions pane to separate conditions into groups when you require complex data mining. 

To group query conditions 

1. With a query tool window open, in the Conditions pane, click the conditions to group. 
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Tip: To select multiple sequential conditions, press and hold the Shift key and click the first and 
last sequential condition. To select multiple non-sequential conditions, press and hold the Ctrl 
key and click each individual condition. To select all conditions, right-click and then click Select 
All. 

2. Do one of the following: 

• In the toolbar, click the Group icon. 

• Right-click the selected conditions and then click Group. 

The query tool groups the selected conditions and flags the beginning and ending of the group. 

 
3. Continue grouping conditions as necessary. The following example shows a complex grouping of 

conditions. 

 

Modify the Query Condition Order 

Use the Conditions pane to modify the order in which to evaluate conditions. 

To modify the query condition order 

With a query tool window open, in the Conditions pane, click the condition and then, in the toolbar, 
click the up or down arrow. 
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Set a Query Condition to Optional or Required 

Use the Conditions pane to set a query condition to optional or required using Boolean operators (OR, 
AND). The query tool sets conditions to "required" by default. If a query has a single condition, the query 
requires that condition and you cannot set it to optional. If a query has more than one condition, you 
can set each condition that follows the first condition in the list to required or optional. 

To set a query condition to optional or required 

With a query tool window open, in the Conditions pane, do one of the following: 

• To change the query to require accounts to meet only one of the conditions for inclusion in the 
export file, right-click the second condition and then click Set Condition Optional. The condition 
changes from "and" to "or." 

In the following example, if an account contract date is "February 7, 2013" but the Desk is not 
"Collect 1 Desk," the query results include the account. If an account contract date is not 
"February 7, 2013" but the Desk is "Collect 1 Desk," the query results include the account. If an 
account contract date is "February 7, 2013" and the Desk is "Collect 1 Desk," the query results 
include the account. If an account contract date is not "February 7, 2013" or the Desk is not 
"Collect 1 Desk," the query results don't include the account. 

 
• To change the query to require accounts to meet all the conditions for inclusion in the export 

file, right-click the second condition and then click Set Condition Required. The condition 
changes from "or" to "and." 

In the following example, both conditions must be true for an account to appear in the query 
results. So, if an account contract date is "February 7, 2013" and the Desk is "Collect 1 Desk," the 
query results include the account. If an account contract date is "February 7, 2013" but the Desk 
is not "Collect 1 Desk," the query results don't include the account. If an account contract date is 
not "February 7, 2013" but the Desk is "Collect 1 Desk," the query results don't include the 
account. 

 

Delete a Query Condition 

Use the Conditions pane to delete a condition from a query. 

To delete a query condition 

1. With a query tool window open, in the Conditions pane, do one of the following: 
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• Click the condition and then, in the toolbar, click the Delete icon. 

• Click the condition and then press the Delete key. 

• Right-click the condition and then click Delete. 

A confirmation dialog box appears. 

2. Click Yes. 

Query Condition Types 

You use query conditions to specify the criteria to use to evaluate accounts. The criteria available is 
based on the condition type. 

Each condition is one of the following types: 

• Dates 

• Single option 

• Multiple option 

Dates 

Date conditions allow you to query accounts based on a specific date, date range, any date or blank 
date, or relative date. When you select a date condition, a dialog box displays to allow you to specify the 
date criteria. The criteria available depends on the value you select in the Value is list box, and whether 
you select the Relative check box. 

Specific date 

Use one of the following comparisons to evaluate accounts based on a specific date: 

Value is Description 

Equal To Retrieves accounts where the date matches a specific date. 

Not Equal To Retrieves accounts where the date does not match a specific date. 

Later Than or Equal To Retrieves accounts where the date matches or comes after a specific date. 

Earlier Than or Equal To Retrieves accounts where the date matches or comes before a specific date. 

Later Than Retrieves accounts where the date comes after a specific date. 

Earlier Than Retrieves accounts where the date comes before a specific date. 
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In the following example, the system retrieves accounts where the Closed Date is 01/01/2012. 

 
Date range 

Use one of the following comparisons to evaluate accounts based on a date range: 

Value is Description 

Between Retrieves accounts where the date falls between two specific dates. 

Not Between Retrieves accounts where the date comes before a specific start date or after a specific 
end date, but not between the two dates. 

In the following example, the system retrieves accounts where the Closed Date falls on or between 
01/01/2012 and 02/01/2012. 

 
Any date or blank date 

Use one of the following comparisons to evaluate accounts based on whether a date is blank or contains 
any value: 

Value is Description 

No Value Retrieves accounts where the date is blank. 

Any Value Retrieves accounts where the date is any date or blank. 

In the following example, the system retrieves accounts where the Closed Date is blank (doesn't contain 
a value). 
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Relative date 

Use the relative date option to evaluate accounts based on the relation of a date to the current date. 
You specify a comparison and the criteria to use to calculate the relative date. The criteria are the 
number of days, months, or years from the current date, and whether to add or subtract that number 
from the current date. 

Use one of the following comparisons to evaluate accounts based on the calculated relative date: 

Value is Description 

Equal To Retrieves accounts where the date matches the relative date. 

Not Equal To Retrieves accounts where the date does not match the relative date. 

Later Than or Equal To Retrieves accounts where the date matches or comes after the relative date. 

Earlier Than or Equal To Retrieves accounts where the date matches or comes before the relative date. 

Later Than Retrieves accounts where the date comes after the relative date. 

Earlier Than Retrieves accounts where the date comes before the relative date. 

In the following example, the system retrieves accounts where the Closed Date is two days before the 
current date. 

 
Single option 

Single option conditions allow you to retrieve accounts that match a single option in a group of options. 
In the following example, the system retrieves accounts that are the parent link to other accounts. 

 
Multiple option 
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Multiple option conditions allow you to retrieve accounts that match one or more options in a group of 
options. In the following example, the system retrieves accounts assigned to the POD desk and accounts 
assigned to the POOL desk. 

 

Query Condition Icons 

The following table lists the query condition icons and their description. 

Icon Description 

 

Opens a dialog box to allow you to edit the selected condition. 

 

Deletes the selected condition or group. 

 

Moves the selected condition up one row in the Conditions pane. 

 

Moves the selected condition down one row in the Conditions pane. 

 

Copies the selected condition from the Conditions pane to the Clipboard. 

 

Pastes a condition from the Clipboard into the Conditions pane. 

 

Groups the selected conditions. 

 

Sets the selected condition as optional using the OR Boolean. 

 

Sets the selected condition as required using the AND Boolean. The AND operator is set by 
default. 
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Query Results 

Query Results 

Use the Results tab in a query tool window to view the results of a query. 

Run a Query 

Use a query tool window to run a query. 

To run a query 

1. Open a query tool window. 

2. To count the number of records in the query results, do the following: 

a. In the toolbar, click Count. The Query Designer dialog box appears. 

 
b. Click OK. 

3. To run the query, in the toolbar, click Run. The results appear on the Results tab. The following 
example shows the Results tab in the Select Accounts window. 
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Arrange Query Column Headings 

Use the Results tab in a query tool window to change the order in which columns appear in the query 
results. 

To arrange query column headings 

1. With a query tool window open, in the toolbar, click Run. The results appear on the Results tab. 
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2. Click a column heading and drag it to the new location. 

3. When two red arrows appear in the location where you want to place the column, release your 
mouse. 

 

Pin a Query Column 

Use the Results tab in a query tool window to pin a column in the query results so that it remains 
stationary when you scroll horizontally. 

To pin a query column 

1. With a query tool window open, in the toolbar, click Run. The results appear on the Results tab. 



Exchange Manager Printable Help 

276 

 
2. In the column heading, click the pushpin  icon. The pushpin points down to indicate a pinned 

column. 

3. Scroll horizontally in either direction and the pinned column remains stationary. 

Sort Query Results 

Use the Results tab in a query tool window to sort the query results. 

To sort query results 

1. With a query tool window open, in the toolbar, click Run. The results appear on the Results tab. 
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2. Click a column heading. An arrow appears and points up to indicate that the column is sorted in 

ascending order. 

 
3. To sort the column in descending order, click the column heading again. The arrow points down 

to indicate that the column is sorted in descending order. 

Group Accounts in the Query Results 

Use the Results tab in a query tool window to group accounts in the query results. 

To group accounts in the query results 

1. With a query tool window open, in the toolbar, click Run. The results appear on the Results tab. 
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2. Click a column heading, drag it into the space above the column headings, and drop it. Accounts 

group on the specified column. The following example shows accounts grouped by customer. 
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3. To view the accounts in a group, click the plus sign (+) next to the group to expand it. 

4. To add a group within a group, do the following: 

a. Click the plus sign (+) next to the group to expand it. 

b. Click a column heading, drag it into the space above the column headings, and drop it. 
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5. To change the sort for a group, click the group heading. Groups sort in ascending order by 

default. 

6. To delete a group, click the group heading and drag and drop it back into the query results 
space. 

Summarize Query Data 

Use the Results tab in a query tool window to summarize query results. 

To summarize query results 

1. With a query tool window open, in the toolbar, click Run. The results appear on the Results 
tab.   
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2. In the column heading, click the Sigma icon. The Select Summaries dialog box appears. The 

options available are based on the item's data type. 

 
3. Select the calculations to perform on the data and then click OK. The result appears in the last 

row of the data grid. If you grouped data, the system calculates the data for each group and 
displays the results in the last row for each group. 
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Export Query Results 

Use the Results tab in a query tool window to export the results of a query. 

To export query results 

1. With a query tool window open, in the toolbar, click Run. The results appear on the Results tab. 

 
2. To export the results, click Export to Excel. The Select a Location for the Excel Spreadsheet 

dialog box appears. 

3. In the File name box, type a name for the export file and then click Save. 

Filter Query Results 

Use the Results tab in a query tool window to filter query results. 

To filter query results 
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1. With a query tool window open, in the toolbar, click Run. The results appear on the Results 
tab.   

 
2. In the column heading of the column to filter, click the Funnel icon. A list of options for the 

specified column appears. 

 
(All): If selected, the query tool doesn't filter the results. 

(Custom): If selected, opens the Enter Filter Criteria for... dialog box to allow you to set custom 
filtering conditions. For more information, see Set Custom Filter Criteria. 

(Blanks): If selected, the query results only include accounts with a blank or null value in the 
specified column. 
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(NonBlanks): If selected, the query results only include accounts that don't have a blank or null 
value in the specified column. 

3. Click any value other than (Custom). The list closes and the query results include the records 
that match the specified filter only. 

Set Custom Filter Criteria 

Use the Enter Filter Criteria for... dialog box to customize selection criteria for any column in the query 
results. You can combine criteria to create more complex filters. 

To set custom filter criteria 

1. With a query tool window open, in the toolbar, click Run. The results appear on the Results tab. 

 
2. In the column heading of the column to filter, click the Funnel icon. A list of options for the 

specified column appears. 
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3. Click (Custom). The Enter Filter Criteria for... dialog box appears. The following example shows 

the dialog box for the Desk column. 

 

4. In the Operand list box, click an operator. For more information, see Custom Filter Operators. 

5. In the Operand list box, click or type an operand. The condition appears at the bottom of the 
dialog box. 

 
6. To add conditions, click Add a condition. The system adds a blank row. 

7. To delete a condition, click the condition and then click Delete Condition. 
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8. If you set multiple conditions, do one of the following: 

• To set the filter so that all the conditions have to be true for an account to appear in the 
query results, click And conditions. For example, desk does not equal "000000" and 
desk does not equal "000002" means that you want to see accounts for all desks except 
"000000" and "000002".   

• To set the filter so that only one condition has to be true for an account to appear in the 
query results, click Or conditions. For example, desk equals "000000" or desk equals 
"000000" means that you only want to see accounts for desks "000000" or "000002". 

9. When finished creating the custom filter, click OK. 

Custom Filter Operators 

The following table describes the operators that are available when setting filter criteria. The operators 
available for a column are based on the column's data type. 

Operator Description 

Equals Displays records where the value in the column matches the value that you 
specify. 

Does not equal Displays records where the value in the column does not match the value that 
you specify. 

Less than Displays records where the value in the column is less than the value that you 
specify. 

Less than or equal to Displays records where the value in the column is less than or equal to the value 
that you specify. 

Greater than Displays records where the value in the column is greater than the value that you 
specify. 

Greater than or equal 
to 

Displays records where the value in the column is greater than the value that you 
specify. 

Like Displays records where the value in the column matches the pattern that you 
specify. 

Matches Regular 
Expression 

Displays records where the value in the column is in the format that you specify. 

  

^[A-Z] finds all values in uppercase character format only. 
^[a-z] finds all values in lowercase character format only. 

^[0-9] finds all values in numeric format only. 
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Operator Description 

^[A-Za-z] finds all values in mixed case character format. 

^[A-Za-z] finds all values in mixed case character format. 

^[^0-9]+$ finds all values with a numeric format and dollar sign. 

^[A-Za-z0-9] [A-Za-z0-9_]*$ finds all values of mixed case and currency. 

Starts with Displays records where the value in the column starts with the character or 
characters that you specify. 

Contains Displays records where the value in the column contains the character or 
characters that you specify. 

Ends with Displays records where the value in the column ends with the character or 
characters that you specify. 

Does not start with Displays records where the value in the column does not start with the 
character or characters that you specify. 

Does not contain Displays records where the value in the column does not contain the character or 
characters that you specify. 

Does not end with Displays records where the value in the column does not end with the 
character or characters that you specify. 

Does not match Displays records where the value in the column does not match the character or 
characters that you specify. 

Not like Displays records where the value in the column is not like the pattern that you 
specify. 

File History 

File History 

Use the file history feature to view a list of files that Exchange Manager imported and exported, and 
details for a specific transfer. 

View File Transfer History 

Use the History tab to view the history of file imports and exports processed using Exchange Manager. 

To view file transfer history 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the History tab. 
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Completed Date Time: Date and time the import or export file completed processing. 

File Type: Type of file imported or exported. 

Raw File: Name of the file containing the import or export data. 

View Batch History Details 

Use the Batch History Details window to view details for a file import or export, including any errors. 

To view batch history details 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the History tab. 

 

4. Select the starting and ending dates for transfer history to view, and then click Get History. A list 
of all transfers appears. 

5. Click the row to view and then click the icon at the end of the row. 

 
The Batch History Details window appears. 
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View Raw Source File: Opens the original file and displays its contents. If the original file is an 
Excel file, Exchange Manager opens it in Excel. 

Export Results to Excel: Creates an Excel spreadsheet containing the information displayed 
currently. 

Show only Financials: Displays payment and reversal transactions only. To clear this filter after 
setting it, close the window and reopen it. 

6. To view details, click the plus sign (+) next to an item. 

Maintain an Interface Note 

Use the Interface Notes tab to maintain an interface note. The Version History section of the tab 
displays change history for the client record. 

To maintain an interface note 

1. In the Navigation pane, click Clients. 
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2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 

 
3. Click the Interface Notes tab. 
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4. In the Interface Notes panel, type a note or copy and paste text from the Clipboard. 

5. In the toolbar, click Save. The Update comment dialog box appears. 

6. In the Update comment box, type a comment regarding the note and then click OK. 

Save a Previous Version of an Exchange Client 

Use the Interface Notes tab to save in XML format a previous version of an Exchange client. 

To save a previous version of an Exchange client 

1. In the Navigation pane, click Clients. 

 
2. In the Clients pane, expand the appropriate folder and then double-click the client. The tab for 

the specified client appears in the Information pane. 
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3. Click the Interface Notes tab. 

 

4. In the Client Definition column of the data grid, click the version to save. The Save As dialog box 
appears. 
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5. In the File name box, type a name for the file and then click Save. The file saves to the specified 
location and name. 

Process Configuration 

Process Configuration 

Process configuration allows you to create lists of clients to run against one or more files. You can 
automate the process using Job Manager or run it manually. Note the following: 

• You can automate individual client jobs for processing at regular intervals. 

• You can automate multiple client jobs to run against a single file or group of files (for example, 
your customer sends one file containing new business, maintenance, and financial updates). 

• You create Transfer and Protection configurations in Job Manager. 

Create a Process 

Use the Process Configuration tab to create a process for importing or exporting files. You can add 
multiple clients to the same process to run against the individual file selected, or group of files specified 
in the transfer configuration. You can automate the process using Job Manager. 

To create a process 

1. From the menu bar, click File > Process > Create New Process. The Process Configuration tab 
appears in the Information pane. 
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Name: Name that identifies the process. 

Description: Description of the process to use for reference when viewing or modifying the 
process. 

Owner Client Name: Client for whom to run the process. 

Transfer Configuration: Job Manager transfer configuration that specifies the group of files to run 
the process against.    

Protection Configuration: Job Manager protection configuration that specifies the encryption 
method to use during the transfer process.    

Process Type: Type of process, either import or export. 

Send Errored Files as Email Attachments on Imports: If selected, the system sends files with 
import errors as email attachments. 

2. Complete the information and then click Add Process. The Process Config dialog box appears. 

 
Client: Client to include in the process. 

Interface Name: Type of file to process, such as new business or maintenance. 

3. Complete the information and then click OK. 
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Tips: 

• To change the client processing order, click the row in the data grid and then click the 
up or down arrows. 

• To remove a client from the process, click the row in the data grid and then click 
Remove Process. 

4. Continue adding clients to the process as necessary. 

5. In the Exchange Manager window toolbar, click Save Process. 

Modify a Process 

Use the Process Configuration tab to modify a process for importing or exporting files. 

To modify a process 

1. From the menu bar, click File > Process > Configure Existing Process. The Choose Process dialog 
box appears. 
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2. Click the row in the data grid for the process to modify and then click OK. The Process 
Configuration tab appears in the Information pane. 

 
Name: Name that identifies the process. 

Description: Description of the process to use for reference when viewing or modifying the 
process. 

Owner Client Name: Client for whom to run the process. 
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Transfer Configuration: Job Manager transfer configuration that specifies the group of files to run 
the process against.    

Protection Configuration: Job Manager protection configuration that specifies the encryption 
method to use during the transfer process.    

Process Type: Type of process, either import or export. 

Send Errored Files as Email Attachments on Imports: If selected, the system sends files with 
import errors as email attachments. 

3. Complete the information. 

Tips: 

• To change the client processing order, click the row in the data grid and then click the 
up or down arrows. 

• To remove a client from the process, click the row in the data grid and then click 
Remove Process. 

4. To add a client to the process, do the following: 

a. Click Add Process. The Process Config dialog box appears. 

 
Client: Client to include in the process. 

Interface Name: Type of file to process, such as new business or maintenance. 

b. Complete the information and then click OK. 

5. Continue adding clients to the process as necessary. 

6. In the Exchange Manager window toolbar, click Save Process. 

Note: To delete the process, in the Exchange Manager window toolbar, click Delete Process. 

Run a Process Manually 

You can run a process manually, rather than run it automatically in Job Manager. You can only select one 
file when running a process manually. 

To run a process manually 

1. In the Navigation pane, click Clients. 

2. In the Clients pane, expand the appropriate folder and then double-click the client specified as 
the owner client in the process configuration. The tab for the specified client appears in the 
Information pane. 
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3. From the toolbar, click Import > Using Process and then click the process to run. The Open 

dialog box appears. 

4. Click the import file to run and then click Open. 

View Version History 
Use the Version History window to view a history of activities that occurred in Exchange Manager. 

To view version history 

1. From the menu bar, click Tools > Version History. The Version History window appears. 
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ID: Unique code the system assigns to identify the history record. 

Altered: Date the activity occurred. 

User ID: Unique code that identifies the user who performed the activity. 

User Name: Name of the user who performed the activity. 

Tree Path: Path in the Navigation pane associated to the activity. 

Comment: Description of the activity. 

2. When finished viewing the information, click OK. 

Data Grids 

Data Grids 

A data grid displays information in a table format (rows and columns). Each row represents a single 
record and each column represents a single data item. If a column in a data grid contains no data, either 
the user or the system didn't provide that data. If the number of records in a data grid exceeds the 
maximum allowed to display on a single page, a navigation bar appears at the bottom of the data grid. 

Some data grids allow you to: 

• Sort the data by a single column in ascending or descending order. For more information, see 
Sort Data in a Data Grid. 

• Limit the data that displays based on one or more criteria you specify. For more information, see 
Filter Data in a Data Grid. 

• Group the data by one or more column headings. For more information, see Group Data in a 
Data Grid. 

Sort Data in a Data Grid 

Some data grids allow you to sort the data by a single column in ascending or descending order. 
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To sort data in a data grid 

1. Click the arrow in a column heading to sort the data grid in ascending order by that column. An 
"up" arrow appears next to the column heading. The following example shows the data grid 
sorted by ID. 

 
2. Click the column heading again to sort the data grid in descending order by that column. A 

"down" arrow appears next to the column heading. 

Filter Data in a Data Grid 

Some data grids allow you to limit the data that displays based on one or more criteria. You can filter the 
data grid by one or more columns. 

To filter data in a data grid 

1. In the column heading to filter, click the Filter icon. 

 
A list of filter options appears. 
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(All): Clears the filter and displays all records. 

(Custom): Opens a dialog box to allow you to set custom filtering criteria. 

(Blanks): Displays all records where the field doesn't contain a value. 

(NonBlanks): Displays all records where the field contains a value. 

[Value]: Displays all records that match the specified value. 

2. Click a filter option. One of the following occurs: 

• If you selected an option other than "custom," Exchange displays only the records that 
match the criteria that you specified. 

• If you selected the "custom" option, the Enter Filter Criteria by [column name] dialog 
box appears. 

 
And conditions: If selected, both conditions must be true for the record to display in the 
data grid. This option is available when you have two or more conditions specified. 

Or conditions: If selected, only one condition must be true for the record to display in the 
data grid. This option is available when you have two or more conditions specified. 

Operand: Comparison operator to use to compare the data grid column value to the value 
that you specify. 

Operand: Value to which to compare the data grid column value. 

3. Specify a condition (click a comparison operator and a value to which to compare) and then click 
Add a condition. 

4. To narrow your results, repeat the previous step and specify more conditions. 

5. If you specified more than one condition, do one of the following: 

• To require all conditions to be true, click And conditions. 

• To require only one of the conditions to be true, click Or conditions. 

6. To delete a condition, click the condition and then click Delete Condition. 
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7. When finished setting the custom filter, click OK. Exchange displays only the records that match 
the conditions that you specified. 

Custom Filter Operators 

The following table describes the operators that are available when setting filter criteria. The operators 
available for a column are based on the column's data type. 

Operator Description 

Equals Displays records where the value in the column matches the value that you 
specify. 

Does not equal Displays records where the value in the column does not match the value that 
you specify. 

Less than Displays records where the value in the column is less than the value that you 
specify. 

Less than or equal to Displays records where the value in the column is less than or equal to the value 
that you specify. 

Greater than Displays records where the value in the column is greater than the value that you 
specify. 

Greater than or equal 
to 

Displays records where the value in the column is greater than the value that you 
specify. 

Like Displays records where the value in the column matches the pattern that you 
specify. 

Matches Regular 
Expression 

Displays records where the value in the column is in the format that you specify. 

  

^[A-Z] finds all values in uppercase character format only. 
^[a-z] finds all values in lowercase character format only. 

^[0-9] finds all values in numeric format only. 

^[A-Za-z] finds all values in mixed case character format. 

^[A-Za-z] finds all values in mixed case character format. 

^[^0-9]+$ finds all values with a numeric format and dollar sign. 

^[A-Za-z0-9] [A-Za-z0-9_]*$ finds all values of mixed case and currency. 

Starts with Displays records where the value in the column starts with the character or 
characters that you specify. 
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Operator Description 

Contains Displays records where the value in the column contains the character or 
characters that you specify. 

Ends with Displays records where the value in the column ends with the character or 
characters that you specify. 

Does not start with Displays records where the value in the column does not start with the 
character or characters that you specify. 

Does not contain Displays records where the value in the column does not contain the character or 
characters that you specify. 

Does not end with Displays records where the value in the column does not end with the 
character or characters that you specify. 

Does not match Displays records where the value in the column does not match the character or 
characters that you specify. 

Not like Displays records where the value in the column is not like the pattern that you 
specify. 

Group Data in a Data Grid 

Some data grids allow you to group the data by one or more columns. If you select multiple columns, 
Exchange groups and sorts the data by the first column that you select, and then by each subsequent 
column that you select. 

To group data in a data grid 

1. Drag and drop a column heading into the space just above the column headings. Exchange 
groups the data. 

 
2. To add groups within a group, do the following: 

a. Click the plus sign (+) next to a group to expand it. 

b. Drag and drop a column heading underneath an existing group. 



Exchange Manager Printable Help 

306 

 
Note: By default, Exchange sorts the grouped data in ascending order by the column 
specified. 

3. To change the sort to descending order, click the "up" arrow on the sorted column. To return 
the sort to ascending order, click the "down" arrow on the sorted column. 

4. To remove a grouping, drag and drop the grouped column to its original location in the data 
grid. 

Summarize Data in a Data Grid 

Some data grids allow you to summarize the data in a column. 

To summarize data in a data grid 

1. In the column heading to summarize, click the Sigma icon. 

 
The Select Summaries dialog box appears. 
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2. Select one or more calculations to perform on the data and then click OK. The result appears in 
the last row of the data grid. If you grouped the data, Exchange calculates the data for each 
group and displays the results in the last row for each group. 

 
3. To remove summary information, click the Sigma icon and clear the check boxes in the Select 

Summaries dialog box. 

Pin a Column 

Some data grids allow you to pin a column so that it remains stationary when you scroll horizontally. 

To pin a column 

1. In the column heading to pin, click the Pushpin icon. The pushpin points down to indicate that 
the column is pinned. 

 
2. Scroll horizontally in either direction and the pinned column remains stationary. 

3. To unpin a column, click the Pushpin icon on a pinned column. The pushpin points to the left to 
indicate that the column is not pinned. 

Forms 

Forms 

Use the Forms panel to add forms that run custom programs. For example, you can add a form to gather 
input from the user. 
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Add a Form 

You can use the New Form dialog box to add a custom form. 

To add a form 

1. In the Navigation pane, click Forms. 

2. In the Forms pane, right-click Forms and then click Add Form. The New Form dialog box 
appears. 

 
3. Next to the Assembly box, click the ellipsis (...). The Please select the assembly... dialog box 

appears. 

4. Click the ".dll" or ".exe" file that contains the custom form definition and then click Open. The 
path and file name appear in the Assembly box. 

5. In the Form box, type the namespace and name of the form, separated by a period. 

 
6. Click OK. The system adds the form to the Forms node. 
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7. Type over the "New Form" label with a name for the form and then press Enter. 
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Complete a Form 

Use the [Form Name] tab to complete the information on a form. 

To complete a form 

1. In the Navigation pane, click Forms. 

2. In the Forms pane, expand the Forms node to locate the form. 

3. Double-click the form name or right-click the form name and then click Properties. The [Form 
Name] tab appears in the Information pane. 

The following form is just an example. The objects that appear on the form are based on how you 
designed the form. 

 
4. Complete the information on the form. 

Rename a Form 

Use the Forms pane to rename a form. 

To rename a form 

1. In the Navigation pane, click Forms. 

2. In the Forms pane, expand the Forms node to locate the form. 

3. Right-click the form name and then click Rename. 

4. Type the new name and then press Enter. 
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Delete a Form 

Use the Forms pane to delete a form. 

To delete a form 

1. In the Navigation pane, click Forms. 

2. In the Forms pane, expand the Forms node to locate the form. 

3. Right-click the form name and then click Delete. 

4. In the confirmation dialog box, click Yes. 

Services 
The Services panel is no longer in use. 

Vendors 
The Vendors panel is no longer in use. 
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